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1 Product overview

This chapter presents an overview of the hardware components of the HP Workstation.

● Product features on page 2

● Product specifications on page 6

● Energy Star® on page 13

● Hyper-Threading Technology on page 14
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Product features
Exploded view

The following image shows a typical HP xw8400 Workstation. Drive configurations can vary.

For complete and current information on supported accessories and components, see
http://partsurfer.hp.com.

Figure 1-1  Exploded view

Table 1-1  Exploded view

Item Description Item Description

1 PCI card support 10 Memory modules

2 Power supply 11 Card guide/Front fan (fan is optional)

3 CPU heatsinks 12 Graphics card

4 Processors 13 Optical drive*

5 System fan 14 PCI-E card

6 Access panel 15 Diskette drive

7 System board 16 PCI card

8 Chassis 17 Hard drive

9 Front bezel

* A CD-ROM is an example of an optical drive. 
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Front panel components  
The following image shows a typical HP xw8400 Workstation. Drive configurations can vary.

Figure 1-2  Front panel components

Table 1-2  Front panel components

Item Symbol Description Item Symbol Description

1  Optical drive 6 Headphone connector 

2  5.25-inch drive bay 7 USB 2.0 ports 

3  Diskette drive (optional) 8 Hard drive activity light

4 IEEE-1394a connector 9 Power button 

5 Microphone connector 10  Power on light 
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Rear panel components  

Figure 1-3  Rear panel components

Table 1-3  Rear panel components

Item Symbol Description Item Symbol Description

1  Power cord connector 10  Graphics adapter

2  Built In Self Test (BIST) LED 11 Audio line-in connector

3 Keyboard connector 12 RJ-45 network connector

4 Serial connector 13 Parallel connector

5 USB 2.0 ports 14 Mouse connector

6 IEEE-1394a connector 15  Cable lock slot

7 Microphone connector 16  Padlock loop

8 Audio line-out connector 17  Universal chassis clamp opening

9  MiniSAS 4–port connector (optional) 18  Access panel key

 

 

 

The rear panel connectors are labeled with industry-standard icons and colors to assist you in connecting your peripheral devices.

Serial number and COA label location
Each workstation has two unique serial number labels. Systems preinstalled with Microsoft® Windows®
XP also have a certificate of authentication (COA) label (2). The serial number labels (1) are located on
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the side panel of the unit and on the rear panel. Keep the serial number available when contacting
customer service for assistance.

Figure 1-4  Serial number and COA label location
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Product specifications 
The following table lists the physical dimensions.

Table 1-4  Physical characteristics

Weight (depending on
configuration)

18 - 25.2 kg (39.6 - 55.6 lb.)

Tower dimensions 455 mm (17.9 in.) tall, 210 mm (8.3 in.) wide, 525 mm (20.7
in.) deep

Rack mount dimensions (top
cover and foot removed)

210 mm (8.3 in.) tall, 440 mm (17.3 in.) wide, 525 mm (20.7
in.) deep

Power supply and cooling
This section describes power supply specifications.

Table 1-5  Voltage specification

Voltage Minimum Maximum Description

3.3 V 3.17 V 3.47 V Used with PCI, MCH, ESB2, PXH, LAN, and onboard logic

5 V 4.90 V 5.35 V Used with storage (disk, optical, diskette), PCI, Audio,
USB, input to onboard regulator, and onboard logic

12 VCPU0 11.52 V 12.6 V Input to onboard regulator that supplies power for CPU0

12 VCPU1 11.52 V 12.6 V Input to onboard regulator that supplies power for CPU1

12 V-M 11.52 V 12.6 V Input to onboard regulators that supply 1.5 V and 1.8 V
for memory

12 V-B 11.52 V 12.6 V Used with PCI fans, input to onboard regulators that
supply 1.5 V and 1.2 V

12 V-D 11.52 V -12.6 V Used with storage (disk, optical, floppy)

12 V-G 11.52 V 12.6 V Used with PCI Express x16 auxiliary connector

V12N –11.4 V –12.6 V Used by PCI

5 VSB 4.85 V 5.25 V Used for sleep circuitry

Table 1-6  Current specification

Current Continuous Description

3.3 V 22.0 A Used with PCI, MCH, ESB2, PXH, LAN, and
onboard logic

5 V 18.0 A Used with storage (disk, optical, diskette), PCI,
Audio, USB, input to onboard regulator, and
onboard logic

12 VCPU0 13.7 A Input to onboard regulator that supplies power for
CPU0
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Current Continuous Description

12 VCPU1 13.7 A Input to onboard regulator that supplies power for
CPU1

12 V-M 14 A Input to onboard regulators that supply 1.5 V and
1.8V for memory

12 V-B 14.5 A Used with PCI fans, input to onboard regulators that
supply 1.5 V and 1.2 V

12 V-D 10.0 A Used with storage (disk, optical, floppy)

12 V-G 12.5 A Used with PCI Express x16 auxiliary connector

V12N 0.3 A Used by PCI

5 VSB 2.5 A Used for sleep circuitry

WARNING! Do not exceed 135 W of a 5-V and 3.3-V power combination.

Do not exceed 64 A (768 W) of a 12-V (CPU0/CPU1/M/B/D/G) power combination.

Do not exceed 800 W of total continuous output power.

Power supply specifications
The  integrated, surge-tolerant power supply is rated to withstand a power surge of up to 2,000 V (line-
to-PE or neutral-to-PE) and 1,000 V (line-to-line) without any data loss or system downtime. The
following specifications describe the power supply:

Table 1-7  Power supply specifications

Parameter Specification

Full ranging input (No line select switch) Yes

Active power factor correction (APFC) (Input current is nearly
1/2 non-APFC power supply)

Yes

Passive power No

Operating voltage range 90–269 VAC

Rated voltage range 100–240 VAC/118 VAC

Rated line frequency 50–60 Hz/400 Hz

Operating line frequency range 47–66 Hz/393–407 Hz

Rated input current 13.2 A@100–120 VAC

6.6 A@200–240 VAC

11.2 A@118 VAC

Maximum rated power 800 W

Heat dissipation Typical: 1,710 BTU/hr. (430 kg-cal/hr)

Maximum: 3,793 BTU/hr. (956 kg-cal/hr)

Power supply fan 92 mm x 32 mm variable speed

Table 1-6  Current specification (continued)
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Power supply size (wide x high x deep) 98 mm x 160 mm x 213 mm

Energy Star®–compliant Yes

Blue Angel Compliant (<2 W in S5 — Power off) N/A

Power consumption in ES mode — Suspend to RAM (S3)
(Instantly Available PC)

<7 W

FEMP standby power compliant @ 115 V (<2 W in S5 - Power
Off)

Yes (Wake-On-LAN (WOL) disabled)

BIST LED Yes

Surge tolerant full ranging power supply Withstands power surges up to 2,000 V

Power consumption and cooling 
Example 1: The following table shows the primary power consumption for an example configuration:

● Two 2.66-GHz Xeon 5100 series dual-core processors

● Four 1-GB, 667-MHz memory modules

● Two 160-GB SATA hard drives

● Two optical drives

● One PCI Express graphics card (nVidia FX3500)

● One diskette drive

● One monitor, powered separately

Table 1-8  Example 1 Energy consumption *

 115 VAC 230 VAC 100 VAC

 LAN enabled LAN disabled LAN enabled LAN disabled LAN enabled LAN disabled

Windows Idle (S0) 209 W 205 W 210 W

Windows Busy (S0) 337 W 335 W 343 W

Sleep (S3) 4.67 W 4.67 W 5.32 W 5.32 W 4.63 W 4.63 W

 

 

 

* Energy Star low energy mode.

 

 

 

This product is in compliance with US executive order 13221, WOL (wake on LAN) disabled.

Table 1-9  Example 1 Heat dissipation *

 115 VAC 230 VAC 100 VAC

 LAN enabled LAN disabled LAN enabled LAN disabled LAN enabled LAN disabled

Windows Idle (S0) 713 BTU/hr 699 BTU/hr 718 BUT/hr

Table 1-7  Power supply specifications (continued)
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Windows Busy (S0) 1150 BTU/hr 1143 BTU/hr 1171 BTU/hr

Sleep (S3) 16 BTU/hr 16 BTU/hr 18 BTU/hr 18 BTU/hr 16 BTU/hr 16 BTU/hr

 

 

  

* Heat dissipation calculation is based on measured watts, assuming the service level is attained for one hour.

 

 

 

This product is in compliance with US executive order 13221, WOL (wake on LAN) disabled.

Example 2: The following table shows the primary power consumption for an example configuration:

● Two 3.73-GHz Xeon 5000 series dual-core processors

● Eight 1-GB, 667-MHz memory modules

● Two 160-GB SATA hard drives

● Two optical drives

● One PCI Express graphics card (nVidia FX3500)

● One diskette drive

● One monitor, powered separately

Table 1-10  Example 2 Energy consumption *

 115 VAC 230 VAC 100 VAC

 LAN enabled LAN disabled LAN enabled LAN disabled LAN enabled LAN disabled

Windows Idle (S0) 293 W 286 W 292 W

Windows Busy (S0) 413 W 399 W 415 W

Sleep (S3) 4.1 W 3.2 W 4.8 W 3.9 W 4.1 W 3.2 W

 

 

 

* Energy Star low energy mode.

 

 

 

This product is in compliance with US executive order 13221, WOL (wake on LAN) disabled.

Table 1-11  Example 2 Heat dissipation *

 115 VAC 230 VAC 100 VAC

 LAN enabled LAN disabled LAN enabled LAN disabled LAN enabled LAN disabled

Windows Idle (S0) 1000 BTU/hr 977 BTU/hr 997 BUT/hr

Windows Busy (S0) 1410 BTU/hr 1362 BTU/hr 1417 BTU/hr

Table 1-9  Example 1 Heat dissipation * (continued)
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Sleep (S3) 14 BTU/hr 11 BTU/hr 17 BTU/hr 14 BTU/hr 14 BTU/hr 11 BTU/hr

 

 

 

* Heat dissipation calculation is based on measured watts, assuming the service level is attained for one hour.

 

 

 

This product is in compliance with US executive order 13221, WOL (wake on LAN) disabled.

NOTE When you power down your workstation with the power button on the front panel, the
power consumption falls below 10 W. To reach zero power consumption, unplug the workstation
from the power outlet or use a power strip with a switch.

For additional information on power-saving features, see your operating system documentation.

System fans and airflow 
The workstation includes one rear system fan, one memory fan, one processor (CPU) heatsink fan for
each processor, and one power supply fan, plus optional front system fans.

Resetting the power supply 
If an overload triggers the power supply overload protection, all power is immediately shut off. To reset
the power supply unit:

1. Disconnect the power cord.

2. Determine what caused the overload, and fix the problem.

3. Reconnect the power cord, and reboot the workstation.

When you power down the workstation through the operating system, power consumption falls below
the low power consumption rate but does not reach zero. This on/off feature extends the life of the power
supply.

Power cord requirements
The power cord set (flexible cord or wall plug) received with this product meets the requirements for use
in the country where you purchased the equipment.

If you must obtain a power cord for a different country, you should purchase a power cord that is
approved for use in that country.

The power cord must be rated for the product and for the voltage and current marked on the product’s
electrical ratings label. The voltage and current rating of the cord should be greater than the voltage and
current rating marked on the product. The length of the cord must be between 6 feet (1.8 m) and 12 feet
(3.6 m). If you have questions about the type of power cord to use, contact the HP authorized service
provider.

A power cord should be routed so that it is not likely to be walked on or pinched by items placed on it
or against it. Particular attention should be paid to the plug, electrical outlet, and the point where the
cord exits from the product.

NOTE A 15AMP-capable (minimum) power cord must be used in with a 110-V power source.
A 10AMP-capable (minimum) power cord should be used with a 220-V power source.

Table 1-11  Example 2 Heat dissipation * (continued)
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Environmental specifications 
This section describes environmental specifications of your workstation.

Table 1-12  Environmental Specifications

Temperature (operating) 40° to 95° F (5° to 35° C)

Temperature (non-operating) –40° to 140° F (–40° to 60° C)

Humidity (operating) 8% to 85% RH, non-condensing

Humidity (non-operating) 8% to 90% RH, non-condensing

Altitude (operating) 0 to 10,000 ft. (3,048 m)

Altitude (non-operating) 0 to 30,000 ft. (9,144 m)

Shock (operating) 1/2-sine: 40 G, 2–3 ms

Shock (non-operating) 1/2-sine: 160 cm/s, 2–3 ms, (approximately 100 G)

square: 605 cm/s, 30 G

NOTE Values represent individual shock events and
are not indicative of repetitive shock events.

Vibration (operating) Operating random: 0.5 G (rms), 5–300 Hz

Vibration (non-operating) Random: 2.0 G (rms), 10–500 Hz

NOTE Values are not indicative of continuous
vibration.

PCI card slot power specification
Table 1-13  PCI and PCI Express slot power specifications

Slot# Slot Type Slot Power (Maximum)

1 PCI (32–bit, 33 MHz) 25 W*

2 PCI Express x16 graphics 150 W**

3 PCI Express x8 (x4) 25 W*

4 PCI Express x16 (x4) 25 W*

5 PCI-X 133 25 W*

6 PCI-X 100 25 W*

7 PCI-X 100 25 W*

* In addition to these slot power specifications, the overall power
consumption of the system (including I/O cards, processor, and
memory) must not exceed the maximum ratings of the system power
supply. See Power supply specifications on page 7 for details.
** Includes 75 W maximum from the system board connector, and
75 W maximum from the auxiliary graphics power connector.
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NOTE If a graphics card requiring more than 75 W is installed, HP recommends not using slot
3, which is the PCI Express slot below the graphics slot. In addition to these slot power
specifications, the overall power consumption of the system (including I/O cards, processors,
memory, and drives) must not exceed the maximum ratings of the system power supply.

For hardware specifications of other system components, such as graphics cards or optical drives, see
the website of the specific manufacturer.
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Energy Star® 
The Energy Star program, a government-backed initiative, promotes energy efficiency by identifying
ways to reduce energy consumption. Select HP workstations participate in the Energy Star program.

NOTE  Energy Star is not supported on Linux-based workstations.

For those workstations that support Energy Star and have it enabled, the power management features
are set as follows:

● The monitor goes into power savings mode after 20 minutes of inactivity.

● The system goes into standby mode after 20 minutes of inactivity

NOTE If you have to restore the operating system, reset the Energy Star settings (if applicable)
after the restore.

To verify the factory default power settings for your product, select Start>Control Panel and double-
click Power Options.

Energy Star compliance
HP products purchased with the Energy Star configuration are compliant with U.S. Environmental
Protection Agency (EPA) Computers Program. The EPA Energy Star configuration does not imply
endorsement by the EPA. As an Energy Star partner, HP offers products with the Energy Star
configuration to meet the Energy Star guidelines for energy efficiency.

EPA created the Energy Star Computers Program to promote energy efficiency and reduce air pollution
through more energy-efficient equipment in homes, offices, and factories. HP products achieve this
result by reducing the power consumption when not being used.

Energy Star on HP workstations uses Advanced Configuration and Power Interface (ACPI) power
management. The system can wake as a result of a user action (keyboard or mouse) or from the network
or a modem.

The Power Management feature, when used in conjunction with an external Energy Star-compliant
monitor, will support the power-down features of the monitor. The Power Management feature allows
an external monitor to go into low-power mode when the Energy Save timeout occurs.

NOTE  Using the Energy Star Save Monitor feature with non-Energy Star-compliant monitors
might cause video distortion when the Energy Save timeout occurs.
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Hyper-Threading Technology 
Hyper-Threading Technology, developed by Intel®, enables a single processor to execute multiple
threads of instructions simultaneously. Hyper-Threading Technology enables the processor to utilize its
execution resources more efficiently, delivering performance increases and improving user productivity.
Not all applications or environments benefit from the Hyper-Threading Technology. Hyper-Threading is
most beneficial in multi-tasking environments.

NOTE On the HP xw8400 Workstation, Hyper-threading is only supported on Intel Xeon(TM)
5000 Series processors.

To see if Hyper-Threading Technology can benefit you, test your system by enabling the feature. To do
this, run Computer Setup (F10) during the boot process and select Advanced>Power-On
Option>Hyper-Threading, and enable Hyper-Threading Technology.

NOTE HP recommends using Hyper-Threading Technology with Windows XP systems. This
technology is detected by the system and is turned on in the operating system after it is enabled
in the system BIOS.

For more information about the Hyper-Threading Technology, see Intel's website at
http://www.intel.com.
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2 Installing or restoring the operating 
system

This chapter describes the installation and restoration of the operating system.

● Installing the operating system and software on page 16

● HP software on page 18

● Restoring the Windows operating system on page 19

● HP Backup and Recovery Manager restore points on page 20

● Protecting the software on page 22

● Ordering backup software on page 20

If your workstation was shipped with a preinstalled operating system, it is configured automatically the
first time your workstation is powered on.

Adding optional hardware devices to your workstation before the operating system successfully installs
can cause errors and prevent the operating system from installing properly.

CAUTION  After the automatic installation has begun, do not power off your workstation until
this process completes. Powering off your workstation during the installation process might
damage the software that runs the system.
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Installing the operating system and software
The following sections discuss operating system and HP software installation procedures.

Microsoft Windows XP Professional 
The first time you power on your workstation, you are prompted to select a language for the operating
system. After selecting the language, read and follow the instructions on the screen to complete the
installation of the operating system. This process takes approximately 10 minutes, depending on the
system hardware configuration. During the process, do not power off your workstation unless you are
directed to do so.

Installing or upgrading device drivers
To install hardware devices, such as a printer, a display adapter, or network adapter after the operating
system installation is completed, the operating system needs access to the appropriate software drivers
for the devices. Device drivers are usually provided on a CD supplied with the peripheral device.

Some existing peripheral devices might not have been shipped with drivers developed for Windows XP.
To locate the most current device drivers, see http://www.hp.com/go/workstationsupport.

Linux-preinstalled workstations
If you have a Linux-preinstalled workstation, follow the instructions in this section to set up your operating
system and software.

After the boot process completes, you can view additional HP Linux documentation by opening your
Internet browser (the browser is automatically set to use the local HP documentation page as its default).
You can also access Linux Web links for Red Hat (Internet access required) by using your Internet
browser.

For additional information about setting up Linux-preinstalled or Linux-enabled workstations, refer to
the HP User Manual for Linux at http://www.hp.com/support/linux_user_manual.

For more information about HP and Linux, see http://www.hp.com/linux.

Starting up the Linux operating system
The first time your workstation is booted, the Red Hat First Boot utility displays. This program enables
you to enter your password, network, graphics, time, and keyboard settings for your workstation.

CAUTION After the automatic installation has begun, do not power down your workstation until
the process is complete. Powering down your workstation during the installation process might
damage the software that runs your workstation or prevent its proper installation.

When you enable the YPBind feature in the Network tab of the Linux Setup Tool, you might get a blank
screen for about 15–30 seconds after you have selected and saved all of your settings and exited the
utility. This behavior is normal. The boot process continues its execution after the screen returns.

Upgrading device drivers
To upgrade a Linux device driver, see http://www.hp.com/go/workstationsupport.
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Linux-enabled workstations
Linux-enabled workstations are not preinstalled with Linux. They require the HP Installer Kit for Linux
and the purchase of a Red Hat box set. The Installer kit includes the HP CDs necessary to complete
the installation of all versions of the Red Hat box set that have been verified to work on HP workstation
hardware.

Verifying hardware compatibility
To determine which Linux versions have been verified to work on HP workstation hardware:

1. Go to http://www.hp.com/support/linux_hardware_matrix.

2. Select your HP workstation model.

Installing the Linux operating system
To install the Linux operating system on your Linux-enabled system, follow the instructions for Restoring
the Linux operating system on page 21 in this chapter.

For more information concerning the setup of Linux-preinstalled or Linux-enabled workstations, refer to
the HP User Manual for Linux located at http://www.hp.com/support/linux_user_manual.

For more information about HP and Linux, see http://www.hp.com/linux.

Red Hat Activation
With your workstation you received an activation card called Activate Your Subscription. This card is
necessary to activate your Linux subscription with Red Hat Network. Until activation, your Red Hat Linux
is not fully enabled.

To activate Red Hat Linux, click the Activate Your Subscription  icon on your desktop. This takes you
to www.redhat.com/activate. Follow the instructions at this website to activate your subscription using
the information on the card.

HP recommends that you activate your subscription as soon as you connect to the web.

NOTE Keep the Red Hat activation card with your workstation registration card for future
reference.
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HP software
The following HP software may be installed on your workstation depending on the operating system and
options:

● Computer Setup (F10) Utilities and diagnostic features

● HP Support Software including device drivers

● Security Management tools (optional)

● Software Support Management tools

Additional software is available for download:

● HP Client Manager Software is available at http://www.hp.com/go/easydeploy.

● System Software Manager is available at http://www.hp.com/go/ssm.

NOTE Additional HP software might be required in certain situations.
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Restoring the operating system
This section describes how to restore the Windows and Linux operating systems.

Restoring the Windows operating system
Your workstation has a several methods to restore your Windows XP operating system to a near-factory
state, or to the state of the system at a predefined snapshot in time. Your system has a recovery partition
on the system hard drive that contains software and data required for the restore process as described
in the following sections.

NOTE If you received restore media with your system, use the media to restore your operating
system. Refer to the instructions on the media for restoring your operating system.

The RestorePlus! process
The Window operating system and device drivers (for devices shipped with the system) are reinstalled
using this process. Some application software may not be restored using the RestorePlus! process. In
this case you must install the application software from the appropriate application CD. The RestorePlus!
process can be executed from CD or from the recovery partition contained on your system hard drive.

CAUTION Backup your data before you attempt any operating system restore. All data on the
Windows partition will be deleted when you restore using the RestorePlus! process. However,
the recovery partition on the system drive and other partitions should not be affected.

Creating a RestorePlus! CD

You can create a set of the CDs from your system if you have a CD burner. When you first boot your
system, you will be prompted to make CDs for RestorePlus!, the Windows operating system, and a
supplemental HP Backup and Recovery Manager CD. (There may be additional CDs you can create
depending on the options you purchased.) You also have the option to move images of the CDs to
another location, such as a network share, to be burned to CD at a later time or from another system.

Restoring from RestorePlus! CDs

The RestorePlus! process can be started by booting from the RestorePlus! CD.

Restoring from RestorePlus! on the Recovery Partition

Follow these steps to start the RestorePlus! process from the Emergency Recovery menu:

1. Boot the workstation.

2. Press the F11 key when prompted during the boot process to enter the Emergency Recovery menu.
The F11 prompt appears briefly during the boot process.

3. Select Recover PC’s factory installed operating system, drivers, utilities, and applications
from the Emergency Recovery menu.

NOTE Some applications may not be restored using this method.
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HP Backup and Recovery Manager restore points
HP Backup and Recovery Manager is preinstalled on your workstation. This software allows you to
backup and restore your system and data. You will be prompted to make RestorePlus! CDs at the first
boot of the system. An Initial Restore Point (IRP) will be created automatically. This restore point is a
complete snapshot of the system partition at the time the IRP was created. The IRP is stored in the
recovery partition on the system hard drive, but you can also burn the IRP to CDs, DVDs, or copy it to
another location. The restore point can be used to return the system partition back to the state the system
was when captured.

Restoring from the HP Backup and Recovery Manager restore point CD/DVDs

The HP Backup and Recovery Manager (HPBR) restore point can be burned to CD or DVDs and used
to restore the system. Typically you would used the CD/DVD set if the hard drive has been replaced or
all partitions have been corrupted. Boot the system from the HPBR restore point CD/DVD and follow
the online instructions.

Restoring from the HP Backup and Recovery Manager restore point on the Recovery Partition

The HP Backup and Recovery Manager (HPBR) Initial Restore Point is stored in the system recovery
partition and can be restored using the Emergency Recovery menu. Boot your system and press the
F11 key when prompted to enter the Emergency Recovery menu. The F11 prompt appears briefly during
the boot process. From the Emergency Recovery menu, choose Recover PC to a specific point in
time and follow the instructions.

Reclaiming hard disk space from the recovery partition
The recovery partition can be removed to reclaim the hard drive space. If the recovery partition is
removed, the F11 Emergency Recovery function is not available. The ability to recover the system from
data on the recovery partition will be lost. Any RestorePlus! media contained in the recovery partition
will be deleted. The ability to create the RestorePlus! CD set will be lost.

To free up disk space, you can remove just the recovery partition, or you can completely uninstall the
HP Backup and Recovery Manager application.

● The recovery partition can be removed using Remove HP Recovery Partition in the HP Backup
& Recovery program folder. The recovery partition is deleted, the user partition is extended to
reclaim the unused hard drive space, and the F11 boot prompt is removed. The HP Backup and
Recovery Manager application remains and can be used for data backup and restore.

● The HP Backup and Recovery Manager application can be uninstalled using the Windows Control
Panel—>Add/Remove Programs utility. The application is uninstalled, the recovery partition is
deleted, the user partition is extended to reclaim the unused space, and the F11 boot prompt is
removed. Emergency recovery as well as data backup and recovery is not possible after the
application is uninstalled.

CAUTION Deleting the recovery partition or uninstalling the HP Backup and Recovery Manager
application reduces or eliminates the ability to recover the system.

Ordering backup software
If you are unable to create system recovery CDs or DVDs, the HP Restore Plus CD set can be obtained
through product support on http://www.hp.com/support.
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NOTE Before calling HP to order the software, be sure to have the serial number of your
workstation available. See Serial number and COA label location on page 4 for details.

Restoring the Linux operating system

NOTE To restore the Linux operating system, the HP Driver CD and Red Hat box set are
required. Download the latest HP Driver CD to get any new enhancements.

For preloaded Linux systems, an icon called Red Hat ISO's is available on the desktop. Click this icon
to go to the /iso directory. This directory contains the binary and source ISO files. This directory also
contains the driver CD ISO which is the same as the CD that is shipped with the workstation. Follow the
instructions in the Readme file in the /iso directory to burn the ISOs to CD.

HP recommends that you burn the ISOs to CD so you have a backup.

NOTE Linux does not support mixed drive types for a manufacturing preload. When restoring
the operating system, mixed drive types can be handled with the restoring media.

Downloading the latest HP driver CD contents

See http://www.hp.com and select Software and Drive Downloads. Find your workstation and
operating system. Select your driver CD under Software, and follow the directions under Release
Notes.

Installing the operating system with the HP driver CD contents

1. Boot your workstation from the Red Hat box set Binary CD 1.

2. Insert the Linux operating system CDs from the Red Hat box set as prompted.

3. Continue following the prompts until the operating system is successfully installed.

4. Configure the X server to start on reboot.

5. Reboot your workstation.

6. Follow the prompts to set up your system with the Red Hat First Boot utility.

7. When prompted in First Boot to add additional CDs, insert the HP Driver CD into the CD-ROM tray
of your workstation.

8. Click Install next to “Additional CDs.” The HP Driver CD window opens.

9. Click Press to begin install.

When the install is done, you will have two options— Reboot now... on the left side and Press to
continue, reboot later... on the right side.

10. Click Reboot now...
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Protecting the software
To protect software from loss or damage, keep a backup copy of all system software, applications, and
related files stored on the hard drive. See the operating system or backup utility documentation for
instructions on making backup copies of data files.
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3 System management

This section describes the various tools and utilities that allow for the system management of the
workstation.

● Computer Setup (F10) Utility on page 24

● Desktop management on page 34
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Computer Setup (F10) Utility
The Computer Setup (F10) Utility enables you to:

● Change factory default settings and set or change the system configuration, which might be
necessary when you add or remove hardware.

● Determine if all of the devices installed on the workstation are recognized by the system and
functioning properly.

● Determine information about the operating environment of the workstation.

● Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

● Establish and manage passwords and other security features.

● Establish and manage energy-saving time-outs (not supported for Linux platforms).

● Modify or restore factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

● Modify the boot order of installed mass storage devices such as SATA, IDE (ATA), SAS, SCSI,
diskette drives, optical drives, network drives, and LS-120 drives.

● Configure the boot priority of SATA, IDE (ATA), and SAS hard drive controllers.

● Enable or disable Network Server Mode, which enables the workstation to boot the operating
system when the power-on password is enabled with or without a keyboard or mouse attached.
When attached to the system, the keyboard and mouse remain locked until the power-on password
is entered.

● Select POST Messages Enabled or Disabled to change the display status of POST messages.
POST Messages Disabled suppresses most POST messages, such as memory count, product
name, and other non-error text messages. If a POST error occurs, the error is displayed regardless
of the mode selected. To manually switch to POST Messages Enabled during POST, press any
key (except F1 through F12).

● Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

● Enter the Asset Tag or property identification number assigned by your company to this
workstation.

● Enable power-on password prompting during system restarts (warm boots) and during power-on.

● Secure the integrated I/O functionality, including the serial, USB, or parallel ports, audio, or
embedded NIC, so that the I/O functionality cannot be used until they are unsecured.

● Enable or disable removable media boot ability.

● Enable or disable removable media write ability (when supported by hardware).
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● Replicate your system setup by saving system configuration information on diskette and restoring
it on one or more workstations.

● Execute self-tests on specified SATA and IDE (ATA) hard drives (when supported by the drive).

BIOS ROM
The BIOS of the computer is a collection of machine language programs stored as firmware in ROM.
The BIOS ROM includes such functions as POST, PCI device initialization, Plug 'n Play support, power
management activities, and the Computer Setup (F10) Utility. The firmware contained in the BIOS ROM
supports the following systems and specifications:

● Microsoft Windows Hardware Quality Labs (WHQL)

● Alert-on-LAN (AOL) and Wake-on-LAN (WOL)

● ACPI 1.0 and 2.0 and OnNow

● SMBIOS 2.5

● PC98/99/00 and NetPC

● HP Preboot Execution Environment (PXE) boot ROM for the integrated LAN controller

● BIOS Boot Specification 1.01

● Enhanced Disk Drive Specification 3.0

● “El Torito” Bootable CD-ROM Format Specification 1.0

● ATAPI Removable Media Device BIOS Specification 1.0

● MPS Specification 1.4 (for booting Linux SMP)

● ASF (Alert Standard Format) 1.0

The BIOS ROM is a 1-MB Intel Firmware Hub (or Firmware Hub-compatible) part. The runtime portion
of the BIOS resides in a 96-KB block from E8000h to FFFFFh (approximation). ACPI code and data
take about 128 KB below TOLM (top of low memory, last RAM address below 4 GB).

Using Computer Setup (F10) Utility 
You can only open the Computer Setup (F10) Utility by powering on the workstation or restarting the
system. To access the Computer Setup (F10) Utility menu:

1. Power on or restart the workstation.

2. Press the F10 key as soon as your display is active and the message Setup appears in the lower
right corner of the screen.

NOTE If you do not press F10 at the appropriate time, you must try again. Restart the
workstation and press F10 again to access the utility, or press Ctrl+Alt+Delete prior to boot
if you miss the opportunity to press F10.

3. Select your language from the list, and press the Enter key. In the Computer Setup (F10) Utility
menu, five headings are displayed: File, Storage, Security, Power, and Advanced.
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4. Use the left and right arrow keys to select the appropriate heading. Use the up and down arrow
keys to select the option you want, and press Enter.

5. To apply and save changes, select File>Save Changes and Exit.

● If you have made changes that you do not want applied, select File>Ignore Changes and
Exit.

● To reset to factory settings, select  File>Default setup>Restore Factory Settings as
Default. Press F10 to accept the changes. Click Apply Defaults and Exit. This option
restores the original factory system defaults.

CAUTION Do not turn the workstation power off while the ROM is saving your Computer Setup
(F10) Utility changes because the CMOS could become corrupted. After you exit the F10 Setup
screen, it is safe to remove all power from the workstation.

Computer Setup (F10) Utility menu

NOTE The following content is subject to change with new BIOS releases, so your menu may
be different than shown in Table 1–1.

Table 3-1  Computer Setup (F10) Utility menu descriptions

Heading Option Description

File System
Information

Lists product name, SKU number, processor type/speed/stepping, cache size (L1/L2), memory
type and size, integrated Media Access Control (MAC) for enabled or embedded Network Interface
Card (NIC), if applicable, system BIOS type, chassis serial number, and asset tracking number.

About Displays copyright information.

Set Time and
Date 

Enables you to set system time and date.

 Flash System
ROM

Enables you to flash (update) system BIOS using any supported removable mass storage device
(CD-ROM, USB drive, floppy).

Replicated
Setup

Save to Removable Media

Saves the current F10 Setup configuration to a text file called cpqsetup.txt, which can be used
for Replicated Setup functions.

  Restore from Removable Media

Restores previous F10 Setup configuration from a text file called cpqsetup.txt, which can be used
for Replicated Setup functions.

Default Setup Save Current Settings as Default

Stores the current F10 Setup configuration into the physical ROM as the default.

  Restore Factory Settings as Default

Restores the original factory settings to the F10 Setup configuration information in the physical
ROM as the default.

Apply Defaults
and Exit

Saves the selected default settings (previously-saved user settings or factory settings) into Non-
Volatile Random Access Memory (NVRAM) and exits.

Ignore
Changes and
Exit

Exits the Computer Setup (F10) Utility without applying or saving any changes.
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Heading Option Description

Save Changes
and Exit

Saves changes to system configuration and exits the Computer Setup (F10) Utility.

Storage Device
Configuration

Lists all installed storage devices including hard disk, SATA 0, USB, CD-ROM, IDE Primary 0, and
IDE/SATA.

When a device is selected, detailed information and options are displayed.

Hard Disk

Identifies the hard disk drives on the system by model, firmware, serial number, connector color,
emulation type, multi-sector transfers, and translation mode.

CD-ROM

Identifies the CD-ROM drives on the system.

Diskette Type (for legacy diskette drives only)

Identifies the highest capacity media type accepted by the diskette drive. Options are 3.5" 1.44
MB, 5.25" 1.2 MB, and Not Installed.

Default Values

Enables you to set the default values for IDE and SATA devices such as the following:

● Multisector Transfers (IDE disks only)–Specifies how many sectors are transferred per multi-
sector Programmed Input/Output (PIO) operation. Options (subject to device capabilities) are
Disabled, 8, and 16.

● Transfer Mode (IDE devices only)–Specifies the active data transfer mode. Options (subject
to device capabilities) are PIO 0, Max PIO, Enhanced DMA, Ultra DMA 0, and Max UDMA.

● Translation Mode (IDE/SATA disks only)–Enables you to select the translation mode to be
used for the device, which enables the BIOS to access disks partitioned and formatted on
other systems and may be necessary for users of older versions of UNIX (for example, SCO
UNIX version 3.2). Options are Bit-Shift, LBA Assisted, Off, and Automatic.

NOTE The Automatic option has been added to allow BIOS to automatically
determine the translation mode used to configure a previously formatted IDE, SATA,
or USB mass storage device. This setting prevents you from having to know how the
mass storage device was previously formatted.

Ordinarily, the translation mode selected automatically by the BIOS should not be changed.
If the selected translation mode is not compatible with the translation mode that was active
when the disk was partitioned and formatted, the data on the disk will be inaccessible.

Storage
Options

Removable Media Boot

Enables and disables ability to boot the system from removable media.

  Legacy Diskette Write

Enables and disables ability to write data to legacy media.

BIOS DMA Data Transfers

Determine the point where BIOS enables DMA transfers for both IDE and SATA devices when
possible during POST to increase transfer speed.

SATA Emulation

Table 3-1  Computer Setup (F10) Utility menu descriptions (continued)
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Heading Option Description

Sets the SATA emulation mode with the following options:

● RAID + AHCI–Requires one of the two Intel SATA option ROMs to run. In this mode, the
Option ROM manages the drives so they are not shown in Device Configuration. This option
is the default and offers best performance.

● Separate IDE Controller–Offers standard SATA supports (four ports only).

● Combined IDE Controller–Makes the SATA controller look like an IDE controller and offers
best IDE compatibility (two ports only).

Primary SATA Controller

Enables you to disable the ESB-2 SATA controller primary SATA ports from the BIOS perspective,
but the controller is not hidden. The BIOS will ignore these ports and will not configure and
enumerate any devices connected to it. However, the operating system can re-enable and
enumerate devices upon booting.

  Secondary SATA Controller

Enables you to disable the ESB-2 SATA controller secondary SATA ports from the BIOS
perspective, but the controller is not hidden. The BIOS will ignore these ports and will not configure
and enumerate any devices connected to it. However, the operating system can re-enable and
enumerate devices upon booting.

 DPS Self-Test Selects the Drive Protection System (DPS) Self-Test (also called DST, Drive Self-Test). You are
prompted for the drive on which to run the test.

Boot Order Enables you to configure the boot, diskette drive, and hard drive orders by physically reordering
the menu entries. Boot Order presents these selections:

● ATAPI CD-ROM Drive (Optical Drive in BIOS 1.01 and above)

● USB device

● Hard Drive

● Integrated SATA

● Integrated IDE

● Broadcom Ethernet controller

● Diskette Drive

Boot devices can be disabled from participating in the boot order process. These order changes
are reconciled with the IPL/BCV historical information and stored in the physical ROM part when
the F10 Setup changes are confirmed by selecting File>Save Changes and Exit.

NOTE MS-DOS drive lettering assignments might not apply after a non-MS-DOS
operating system has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
workstation and press the F9 key when the F9=Boot Menu message appears on the screen. After
POST is completed, a list of bootable devices is displayed. Use the arrow keys to select the
preferred bootable device and press Enter. The workstation then boots from the selected non-
default device for this one time.

Security Setup
Password 

Enables you to set and enable setup (administrator) password.

Table 3-1  Computer Setup (F10) Utility menu descriptions (continued)
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Heading Option Description

NOTE If the setup password is set, you must enter Computer Setup (F10) Utility to
change it, flash the ROM, and make changes to certain plug-and-play settings under
Windows.

Power-On
Password 

Enables you to set and enable the power-on password.

 Password
Options

Lock Legacy Resources

Prevents the operating system from reassigning plug-and-play resources for serial, parallel, and
floppy legacy I/O devices.

 Network Server Mode

Enable or disable Network Server Mode, which enables the workstation to boot the operating
system when the power-on password is enabled with or without a keyboard or mouse attached.
When attached to the system, the keyboard and mouse remain locked until the power-on password
is entered.

 Password Prompt on Warm Boot

Sets the Password Prompt on Warm Boot function. If disabled, the BIOS will only prompt for a
password after power-on

Smart Cover Enables you to disable cover removal sensor or to notify the user if the sensor has been activated.
If disabled, the BIOS will only prompt for a password after power-on.

 Device Security Makes the following devices available or unavailable to the system:

● Serial Port

● Parallel Port

● All USB Ports

● Front USB Ports

● System Audio

● IDE Controller Security

● SATA Controller Security

● IEEE 1394 Controller

● Network Controller

● SAS Controller

For each device, Device Available is the default setting and allows the operating system access
to the device. Device Hidden makes the device unavailable. It is disabled by the BIOS and cannot
be enabled by the OS.

 Network
Service Boot

Enables a Network Service Boot which boots using the NIC PXE option ROM. In this case, the
actual boot image resides on a remote server. When enabled, you can set the boot order of the
NIC PXE option ROM and you can force a network boot by pressing F12 during POST.

System IDs Asset Tag

A 16–byte string identifying the system.

 Ownership Tag

An 80–byte string identifying ownership of the system. This tag is displayed on the screen during
POST.

Table 3-1  Computer Setup (F10) Utility menu descriptions (continued)
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Heading Option Description

 UUID (Universal Unique Identifier)

Can only be updated if the current chassis serial number is invalid. (These ID numbers are normally
set in the factory and are used to uniquely identify the system.)

 Keyboard

Enables you to set the keyboard locale for System ID entry.

 OS Security Data Execution Prevention

Sets Data Execution Prevention mode in the processors. This mode prohibits code from running
in pages that were set up as data pages, and prevents attacks such as buffer overflows. Operating
system support is required for this feature.

 Intel Virtualization Technology

Enables Intel Virtualization Technology in the processors. Additional virtualization software (such
as VMware) is required to use virtualization. This feature requires a power cycle to be activated.
Operating system support is required for this feature.

Power OS Power
Management

Runtime Power Management

Enables Enhanced Intel SpeedStep Technology (EIST) and Demand-Based Switching (DBS). This
option allows the operating system to tune processor performance states depending on load.

Idle Power Savings

When set to Enhanced, this option enables C1E, the high-efficiency processor halt state. When
the operating system puts a processor in idle mode, its power consumption is reduced. This option
reduces power consumption when the load is light. Operating system support is required for this
feature.

 ACPI S3 Support

Enables the suspend-to-RAM state. This option is mostly for troubleshooting purposes; the
operating system will never enter S3 if one of its drivers does not support that state. Enabled by
default; disabled for troubleshooting.

 ACPI S3 Hard Disk Reset

When enabled, the BIOS sends a “drive reset” command to the IDE and SATA drives when
resuming from S3, before returning to the operating system.

 ACPI S3 PS2 Mouse Wake Up

Allows the PS/2 mouse to wake from ACPI S3. PS/2 keyboards are always enabled. (Disabling
this option means that nudging the mouse will not trigger a system wake.)

 USB Wake on Device Insertion

Enables the USB controllers to generate a wake event when a device is plugged in while the system
is in an ACPI sleep state. The matching USB controller must be set to wake the system (from
Windows, this is done from Device Manager, using the Power Management tab for that controller,
and setting the Allow this device to wake up the system check box).

 Hardware
Power
Management

SATA Power Management

Enables you to enable or disable SATA power management. This option still works when the
controller is in RAID + AHCI mode.

 Thermal Fan Idle Mode

This setting changes the minimum fan speed. The fans are still automatically controlled.

Table 3-1  Computer Setup (F10) Utility menu descriptions (continued)
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Heading Option Description

Advanced
** 

Power-On
Options

POST Messages

Allows for selection between splash screen and text-mode startup.

 F9 Prompt (enable/disable)

When enabled, displays F9=Boot Menu during POST. Displaying this feature prevents the text
from being displayed, but pressing F9 still forces the system to attempt booting from the network.

 F10 prompt (enable/disable)

When enabled, displays F10=Setup during POST. Disabling this feature prevents the text from
being displayed but pressing F10 still accesses the Setup screen.

 F12 prompt (enable/disable)

When enabled, displays F12=Network Service Boot during POST. Disabling this feature prevents
the text from being displayed, but pressing F12 still forces the system to attempt booting from the
network.

 Option ROM* Prompt (enable/disable)

When enabled, causes the system to display a message before loading options ROMs.

 Remote Wakeup Boot Source

Enables you to specify which wakeup boot source device to remove.

 After Power Loss

In the event of an AC power loss, determines what the computer's behavior should be when power
is restored. Options are Off (stay off), On (turn on immediately), and Previous State (if the
computer was on when power was lost, power on immediately; if it was off, stay off).

POST Delay (in seconds)

Specifies a delay during POST. This setting may be necessary for certain add-in peripherals that
respond slowly of violate specifications. For instance, disk drives are supposed to spin within 15
seconds, but some older drives might take longer. Options are None, 5, 10, 15, 20.

Setup Browse Mode

Enables viewing Setup Options without entering Setup password. Enable allows you to view Setup
in read-only mode if you do not enter the Setup password. Disable blocks Setup entirely if you do
not enter the Setup password.

BIOS Power-
On

Enables you to disable or specify a weekday and time for BIOS power-on.

Processors Hyper-Threading (enable/disable)

Reports logical processors to ACPI-capable operating systems.

NOTE This field appears only if the installed processors support hyper-threading.

 Limit CPUID Maximum value to 3 (enable/disable)

Instructs the processors not to report their full capabilities using the CPUID instruction. Useful for
legacy systems.

 Onboard
Devices 

Selects the legacy devices' interrupt (IRQ), DMA channel, and I/O range. It can also disable the
devices. The values are strictly valid for boot time only—a plug-and-play operating system can
change them. Windows XP and Linux will not modify these values under default settings. To hide
a device from the operating system, see the Security>Device Security options in this table.

Table 3-1  Computer Setup (F10) Utility menu descriptions (continued)
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Heading Option Description

 Serial Port

Enables you to set I/O and interrupt (IRQ) for the device.

 Parallel Port

Enables you to set I/O, IRQ, and DMA channel for the device.

 Diskette Controller

Enables you to set I/O, IRQ, and DMA channel for the device.

 PCI VGA
Configuration

This menu lets you select which device to use as the primary VGA device—the one that will show
graphics during POST and boot, before the OS takes over graphics. The menu is dynamically
generated based on detected VGA-compatible devices.

NOTE This menu appears only if more than one VGA-compatible device is installed

Chipset/
Memory

PCI SERR# Generation (enable/disable)

Disables PCI SERR# generation for ill-behaved PCI add-in cards (that can generate SERR#
spuriously).

 PCI VGA Palette Snooping (enable/disable)

Enables PCI VGA Palette Snooping. This option is kept for compatibility purposes.

 MCH Error Handling

Sets which signal to use on serious MCH (North Bridge) errors. SMI is handled by the BIOS and
causes a reboot. NMI and Machine-Check Error are handled by the operating system and cause
a crash.

Device
Options 

Num Lock State at Power-On

Sets the Num Lock state after POST. The Operating System can change this state, also.

  S5 Wake on LAN (enable/disable)

Allows the network to wake the system from shutdown (ACPI S5). When set to Disable, system
power consumption is reduced to match Federal Energy Management Program (FEMP) guidelines.

  Unique Sleep State Blink Rates

Assigns different LED blink patterns for S1 and S3. (The LED is off for S4 and S5.)

  Monitor Tracking (enable/disable)

Enabling this option allows the ROM to save the monitor asset tracking information such as the
serial number and model.

  NIC PXE Option ROM Download (enable/disable)

Disable means you cannot boot from this device, but more option ROM space is available for other
devices.

 SAS Option ROM Download (enable/disable)

Enables or disables downloading embedded SAS option ROM. Disable means you cannot boot
from this device, but more option ROM space is available for other devices.

  SATA RAID Option ROM Download (enable/disable)

Disable means you cannot boot from this device, but more option ROM space is available for other
devices.

Table 3-1  Computer Setup (F10) Utility menu descriptions (continued)
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 PXH-V Secondary Latency Timer

Sets the secondary latency timer on the PXH-V bridge which is connected to PCI-X slot 5.

  PCIX Secondary Latency Timer

Sets the secondary latency timer on the ESB2 PCI-X bridge which is connected to PCI-X slots 6
and 7, and the SAS controller.

  SAS Latency Timer

Sets the latency timer on the SAS controller.

  Peer-to-Peer Reads

Enables you to allow peer-to-peer memory reads between the PCI-X buses behind the PXH-V.

  Fast Delayed Transaction Timer

Enables you to set Discard Transaction Timer to “short delay.” This may improve performance
issues with certain PCI devices. Do not enable this setting unless instructed to do so by the PCI
device supplier.

 Slot Options Applies to these slot types:

● Slot 1 — PCI

● Slot 2 — PCI Express x16

● Slot 3 — PCI Express x8 (x4)

● Slot 4 — PCI Express x16 (x4)

● Slot 5 — PCI-X 133

● Slot 6 — PCI-X 100

● Slot 7 — PCI-X 100

For PCI Express slots, the available option is Option ROM Download.

For PCI-X slots, the available options are Speed, Option ROM Download, and Latency Timer.

For PCI slots, the available options are Option ROM Download and Latency Timer.

* Available on select models.

** These options should be used by advanced users only.

Table 3-1  Computer Setup (F10) Utility menu descriptions (continued)
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Desktop management
HP Client Management Solutions (available for download from http://www.hp.com/go/easydeploy)
provides standards-based solutions for managing and controlling workstations in a networked
environment. This section summarizes the capabilities and features of desktop management key
components:

● Initial configuration and deployment on page 34

● Remote system installation on page 34

● Managing and updating software on page 35

● ROM flash on page 37

● Asset tracking and security on page 41

● Fault notification and recovery on page 47

NOTE Support for specific features described in this guide might vary by model or software
version.

Initial configuration and deployment
The workstation comes with a preinstalled system software image. After a brief software unbundling
process, the workstation is ready to use.

You might prefer to replace the preinstalled software image with a customized set of system and
application software. There are several methods for deploying a customized software image, including:

● Installing additional software applications after unbundling the preinstalled software image.

● Using software deployment tools, such as Altiris® Deployment Solutions™, to replace the
preinstalled software with a customized software image.

● Using a disk cloning process to copy the contents from one hard drive to another.

The best deployment method depends on your information technology environment and processes. The
PC Deployment section of the HP Lifecycle Solutions website (http://whp-sp-orig.extweb.hp.com/
country/us/en/solutions.html) provides information to help you select the best deployment method.

The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with recovery
of system software, configuration management and troubleshooting, and power management.          

Remote system installation
Remote System Installation enables you to start and set up your system using the software and
configuration information located on a network server. This feature is usually used as a system setup
and configuration tool, and can be used for the following tasks:  

● Deploying a software image on one or more new PCs

● Formatting a hard drive

● Installing application software or drivers

● Updating the operating system, application software, or drivers
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To initiate Remote System Installation, press F12 when F12=Network Service Boot appears in the
lower-right corner of  the HP logo screen. Follow the on-screen instructions to continue the process.
The default boot order is a BIOS configuration setting that can be changed to always attempt to PXE
boot.

HP and Altiris have partnered to provide tools designed to make the task of corporate PC deployment
and management easier and less time-consuming, ultimately lowering the total cost of ownership and
making HP PCs the most manageable client PCs in the enterprise environment.

Managing and updating software
HP provides several tools for managing and updating software on desktops and workstations—HP Client
Manager Software, Altiris Client Management Solutions, System Software Manager, Proactive Change
Notification, and Subscriber’s Choice.  

HP Client Manager software
HP Client Manager Software (HP CMS) assists you in managing the hardware aspects of your client
workstations with features that include:

● Detailed views of hardware inventory for asset management

● PC health check monitoring and diagnostics

● Proactive notification of changes in the hardware environment

● Web-accessible reporting of business-critical details such as machines with thermal warnings,
memory alerts, and more

● Remote updating of system software such as device drivers and ROM BIOS

● Remote changing of boot order

● Configuring the system BIOS settings

For more information on the HP Client Manager, see http://h18000.www1.hp.com/im/prodinfo.html.

Altiris Client Management solutions
HP and Altiris have partnered to provide comprehensive, tightly integrated systems management
solutions to reduce the cost of owning HP client PCs. HP Client Manager Software is the foundation for
additional Altiris Client Management Solutions that address:

● Inventory and asset management

● Software license compliance

● PC tracking and reporting

● Lease contract and fixed asset tracking

● Deployment and migration

● Microsoft® Windows® XP Professional® or Home Edition migration

● System deployment

● Personality migrations
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● Help desk and problem resolution

● Managing help desk tickets

● Remote troubleshooting

● Remote problem resolution

● Client disaster recovery

● Software and operations management

● Ongoing desktop management

● HP system software deployment

● Application self-healing

See http://h18000.www1.hp.com/im/prodinfo.html for more information about:

● How HP Client Manager Software works

● Which solutions are compatible with your operating system

● How to download a fully-functional, 30-day evaluation version of the Altiris solutions

System Software Manager
System Software Manager (SSM) is a utility that enables you to update system-level software on multiple
systems simultaneously. When executed on a PC client system, SSM detects both hardware and
software versions and then updates the appropriate software from a central repository, also known as
a file store. Driver versions that are supported by SSM are denoted with a special icon on the software,
the driver download website, and the Support Software CD. To download the utility or to obtain more
information on SSM, see http://www.hp.com/go/ssm.

Proactive Change Notification
The Proactive Change Notification program uses the Subscriber's Choice website to proactively and
automatically send you:

● Proactive Change Notification (PCN) e-mails informing you of hardware and software changes to
most commercial workstations and servers, up to 60 days in advance.

● E-mails containing Customer Bulletins, customer advisories, customer notes, security bulletins,
and driver alerts for most commercial workstations and servers.

You create your own profile to ensure that you only receive the information relevant to a specific IT
environment. To learn more about the Proactive Change Notification program and create a custom
profile, see http://www.hp.com/go/pcn.

Subscriber’s Choice
Subscriber’s Choice is a client-based service from HP. Based on your profile, HP supplies you with
personalized product tips, feature articles, and driver and support alerts and notifications. Subscriber’s
Choice Driver and Support Alerts/Notifications deliver e-mails notifying you that the information you
subscribed to in your profile is available for review and retrieval. To learn more about Subscriber’s
Choice and create a custom profile, see http://www.hp.com/go/pcn.
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ROM flash
The workstation comes with a programmable flash ROM. By establishing a setup password in the
Computer Setup (F10) Utility, you can protect the ROM from being unintentionally updated or
overwritten, which is important to ensure the operating integrity of the workstation. Should you need or
want to upgrade the ROM, you can:

● Order an upgraded ROMPaq diskette from HP.

● Download the latest ROMPaq images from HP driver and support page, http://www.hp.com/
support/files.

NOTE For maximum ROM protection, be sure to establish a setup password. The setup
password prevents unauthorized ROM upgrades. System Software Manager enables you to set
the setup password on one or more PCs simultaneously. For more information, see
http://www.hp.com/go/ssm.

Remote ROM flash
Remote ROM Flash enables you to safely upgrade the ROM on remote HP workstations directly from
the centralized network management console. Performing this task remotely on multiple workstations
and personal computers results in a consistent deployment of and greater control over HP PC ROM
images over the network. It also results in greater productivity and lower total cost of ownership.

The workstation must be powered on to use Remote ROM Flash.

For more information on Remote ROM Flash, see the HP Client Manager Software or System Software
Manager at http://h18000.www1.hp.com/im/prodinfo.html.

HPQFlash
The HPQFlash utility is used to locally update or restore the system ROM on individual PCs through a
Windows operating system.

For more information on HPQFlash, see http://www.hp.com/support/files and enter the name of your
workstation when prompted.

FailSafe Boot Block ROM
The FailSafe Boot Block ROM allows for system recovery in the unlikely event of a ROM flash failure,
for example, if a power failure occurs during a ROM upgrade. The Boot Block is a flash-protected section
of the ROM that checks for a valid system ROM flash when the system is powered on.

● If the system ROM is valid, the system starts normally.

● If the system ROM fails the validation check, the FailSafe Boot Block ROM provides enough support
to start the system from a ROMPaq diskette, which will program the system ROM with a valid image.

NOTE Some models also support recovery from a ROMPaq CD. ISO ROMPaq images are
included with selected models in the downloadable ROM SoftPaq. Recovery from USB devices
is also supported

When the Boot Block detects an invalid system ROM, the System Power LED blinks red eight times,
once every second, followed by a two-second pause. Also, you will hear eight beeps that correspond
to the blinks. A Boot Block recovery mode message is displayed on the screen (some models).
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To recover the system after it enters Boot Block recovery mode:

1. If there is a diskette in the diskette drive or a CD in the CD drive, remove the diskette and CD, and
power down the system.

2. Insert a ROMPaq diskette into the diskette drive, or if permitted on this workstation, insert a
ROMPaq CD into the CD drive. USB media such as an HP DriveKey can also be used.

3. Power on the workstation.

If no ROMPaq diskette or ROMPaq CD is found, you will be prompted to insert one and restart the
workstation.

If a setup password has been established, the Caps Lock light illuminates and you are prompted
to enter the password.

4. Enter the setup password.

If the system successfully starts from the diskette and successfully reprograms the ROM, then the
three keyboard lights illuminate. A rising tone series of beeps also signals successful completion.

5. Remove the diskette or CD, and restart the system.

The following table lists the various keyboard light combinations used by the Boot Block ROM (when a
PS/2 keyboard is attached to the workstation) and explains the meaning and action associated with
each combination.

Table 3-2  Keyboard light combinations used by Boot Block ROM

Light State Description

FailSafe Boot
Block Mode

Keyboard LED Activity State/Message

Num Lock On ROMPaq diskette or ROMPaq CD not present, is bad, or drive not ready

Caps Lock On Enter password

Num, Caps,
Scroll Lock

Blink On in sequence,
one at a time—N,C, SL

Keyboard locked in network mode

Num, Caps,
Scroll Lock

On Boot Block ROM Flash successful.

Diagnostic lights do not flash on USB keyboards.

Replicating the setup
The following procedures enable you to easily copy one setup configuration to other workstations of the
same model to provide faster, more consistent configuration of multiple workstations.

NOTE Both procedures require a diskette drive or a USB device such as an HP DriveKey.

To collect and replicate BIOS settings on multiple computers, use System Software Manager or
HP Client Manager Software. For more information, see http://www.hp.com/go/easydeploy.
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Copying to a single workstation

CAUTION A setup configuration is model-specific. File system corruption can result if the
source and target workstations are not the same model. For example, do not copy the setup
configuration from an HP xw6200 Workstation to an HP xw8400 Workstation.

1. Select a setup configuration to copy. Power off the workstation. In Windows, click Start>Shut
Down>Shut Down.

2. As soon as the workstation is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the
workstation and press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, disregard the keyboard error message that might appear.

3. If you are using a diskette, insert it now.

4. Click File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette.

5. Power off the workstation to be configured and insert the configuration diskette.

6. Power on the workstation to be configured.

7. As soon as the workstation is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

8. Click File>Replicated Setup>Restore from Removable Media, and follow the instructions on the
screen.

9. Restart the workstation when the configuration is complete.

Copying to multiple workstations

CAUTION A setup configuration is model-specific. File system corruption can result if the
source and target workstations are not the same model. For example, do not copy the setup
configuration from an HP xw6200 Workstation to an HP xw8400 Workstation.

This method takes a little longer to prepare the configuration diskette, but copying the configuration to
target workstations is significantly faster.

NOTE A bootable diskette is required for this procedure. If Windows XP is not available to create
a bootable diskette, use the method for copying to a single workstation instead (see Copying to
a single workstation on page 39).

1. Create a bootable diskette.

2. Select a setup configuration to copy. Power off the workstation. In Windows, click Start>Shut
Down>Shut Down.

3. Power on the workstation.

4. As soon as the workstation is powerd on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
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NOTE If you do not press the F10 key at the appropriate time, you must restart the
workstation and press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, disregard the keyboard error message that might appear.

5. If you are using a diskette, insert it now.

6. Click File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette.

7. Download a BIOS utility for replicating setup (repset.exe), and copy it onto the configuration
diskette. To obtain this utility, go to http://www.hp.com/support/files and enter the model number
of the workstation.

8. On the configuration diskette, create an autoexec.bat file containing the following command:
repset.exe cpqsetup.txt.

9. Power off the workstation to be configured. Insert the configuration diskette and power on the
workstation. The configuration utility runs automatically.

10. Restart the workstation when the configuration is complete.

Dual-state power  button
With ACPI enabled, the power button can function either as an on/off switch or as a sleep button. The
feature does not completely remove the power, but instead causes the workstation to enter a low-power
standby state. This feature enables you to power off without closing applications and to return to the
same operational state without any data loss.

To change the power button configuration:

1. Click Start, and select Control Panel>Power Options.

2. In Power Options Properties, click the Advanced tab.

3. In the Power Button section, select Hibernate. (Hibernate must be enabled in the Hibernate
tab.)

After configuring the power button to function as a button, press the power button to put the system in
a very low power state. Press the button again to bring the system to full power status. To completely
remove all power to the system, press and hold the power button for four seconds.

CAUTION Do not use the power button to power off the workstation unless the system is not
responding. Powering off the power without operating system interaction can cause damage to
or loss of data on the hard drive.

Worldwide web site
HP engineers rigorously test and debug software developed by HP and third-party suppliers, and
develop operating system specific support software, to ensure performance, compatibility, and reliability
for HP workstations.

When making the transition to new or revised operating systems, it is important to implement the support
software designed for that operating system. If you plan to run a version of Microsoft Windows that is
different from the version included with the workstation, you must install corresponding device drivers
and utilities to ensure that all features are supported and functioning properly.
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HP has made the task of locating, accessing, evaluating, and installing the latest support software easier.
You can download the software from http://www.hp.com/support. The Web site contains the latest
device drivers, utilities, and flashable ROM images needed to run the latest Microsoft Windows operating
system on the HP workstation.

Building blocks and partners
HP management solutions integrate with other systems management applications, and are based on
industry standards, such as:

● Web-Based Enterprise Management (WBEM)

● Windows Management Interface (WMI)

● Wake on LAN technology

● ACPI

● SMBIOS

● Pre-boot Execution Environment (PXE) support

● Alert Standard Format

Asset tracking and security
Asset tracking features incorporated into the workstation provide key asset tracking data that can be
managed using HP Systems Insight Manager, HP Client Manager Software, or other system
management applications. Seamless, automatic integration between asset tracking features and these
products enables you to choose the management tool that is best suited to the environment and to
leverage the investment in existing tools.

HP also offers several solutions for controlling access to valuable components and information.
ProtectTools Embedded Security, if installed, prevents unauthorized access to data, checks system
integrity, and authenticates third-party users attempting system access. Security features such as
ProtectTools and the Hood Sensor (Smart Cover Sensor) help to prevent unauthorized access to the
internal components of the workstation. By disabling parallel, serial, or USB ports, or by disabling
removable media boot capability, you can protect valuable data assets. Memory Change and Hood
Sensor (Smart Cover Sensor) alerts can be automatically forwarded to system management
applications to deliver proactive notification of tampering with a workstation’s internal components.

NOTE ProtectTools, the Hood Sensor (Smart Cover Sensor), and the Hood Lock (Smart Cover
Lock) are available as options on select systems.

Use the following utilities to manage security settings on the HP workstation:

● Computer Setup (F10) Utility (local).

● HP Client Manager Software or System Software Manager (remote). This software enables the
secure, consistent deployment and control of security settings from a simple command line utility.

The following table and sections refer to managing security features of the workstation locally through
the Computer Setup (F10) Utility.
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Table 3-3   Security features overview 

Feature Purpose How It Is Established

Removable Media Boot Control Prevents booting from the removable media
drives.

From the Computer Setup (F10)
Utility Menu.

Serial, Parallel, USB, or Infrared
Interface Control

Prevents transfer of data through the
integrated serial, parallel, USB, or infrared
interface.

From the Computer Setup (F10)
Utility menu.

Power-On Password Prevents use of the workstation until the
password is entered. This can apply to both
initial system startup and restarts.

From the Computer Setup (F10)
Utility menu.

Setup Password Prevents reconfiguration of the workstation
(use of the Setup Utilities) until the password
is entered.

From the Computer Setup (F10)
Utility menu.

Network Server Mode Provides unique security features for
workstations being used as servers.

From the Computer Setup (F10)
Utility menu.

Ownership Tag Displays ownership information, as defined by
the system administrator, during system
startup (protected by setup password).

From the Computer Setup (F10)
Utility menu.

Kensington Cable Lock
Provision 

Prevents entire system theft only. Install a Kensington cable lock to
secure the workstation to a fixed
object.

Padlock Loop Prevents access panel from being removed.
This loop can also be used to secure the unit
to a fixed object.

Install a padlock.

Access Panel Key Lock
(Standard)

Prevents removal of the access panel and all
internal components including optical and
floppy drives

Lock the access panel.

Universal Chassis Clamp Lock
(Optional)

The version without a cable discourages
access panel removal and prevents theft of I/
O devices. The version with a cable
additionally prevents entire system theft and
allows multiple systems to be secured with a
single cable.

Install a chassis clamp lock.

Hood Sensor Notifies a local or remote user when the
chassis access panel has been opened.

Install an intrusion sensor.

NOTE: For more information about the Computer Setup (F10) Utility, see Computer Setup (F10) Utility menu
on page 26.

Password security 
The power-on password prevents unauthorized use of the workstation by requiring entry of a password
to access applications or data each time the workstation is turned on or restarted. The setup password
specifically prevents unauthorized access to the Computer Setup (F10) Utility and can also be used as
an override to the power-on password. That is, when prompted for the power-on password, entering the
setup password instead will allow access to the workstation. 

A network-wide setup password can be established to enable the system administrator to log in to all
network systems to perform maintenance without having to know the power-on password.
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NOTE System Software Manager and HP Client Manager Software allow remote management
of setup passwords and other BIOS settings in a networked environment. For more information,
see http://www.hp.com/go/easydeploy.

Establishing a setup password  in the Computer Setup (F10) Utility

Establishing a setup password through the Computer Setup (F10) Utility prevents reconfiguration of the
workstation (through use of the Computer Setup (F10) Utility) until the password is entered.   

To establish a setup password using workstation setup:

1. Power on or restart the workstation. In Windows, click Start>Turn off>Restart.

2. As soon as the computer is powered on, press and hold F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the
workstation and press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, disregard the keyboard error message that might appear.

3. Select Security>Setup Password, and follow the onscreen instructions.

4. Before exiting, select File>Save Changes and click Exit.

Establishing a power-on password in the Computer Setup (F10) Utility

Establishing a power-on password through the Computer Setup (F10) Utility prevents access to the
workstation when power is on, unless the password is entered. When a power-on password is set, the
Computer Setup (F10) Utility presents Password Options under the Security menu. The password
options include Network Server Mode and Password Prompt on Warm Boot.

When Network Server Mode is disabled, the password must be entered each time the workstation is
powered on when the key icon appears on the monitor.    When Password Prompt on Warm Boot
is enabled, the password must also be entered each time the workstation is rebooted. When Network
Server Mode is enabled, the password prompt is not presented during POST, but any attached PS/2
keyboard remains locked until the power-on password is entered.

To enable Network Server Mode, a power-on password must be set. The option then shows up
under Advanced>Password Options. This feature allows the system to boot without asking for the
power-on password, but the keyboard and mouse are locked until you enter it. The keyboard LEDs
rotate constantly when the system is in locked mode

To establish a power-on password through workstation setup:

1. Power on or restart the workstation. In Windows, click Start>Shut Down>Restart.

2. As soon as the computer is powered on, press and hold the F10 until you enter the Computer Setup
(F10) Utility. Press Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the
workstation and press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, disregard the keyboard error message that might appear.
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3. Select Security>Power-On Password, and follow the on-screen instructions.

4. Before exiting, select File>Save Changes and, Exit.

Entering a power-on password

To enter a power-on password:   

1. Power on or restart the workstation. In Windows, click Start>Shut Down>Restart the
Computer.

2. When the key icon appears on the monitor, enter the current password, and press Enter.

NOTE Type carefully. For security reasons, the characters you enter do not appear on the
screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must restart the workstation, before you can continue.

Entering a setup password

If a setup password has been established on the workstation, you will be prompted to enter it each time
you run the Computer Setup (F10) Utility.    

To enter a setup password:

1. Power on or restart the workstation. In Windows, click Start>Shut Down>Restart the
Computer.

2. As soon as the workstation powers on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the
workstation and press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, disregard the keyboard error message that might appear.

3. When the key icon appears on the monitor, enter the setup password, and press Enter.

NOTE Type carefully. For security reasons, the characters you enter do not appear on the
screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must restart the workstation, before you can continue.
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Changing a power-on or setup password

To change a power-on or setup password:

1. Power on or restart the workstation. In Windows, click Start>Shut Down>Restart.

2. As soon as the workstation powers on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

NOTE If you do not press F10 at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, disregard the keyboard error message that might appear.

3. When the key icon appears, enter the current password, a slash (/) or alternate delimiter character,
your new password, another slash (/) or alternate delimiter character, and your new password again
as shown: current password/new password/new password

NOTE Type carefully. For security reasons, the characters you enter do not appear on the
screen.

4. Press Enter.

The new password takes effect the next time you power on the workstation.

NOTE See the table of National keyboard delimiter characters on page 46 for information
about the alternate delimiter characters. The power-on password and setup password can also
be changed using the Security options in the Computer Setup (F10) Utility.

Deleting a power-on or setup password
To delete a power-on or setup password:

1. Power on or restart the workstation. In Windows, click Start>Shut Down>Restart the Computer.

2. To delete the power-on password, go to step 3.

To delete the setup password, as soon as the workstation is powered on, press and hold the
F10 key until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if
necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the
computer and press and hold the F10 key again to access the utility.

Use the appropriate operating system shutdown process.

3. When the key icon appears, enter your current password followed by a slash (/) or alternate
delimiter character as shown: current password/.

4. Press Enter.

NOTE See the National keyboard delimiter characters on page 46 for information about the
alternate delimiter characters. The power-on password and setup password can also be changed
using the Security options in the Computer Setup (F10) Utility.
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National keyboard  delimiter characters

Each keyboard is designed to meet country-specific requirements. The syntax and keys that you use
for changing or deleting your password depend on the keyboard that came with your workstation.

Table 3-4  National keyboard delimiter characters

Arabic / Greek - Russian /

Belgian = Hebrew . Slovakian -

BHCSY* - Hungarian - Spanish -

Brazilian / Italian - Swedish/Finnish /

Chinese / Japanese / Swiss -

Czech - Korean / Taiwanese /

Danish - Latin American - Thai /

French ! Norwegian - Turkish .

French
Canadian

é Polish - U.K. English /

German - Portuguese - U.S. English /

* For Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia.

Clearing passwords

If you forget your password, you cannot access the workstation. See Resetting the password jumper
on page 180 for instructions on clearing passwords.

Hood sensor (Smart Cover Sensor) 
The optional hood sensor is a combination of hardware and software technology that can alert you when
the workstation side access panel has been removed. There are three levels of protection, as described
in the following table.

Table 3-5  Hood sensor protection levels

Level Setting Description

Level 0 Disabled Hood sensor is disabled (default).

Level 1 Notify User When the workstation is restarted, the screen displays
a message indicating that the workstation side access
panel has been removed.

Level 2 Setup Password When the workstation is restarted, the screen displays
a message indicating that the workstation side access
panel has been removed. You must enter the setup
password to continue.

These settings can be changed using the Computer Setup (F10) Utility.
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Setting the hood sensor protection level 

To set the hood sensor protection level:

1. Power on or restart the workstation. In Windows, click Start>Shut Down>Restart.

2. As soon as the workstation powers on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the
computer and press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, disregard the keyboard error message that might appear.

3. Select Security>Smart Cover>Cover Removal Sensor, then side access panel, and follow the
on-screen instructions.

4. Select File>Save Changes and click Exit.

Cable lock provision  (optional)
The rear panel of the chassis can accommodate a cable lock accessory that allows the workstation to
be physically secured to a work area.   

Security lock (optional)
This optional feature prevents entire system theft and discourages access panel removal.

Universal chassis clamp lock (optional)
The version without a cable discourages access panel removal and prevents theft of I/O devices. The
version with a cable also prevents entire system theft and allows multiple systems to be secured with a
single cable.

Access panel key lock
This lock prevents removal of the access panel and all internal components. The key is shipped on the
rear of the workstation.

Fault notification and recovery
Fault notification and recovery features combine innovative hardware and software technology to
prevent the loss of critical data and minimize unplanned downtime. 

If the workstation is connected to a network managed by HP Client Manager software, the computer
sends a fault notice to the network management application. With HP Client Manager software, you can
also remotely schedule diagnostics to automatically run on all managed PCs and create a summary
report of failed tests.

Drive Protection System
The Drive Protection System (DPS) is a diagnostic tool built into the hard drives installed in select HP
workstations. DPS is designed to help diagnose problems that might result in unwarranted hard drive
replacement.      

When HP workstations are built, each installed hard drive is tested using DPS, and a permanent record
of key information is written onto the drive. Each time DPS is run, test results are written to the hard
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drive. The service provider can use this information to help diagnose conditions that caused you to run
the DPS software.

ECC fault prediction and pre-failure warranty
When the workstation encounters an excessive number of error checking and correcting (ECC) memory
errors, the workstation displays a Local Alert message. This message contains detailed information
about the errant memory module,enabling you to take action before you experience non-correctable
memory errors. The pre-failure warranty for ECC memory modules enables you to replace these
modules, free of charge, before the modules actually fail. ECC memory modules are optional on selected
HP systems.    

Thermal sensor 
There are multiple sensors on your workstation:

● One per processor

● One per memory module (DIMM)

● One for the system board

● Some hard drives

The processor thermal sensor is a hardware and software feature that tracks the internal temperature
of the workstation. When combined with HP Client Manager Software, this features notifies the network
administrator when the normal range is exceeded. In this case, the processor clock automatically begins
to throttle. If the temperature does not decrease, the system eventually shuts down.
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4 Removal and replacement procedures

This chapter describes removal and replacement procedures of most internal components.

● Service considerations on page 50

● Customer Self Repair on page 54

● Pre-disassembly procedures on page 55

● System board components on page 56

● Removing and replacing components on page 58
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Service considerations
The following sections discuss service considerations that should be reviewed and practiced before
removing and replacing any system components.

WARNING!  When lifting or moving the workstation, do not use the front bezel as a handle
or lifting point. Lifting the workstation from the front bezel or lifting it incorrectly can cause the unit
to fall and harm the user and damage the workstation. To properly and safely lift the workstation,
lift it from the bottom of the unit.

Read cautions, warnings, and safety precautions
For your safety, you must review all safety warning and caution notices before accessing the
components of the workstation. Also, review the Safety and Regulatory Guide that came with your
workstation for more information.

WARNING! Some parts inside the computer will be hot. Power off and unplug the system, and
then wait approximately three to five minutes for them to cool before opening the system access
panels or touching internal components.

Electrostatic discharge information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) might not appear to be affected at all and can work
perfectly throughout a normal cycle. The device can function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.

Generating static
The following table shows that Different activities generate different amounts of static electricity. Static
electricity increases as humidity decreases.

Table 4-1  Static electricity

 Relative Humidity

Event 5% 4% 1%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

7,500 V

3,000 V

400 V

15,000 V

5,000 V

800 V

35,000 V

12,000 V

6,000 V

Removing bubble pack from PCB

Packing PCBs in foam-lined box

7,000 V

5,000 V

20,000 V

11,000 V

26,500 V

21,000 V

CAUTION 700 volts can degrade a product.
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Preventing  electrostatic damage to equipment
Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories.

● Transport products in static-safe containers, such as tubes, bags, or boxes, to avoid hand contact.

● Protect all electrostatic parts and assemblies with conductive or approved containers or packaging.

● Keep electrostatic-sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from their containers.

● When handling or touching a sensitive component or assembly, ground yourself by touching the
chassis.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive
foam.

Personal grounding methods and equipment 
Use the following equipment to prevent static electricity damage to equipment:

● Wrist straps are flexible straps with a maximum of one megohm ± 10% resistance in the ground
cords. To provide a proper ground, wear the strap against bare skin. The ground cord must be
connected and fit snugly into the banana plug connector on the grounding mat or workstation.

● Heel straps, toe straps, and boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both
feet with a maximum of one-megohm ± 10% resistance between the operator and ground.

Table 4-2  Static shielding protection levels

Method Voltage

Antistatic plastic

Carbon-loaded plastic

Metallized laminate

1,500

7,500

15,000

Grounding the work area
To prevent static damage at the work area:

● Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

● Turn off power and input signals before inserting and removing connectors or test equipment

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.
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● Keep work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended materials and equipment
It is recommended that the following materials and equipment be used to prevent static electricity:

● Antistatic tape

● Antistatic smocks, aprons, or sleeve protectors

● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with ground cord of one-megohm ± 10% resistance

● Static-dissipative table or floor mats with hard tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one-megohm ± 10% resistance

● Material handling packages

● Conductive plastic bags and tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes

Required tools and software
The following tools and software are required to service your workstation:

● Torx T-15 screwdriver or flathead screwdriver

● Diagnostics software

Screws
The screws used in the workstation are not interchangeable. They might have standard or metric threads
and might be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with
the removed part and then returned to their proper locations.

Special handling of components
The following components require special handling when servicing the workstation.
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Cables and connectors 
Cables must be handled with care to avoid damage. Apply only the tension required to seat or unseat
the cables during insertion or removal from the connector. Handle cables by the connector or pull strap
whenever possible. In all cases, avoid bending or twisting the cables, and be sure that the cables are
routed in such a way that they cannot be caught or snagged by parts being removed or replaced. 

CAUTION  When servicing this workstation, be sure that cables are placed in their proper
location during the reassembly process. Improper cable placement can damage the workstation.

Hard drives 
Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
guideline applies to failed drives and replacement spares. Keep the following guidelines in mind as well:

● If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the workstation.

● Avoid dropping drives from any height onto any surface.

● If you are inserting or removing a hard drive, power off the workstation. Do not remove a hard drive
while the workstation is on.

● Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector. For more information about preventing electrostatic damage, see
Electrostatic discharge information on page 50.

● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

Lithium coin cell battery 
The battery that comes with the workstation provides power to the real-time clock and has a minimum
lifetime of about three years.

For instructions on battery removal and replacement, see Battery on page 78.

WARNING!  This workstation contains a lithium battery. A risk of fire and chemical burn exists
if the battery is handled improperly. Do not disassemble, crush, puncture, short external contacts,
dispose of in water or fire, or expose it to temperatures higher than 140 degrees F (60 degrees
C).

NOTE Batteries, battery packs, and accumulators should not be disposed of with general
household waste.
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Customer Self Repair
Customer Self Repair (CSR) enables you to obtain replacement parts and install them yourself on your
workstation. The following table indicates which workstation components are customer-serviceable.
See http://www.hp.com/go/selfrepair/ for more information.
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Pre-disassembly procedures
Perform the following steps before servicing the workstation:

1. Remove or disengage any security devices that prohibit opening the workstation.

2. Close any open software applications.

3. Remove any diskettes or CDs from the workstation.

4. Exit the operating system.

5. Shut down the workstation and any peripheral devices that are connected to it.

6. Disconnect the power cord from the electrical outlet and then from the workstation.

7. Disconnect all peripheral device cables from the workstation.
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System board components
The following image shows the system board connectors and sockets on the HP xw8400 Workstation.

Figure 4-1  System board identification

Table 4-3  System board components

Item Description Item Description Item Description Item Description

1 Memory Fan 12 Rear PCI Fan 23 PCI Express x16 (x4
performance)

34 Clear CMOS Button

2 PS/2 Keyboard/
Mouse

13 PCI Express x16
(graphics)

24 Front USB 35 Processor 1 Fan

3 Parallel 14 Battery 25 Serial SCSI (SAS) 36 Processor Power

4 Serial 15 PCI Express x8 (x4
performance)**

26 Serial ATA (SATA) 37 Processor 2

5 USB 16 Crisis Recovery
Jumper

27 Password Jumper 38 Processor 1

6 Network/USB 17 Auxiliary Audio 28 Front Chassis Fan 39 Memory Module
Pairs

7 Internal USB 18 Front audio 29 Boot Block Jumper 40 Auxiliary Power
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Item Description Item Description Item Description Item Description

8 IEEE 1394 19 Front IEEE 1394 30 Primary IDE* 41 Main Power

9 Audio 20 Front Control Panel 31 Diskette Drive

10 Rear Chassis Fan 21 PCI-X 100 32 Processor 2 Fan

11 PCI (32-bit, 33 MHz) 22 PCI-X 133 33 Hard Disk Activity
LED

* The Primary IDE connector is generally used for hard drives.

** The PCI Express x8 is a PCI Express x8 connector that has x4 bandwidth.

System board architecture  
The following image shows the HP xw8400 Workstation block diagram.

Figure 4-2  System board block diagram

Table 4-3  System board components (continued)
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Removing and replacing components
This section discusses the procedures necessary to remove and install various hardware components
on your workstation.

Before servicing or upgrading your workstation:

1. Review the safety precautions and the Service considerations on page 50, as well as the Safety
and Regulatory Information.

2. Locate and clear a suitable work area.

3. Shut down the system and remove power from the unit.

4. Gather your tools.

5. Remove and security devices.

6. Service your unit.

7. Restore power to your unit.

NOTE Prior to removing and replacing a component, make sure you remove all installed
components that obstruct or prevent the removal of the component.

If you are unsure how to remove a particular component, please do one of the following:

1. Refer to the appropriate section in this chapter.

2. If the content you desire is not referenced in this chapter, see www.hp.com/support/
xw8400_manuals and look under “Setup and Install – General” for instructions.

3. See the manufacturer’s web site for instructions for a third party (non-HP) component.

Disassembly order 
Use the following table to determine the sequence in which to remove the major components.

        

Pre-cisassembly ( Pre-
disassembly procedures
on page 55)

Locks (Removing the
security lock (optional)
on page 59)

Access panel (Access panel on page 60)

 Hood sensor (Hood sensor
(Smart Cover Sensor)
on page 63)

    

Front bezel (Front bezel
on page 61)

Front panel I/O device assembly (Front
panel I/O device assembly
on page 63)
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Power button and front
speaker (Power button
assembly and system
speaker on page 64)

Optical drive (Optical
drive on page 79)

Diskette drive (Diskette
drive (optional)
on page 82)

Bezel blanks (Bezel
blanks on page 62)

  Power supply (Power
supply on page 65)

    

  System fan (System/
memory fan assembly
on page 66)

    

Memory (Memory
on page 67)

Front fan removal (optional)
(Front fan removal
(Optional) on page 76)

Battery (Battery
on page 78)

Hard drive (Hard drive
on page 84)

CPU heatsink (Removing the CPU
heatsink on page 88)

Processor (Removing the
processor on page 91)

PCI retainer (PCI retainer on page 71)

PCI retention clamp (PCI
retention clamp
on page 73)

PCI or PCI Express card (Removing
PCI or PCI Express cards
on page 74)

CPU heatsink
(Removing the CPU
heatsink on page 88)

Processor (Removing the
processor on page 91)

System board (System
board on page 94)

Removing the security lock (optional)
If a security padlock is installed, remove it before servicing the unit. To remove the padlock, unlock it
and slide it out of the padlock loop as shown in the following image.
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Figure 4-3  Removing the security lock

Removing the cable lock  (optional) 
If a cable lock is installed, remove it before servicing the unit. To remove the cable lock, unlock it and
pull it out of the cable lock slot as shown in the following image.

Figure 4-4  Removing the cable lock

Access panel   
Before accessing the internal components of the workstation, the access panel must be removed.

To remove the access panel:
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WARNING! Before removing the workstation access panel, be sure that the workstation is
powered off and that the power cord is disconnected from the electrical outlet.

1. Disconnect power from the system.

2. If a lock is present, unlock the access panel. The keys are on the rear panel (Rear panel
components on page 4). Also, unlock any other locks that are present (Kensington, or Padlock).

3. Pull up on the handle and lift off the cover.

Figure 4-5  Opening the access panel

To replace the access panel, align the bottom groove of the side panel with the bottom edge of the
chassis. Rotate the side panel toward the chassis and press firmly until the latch engages.

Front bezel   
To remove the front bezel:

1. Lift up on the three (1) tabs located on the front bezel.

2. Rotate the front bezel away (2) from the chassis, and remove the bezel.
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Figure 4-6  Opening the front bezel

Bezel blanks   
To remove the bezel blanks:

1. Disconnect power from the system ( Pre-disassembly procedures on page 55) and remove the
front bezel (Front bezel on page 61)

2. Remove the bezel blanks by squeezing in on the tabs (1) and pushing the bezel blanks out (2).

Figure 4-7  Removing the bezel blanks
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Hood sensor (Smart Cover Sensor)
To remove the hood sensor:

1. Disconnect power from the system ( Pre-disassembly procedures on page 55) and remove the
access panel (Access panel on page 60). Lay the workstation on its side with the system board
facing up.

2. Disconnect the white 1 x 3 hood sensor connector from the inline connector attached to the front
panel harness.

3. Slide the hood sensor forward.

4. Push the hood sensor down and remove it from the chassis.

Figure 4-8  Removing the hood sensor

To replace the hood sensor, reverse the previous steps.

Front panel I/O device assembly   
To remove the front panel I/O device assembly:

1. Disconnect power from the system ( Pre-disassembly procedures on page 55). Remove the access
panel (Access panel on page 60) and the front bezel (Front bezel on page 61).

2. Unlatch the plastic snap that secures the cables inside the chassis and, disconnect the front panel
I/O device assembly cables from the system board.

3. Remove the screws that hold the front panel I/O device assembly and bracket to the chassis, and
remove the screws that hold the front panel I/O device assembly to the bracket.

4. Pull the front panel I/O device assembly out about two inches away from the chassis.
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5. Pull the bracket away from the front panel I/O device assembly.

Figure 4-9  Removing the front panel I/O device assembly

6. Slide the front panel cables through the chassis and out the front of the unit.

To replace the front panel I/O device assembly, reverse the previous steps.

Power button assembly and system speaker   
The power button and the system speaker are part of the same assembly.

To remove the power button:

1. Disconnect power from the system ( Pre-disassembly procedures on page 55) and remove the
access panel (Access panel on page 60).

2. Remove the front bezel (Front bezel on page 61) and the front panel I/O device assembly (Front
panel I/O device assembly on page 63).

3. Disconnect the power button assembly cable from the system board.

4. Disconnect the speaker wire and the hood sensor from the inline connectors on the power button
assembly cable.

5. Remove the screw that secures the power button assembly to the chassis.

6. Pull the power button assembly away from the chassis.

7. Slide the power button assembly out from the front of the chassis.

To remove the speaker:

1. Disconnect the speaker cable from the inline front panel I/O device assembly cable, if you have
not already done so.

64 Chapter 4   Removal and replacement procedures ENWW



2. Slide the speaker away from the three flanges and remove it from the chassis.

Figure 4-10  Removing the speaker

Power supply
1. Disconnect power from the system ( Pre-disassembly procedures on page 55), and remove the

access panel (Access panel on page 60). Place the workstation on its side with the system board
facing up.

2. Disconnect the power supply from the system board.

CAUTION Be sure you can differentiate which power cable was disconnected from the
PCI Express x16 graphics card and which power cable was disconnected from the system
board. These two cables look similar. The PCI Express power cable has a black connector,
and the power cable has a white connector. When power is present, NEVER connect the
PCI Express power cable to the system board. If you do so, the system board can be
damaged and your warranty voided. To see a picture of the PCI Express cable and where
it must be connected, see the PCI or PCI Express installation on page 75.

3. Disconnect the optical drives, diskette drive, hard drives, and graphics card (select models only)
from the power supply.

4. Remove the four screws (1) from the back panel.

5. Slide the power supply toward the front, and lift up (2) to remove it from the chassis.
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Figure 4-11  Removing the power supply

To install the power supply, reverse the previous steps.

System/memory fan assembly
The system fan and memory fan are connected and treated as a unit. To remove the system/memory
fan assembly:

1. Disconnect power from the system ( Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 60). Place the workstation on its side with the system board
facing up.

2. Press the green tab (2) at the base of the memory fan, and lift it up.

3. Disconnect the system fan and memory fan power plugs from their system board connectors (1).
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4. Press down on the ribbed portion of the system fan housing (3), rotate the fan housing down, and
lift the unit out of the chassis.

Figure 4-12  Removing the system/memory fan assembly

To replace a system/memory fan assembly, reverse the previous steps.

CAUTION When installing the system/memory fan assembly, be sure that the fan is situated
so that the airflow direction is going out of the chassis to avoid overheating.

Memory       

Memory module features

● Eight memory slots for DIMMs

● 512–MB, 1-GB , 2-GB, 4-GB pairs

● 32 GB maximum configuration with 4-GB DIMMs

● Configurable for Single Channel (one DIMM), Dual Channel (two DIMMs), or Quad Channel (four
to eight DIMMs)

● DDR2-667 or DDR2-533, Fully Buffered DIMMs (FBD)

● No support for mirroring

● No spare DIMM support

● Standard FBD, ECC (72-bit ECC)

Memory module requirements

● Use only PC2-5300F, FBDs. Certified and warranted HP memory is recommended.

● Match DIMM pairs by size and type.
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Removing memory module
1. Disconnect power from the system ( Pre-disassembly procedures on page 55), and remove the

access panel (Access panel on page 60). Place the workstation on its side with the system board
facing up.

CAUTION To ensure that memory modules are not damaged during removal or
installation, power off the workstation and unplug the power cord from the AC power outlet.
Wait until the LED on the back of the power supply turns off before removing memory. If you
do not unplug the power cord while installing memory, your memory modules might be
damaged and the system will not recognize the memory changes.

2. Press the green tab at the base of the memory fan (1) and lift it up (2) to expose the memory
modules.

Figure 4-13  Rotating the memory fan

3. Gently push out on the socket levers.
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4. Lift the DIMM straight up, and remove it from the unit.

Figure 4-14  Removing DIMM

NOTE DIMMs and DIMM sockets are keyed for proper installation. Be sure these guides align
when installing a DIMM.

Installing memory module

CAUTION HP only ships DIMMs that are electrically and thermally compatible with this product.
Because third-party DIMMs might not be electrically or thermally compatible, they are not
supported by HP.

You must load memory modules in valid configurations:

● If loading only one DIMM, install it in slot 1. Otherwise, DIMMs must be loaded as matched pairs.

● If loading two DIMMs, install them in slots 1 and 3.

● If loading four DIMMs, install them in slots 1, 3, 5, and 7.

● If loading six DIMMs, install them in slots 1 through 5, and 7.

● If loading eight DIMMs, install them in all slots.
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● Load the memory module pairs in order of size, from smallest to largest.

Figure 4-15  Identifying memory slots

The BIOS generates warnings/errors on invalid memory configurations.

● If there is no way to obtain a valid memory configuration by disabling some of the plugged-in
memory, the BIOS will halt with a diagnostics 2006 code for memory error (five beeps and blinks).

● If the BIOS can find a valid memory configuration by disabling some of the plugged-in memory, it
will do so and report a warning during POST (“215-mismatched memory”). The system can still be
booted in this condition.

Installing a DIMM
1. Disconnect power from the system ( Pre-disassembly procedures on page 55) and remove the

access panel (Access panel on page 60). Lay the workstation on its side with the system board
facing up.

2. Press the green tab at the base of the memory fan (1) and lift it up (2) to expose the memory
modules.

Figure 4-16  Rotating the memory fan
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3. Gently push out on the socket levers.

4. Lower the DIMM straight down, and be sure the socket levers secure the module into place.

5. Lower the memory fan until it snaps into place.

NOTE Ensure that all cables are clear of the fan housing when lowering the memory fan.

PCI slots

Figure 4-17  Identifying PCI slots

Table 4-4  PCI slots

Slot Type Ref

1 PCI (32-bit, 33 MHz) J21

2 PCI Express x16 graphics J41

3 PCI x8 (x4 performance) J20

4 PCI Express x16 (x4 performance) J31

5 PCI-X 133 J22

6 PCI-X 100 J23

7 PCI-X 100 J23

PCI retainer  
For added protection, some cards have PCI retainers installed to prevent movement during shipping.
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Removing the PCI retainer

1. Disconnect power from the system ( Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 60). Place the workstation on its side with the system board
facing up.

2. For short or tall cards, lift the PCI retainer arm (1) with one hand, press in on the sides (2) of the
retainer, and rotate it (3) out of the chassis.

Figure 4-18  Removing the short or tall card PCI retainer

Installing the PCI retainer

1. Disconnect power from the system ( Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 60). Place the workstation on its side with the system board
facing up.
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2. For short or tall PCI cards, attach the hooks of the PCI retainer (1) under the slots on the rear of
the chassis, and then rotate the retainer down until the retainer arm (2) supports the card.

Figure 4-19  Installing the short or tall card PCI retainer

PCI retention clamp  
1. Disconnect power from the system ( Pre-disassembly procedures on page 55), and remove the

access panel (Access panel on page 60). Place the workstation on its side with the system board
facing up.

2. Open the PCI retention clamp by pressing down on the two green clips at the ends of the clamp
and rotating the clamp toward the back of the system.

Figure 4-20  Opening the PCI retention clamp
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PCI Express    
PCI Express is a point-to-point architecture and uses a serial data transmission protocol. A single PCI
Express lane consists of four wires and can transmit 250 MB/s in a single direction or 500 MB/s in both
directions simultaneously. This bandwidth is not affected by what is happening on other PCI Express
buses or legacy PCI/PCI-X buses (provided that total bandwidth can be handled by the CPU and the
memory subsystem.) The transmission protocol is somewhat similar to that used for a LAN connection
and contains error correction and detection, packet addressing, and other network features.

PCI Express improves system attributes. PCI Express enables a low-power, scalable, high-bandwidth
communication path with a small number of connections (wires) compared to traditional parallel
interfaces (for example, PCI).

The PCI Express I/O slots can support other PCI Express cards with lesser bus bandwidth than what is
physically defined for the slot. Use the following table to determine compatibility.

For example, a PCI Express x8 card does not work in a PCI Express x1 slot, but a PCI Express x1 card
works in a PCI Express x8 slot.

NOTE Slot 3: The HP xw8400 Workstation contains one PCI Express x8 slot that supports x4
bandwidth. If a PCI Express x8 card is plugged into the PCI Express x8 slot, the card runs at x4
bandwidth.

Slot 4: The HP xw8400 Workstation contains one PCI Express x16 slot that supports x4
bandwidth. If a PCI Express x8 or x16 card is plugged into the PCI Express x8 slot, the card runs
at x4 bandwidth.

Table 4-5   PCI Express compatibility matrix for xw8400

 Slot 2

x16 mechanical

x16 electrical

Slot 3

x8 mechanical

x4 electrical

Slot 4

x16 mechanical

x4 electrical

PCI Express x1
Card

Yes Yes Yes

PCI Express x4
Card

Yes Yes Yes

PCI Express x8
Card

Yes Yes Yes

PCI Express x16
Card

Yes No Yes

Removing PCI or PCI Express cards   
1. Disconnect power from the system ( Pre-disassembly procedures on page 55), and remove the

access panel (Access panel on page 60). Place the workstation on its side with the system board
facing up. Remove the PCI retainer (PCI retainer on page 71) if present.

2. Open the PCI retention clamp by pressing down on the two green clips at the ends of the clamp
(1) and rotating the clamp toward the back of the system.
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3. Lift the PCI card out of the chassis (2). If removing a PCI Express high-end graphics card, remove
the auxiliary power supply cable (not illustrated) if required, and move the lever to release the card
and lift it out of the chassis (3). Store the card in an anti-static bag.

4. Close the PCI retention clamp.

Figure 4-21  Removing the PCI or PCI-E Card

PCI or PCI Express installation
1. Disconnect power from the system ( Pre-disassembly procedures on page 55), and remove the

access panel (Access panel on page 60). Place the workstation on its side with the system board
facing up, and remove the PCI retainer(PCI retention clamp on page 73).

2. Open the PCI retention clamp by pressing down on the two green clips (1) at the ends of the clamp
and rotating the clamp toward the back of the system.

3. Remove the PCI slot cover (2).

4. Lower the PCI (3) or PCI Express (3) card into the chassis. Verify that the keyed components of
the card align with the socket.

If installing a card with an auxiliary power connector, plug in the power supply cable or adapter
cable supplied with the card (4). This type of card includes, but is not limited to, a PCI Express
graphics card greater than 75 W, and a 1394a I/O card.

5. Ensure that all cards are properly seated, and close the PCI retention clamp.
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Figure 4-22  Installing the PCI or PCI-E card

Front fan removal (Optional)   
To remove the front fan:

1. Disconnect power from the system ( Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 60). Place the workstation on its side with the system board
facing up.

2. Disconnect the fan wire from the connector on the system board.

3. Release the two card guide latches. Pivot the card guide toward the system board (1), and lift it
out of the chassis (2).

Figure 4-23  Removing the card guide
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4. Remove the fan from the card guide by applying outward pressure on the card guide while lifting
the fan away.

Figure 4-24  Removing the fan from the card guide

To install the front fan:

1. Place the fan in the card guide with the fan label facing into the card guide, and the fan protector
screen facing outward.

NOTE  Ensure that the fan blows toward the rear of the chassis.

2. Place the fan wire through the slot in the card guide.

3. Snap the fan into place in the card guide.

Figure 4-25  Installing the fan in the card guide

4. Lower the card guide with installed fan into the chassis. Place the card guide tabs into the chassis
slots and snap the card guide into place.

5. Plug the fan wire into its connector on the system board.
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Battery   

CAUTION Before removing the battery, be sure your CMOS settings are backed up because
all CMOS settings are lost when the battery is removed. To back up the CMOS settings, use
Computer Setup and run the Save to Diskette option from the File menu.

1. Disconnect power from the system ( Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 60). Place the workstation on its side with the system board
facing up.

2. On the system board, press on the release tab of the battery holder.

3. Rotate the battery enough to get beyond the latch, and lift it straight up.

Figure 4-26  Removing the battery

To install the battery slide the battery back in until it snaps back into place.

Power connections to drives   
For help in identifying power cables, refer to the following figure and table. Route or tie cables so that
they cannot interfere with the CPU heatsink fans.

CAUTION Be sure you can differentiate which power cable connects to the PCI Express x16
graphics card and which power cable connects to the system board. These two cables look very
similar. The PCI Express power cable has a black connector, and the power cable has a white
connector. When power is present, you must NEVER connect the PCI Express power cable to
the system board. If you do so, the system board may be damaged and your warranty voided.
To see a picture of the PCI Express cable and where it must be connected, see the PCI or PCI
Express installation on page 75.
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Figure 4-27  Identifying correct power connections

Table 4-6  Power connector descriptions

Connector Description

P1 24–pin Power Connector

P2 4–pin Memory Connector

P3 8–pin CPU0 Connector

P4–P8 SATA and IDE ODD/
Accessory Power Connectors

P9 Diskette Connector

P10–P14 HDD Connector

P15 PCI-E Connector

Optical drive   
Your workstation might have a SATA or an IDE optical drive. To remove the optical drive.

1. Disconnect power from the system ( Pre-disassembly procedures on page 55). Remove the access
panel (Access panel on page 60) and the front bezel (Front bezel on page 61).
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2. Disconnect the audio (1), data (2), and power (3) cables from the drive. The connector colors might
be different than illustrated.

NOTE The audio cable is only required for Linux-based systems.

Figure 4-28  Disconnecting the IDE (left) or SATA (right) cable from the optical drive

3. Lift the green drivelock release lever, and gently slide the drive out of the chassis.

Figure 4-29  Removing the optical drive from the chassis
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To replace an optical drive:

1. Lift the green drivelock release lever while sliding the optical drive into the bay. When the optical
drive is partially inserted, release the drivelock release lever, and slide the drive completely into
the bay until the drive is secured.

CAUTION Ensure that the optical drive is secure. Failure to do so can cause damage to
the drive when moving the workstation.

2. Connect the power, data , and audio (if required) cables to the drive and workstation.

NOTE The audio cable is only required for Linux-based systems.

3. If you are installing more than one optical drive, route the cable as in the following image.

NOTE The data cable for IDE optical drives is routed under the system board.

Figure 4-30  Connecting IDE (left) or SATA (right) optical drive cable to system board

Replacing the SATA optical drive data cable
If your workstation has a SATA optical drive, replace the cable as follows:

1. Disconnect power from the system ( Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 60). Place the workstation on its side with the system board
facing up.

2. Disconnect the SATA data cable from the system board and from the optical drive.

3. Replace the cable. Attach it to the optical drive and its system board connector as shown.
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Figure 4-31  Connecting the SATA optical drive cable to the system board

Diskette drive (optional)   
To remove a diskette drive:

1. Disconnect power from the system ( Pre-disassembly procedures on page 55). Remove the access
panel (Access panel on page 60) and the front bezel (Front bezel on page 61).

2. Disconnect the cables from the back of the diskette drive.

Figure 4-32  Disconnecting cables from the diskette drive
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3. While lifting the green drivelock release tab, slide the drive forward out of the chassis.

Figure 4-33  Removing the diskette drive from the chassis

4. Remove the diskette drive from its bracket by removing the two M3 screws in the rear-most holes
and pulling the diskette drive from the bracket.

Figure 4-34  Removing the diskette drive from the bracket

To replace a diskette drive:

1. Slide the diskette drive into the bracket, and secure it with two M3 screws.

2. While lifting the green drivelock release tab, slide the drive forward into the chassis.
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3. Route the diskette drive data cable between the system board and the hard drive cage. Your cable
might look different than the one shown.

CAUTION The cable must stay between the system board and the hard drive cage. It might
be necessary to push the cable down so that it catches on the system board. This routing
method is important because it avoids interference with the CPU heatsink fans and blocking
airflow.

Figure 4-35  Routing the diskette drive cable to the system board

4. Connect the cables to the back of the diskette drive.

Hard drive   

Replacing a hard drive
For more information on SATA hard drives and the SATA RAID configuration, see Appendix B—SATA
devices on page 141.

Removing a hard drive

1. Disconnect power from the system ( Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 60).

2. Disconnect the cables from the hard drive.
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3. Push in on the green drivelock release tabs, and pull the hard drive out of the chassis.

Figure 4-36  Removing the hard drive

Installing a hard drive

1. Select a drive bay in which to install the drive. If installing more than one hard drive, use the hard
drive order shown in the following image.

Figure 4-37  Identifying hard drive installation order

2. Squeeze the green tabs, and slide the rails out of the empty bay.

ENWW Removing and replacing components 85



3. Attach the rails to the hard drive. Align the pins on the rails with the hard drive holes, and snap the
rails into place.

Figure 4-38  Attaching rails to the hard drive

4. Push the drive into the selected bay until it snaps into place.

5. Attach a data cable from a SATA connector on the system board to the hard drive, and attach a
power cable to the drive.

Figure 4-39  Replacing the SATA hard drive
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6. For a SAS hard drive, attach a SAS/SATA adapter to the connector on the hard drive. Attach a
data cable from a SAS connector on the system board to the hard drive, and attach a power cable
to the drive.

Figure 4-40  Installing the SAS/SATA adapter (left) and cable (right)

Installing a hard drive In the fifth hard drive bay
To install a hard drive into fifth HDD bay:

1. Place the workstation on its side, and remove the three drive screws that are located on the bottom
of the chassis.

Figure 4-41  Installing screws for the hard drive in the fifth hard drive bay

2. Insert the drive into bay 5, and align the holes in the bottom of the hard drive with the screw holes
at the base of the chassis.

3. Insert the screws through the base, and tighten them to secure the hard drive to the chassis.
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4. Attach a data cable from a SATA connector on the system board to the hard drive, and attach the
fifth drive power cable to the drive.

Figure 4-42  Attaching the data cable for the SATA hard drive in the fifth hard drive bay

Processor heatsink   

Removing the CPU heatsink

NOTE The following illustrated CPU heatsink is typical of what you might have in your
workstation. Be aware that different variations of the CPU heatsinks exist, but the overall
procedures listed are sufficient to assist you in removing the CPU heatsink.

1. Shut down the workstation, and disconnect power from the system ( Pre-disassembly
procedures on page 55). Remove the access panel (Access panel on page 60), and place the
workstation on its side with the system board facing up.
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2. Remove the four processor screws slowly, being sure to loosen all the screws evenly. Loosen one
pair of diagonally opposite screws (1) until the screw shanks disengage from the system board,
and then loosen the remaining pair (2). Do not fully loosen one screw, then move on to the next.
Loosen all of the screws a little at a time, so that the processor remains level.

Figure 4-43  Identifying proper screw removal order

3. Disconnect the CPU heatsink fan connector (1) from the system board.

4. Before lifting the heatsink, carefully break the adhesive compound between the CPU heatsink and
processor by rotating the heatsink back and forth (2).

Figure 4-44  Removing the CPU heatsink from the system board

5. Use alcohol and a soft cloth to clean all of the thermal interface material residue from the CPU
heatsink and processor.

CAUTION Allow the alcohol on the processor and CPU heatsink to dry completely.
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Replacing the CPU heatsink
1. Disconnect power from the system ( Pre-disassembly procedures on page 55). Remove the access

panel (Access panel on page 60) and the CPU heatsink (Removing the CPU heatsink
on page 88).

2. Use alcohol and a soft cloth to clean all of the thermal interface material residue from the CPU
heatsink and processor.

CAUTION Allow the alcohol on the processor and CPU heatsink to dry completely.

3. Place the CPU heatsink on top of the processor, and align the four mounting screws with the
holes (1) in the system board.

NOTE If both CPU heatsinks were removed, be sure that all system board standoffs
engage with the keyholes in the chassis, and that the system board connectors engage
correctly with the rear I/O panel, and push back on the system board while engaging the
CPU heatsink screws with the chassis standoffs. You only need to push back when trying
to engage the first screw.

Figure 4-45  Replacing the CPU heatsink on the system board
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4. Insert and tighten the four CPU heatsink screws. First, tighten all of the screws partially so that the
CPU heatsink remains level. Next, fully tighten one pair of diagonally opposite screws (1), and then
fully tighten the remaining pair (2). Tighten firmly to a torque setting of 6 in-lb.

Figure 4-46  Identifying proper screw removal order

5. Connect the CPU heatsink fan connector to the system board (2) as shown in Figure 1–45.

Processor   

Removing the processor
1. Disconnect power from the system ( Pre-disassembly procedures on page 55). Remove the access

panel (Access panel on page 60) and the CPU heatsink (Removing the CPU heatsink
on page 88).
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2. Raise the processor socket handle (1) fully (the full swing angle of the lever is approximately 105
degrees). Lift the processor socket cover (2).

Figure 4-47  Raising the processor socket handle

3. Lift the processor straight out of the socket.

Figure 4-48  Lifting the processor from the socket

CAUTION To avoid bending the socket pins, keep the processor perfectly flat when removing
or installing it.

NOTE Store the processor in a safe place where it will not be damaged.
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Replacing the processor
1. Disconnect power from the system ( Pre-disassembly procedures on page 55). Remove the access

panel (Access panel on page 60), the CPU heatsink (Removing the CPU heatsink on page 88),
and the processor (Removing the processor on page 91).

2. Raise the processor socket handle fully (the full swing angle of the lever is approximately 105
degrees).

CAUTION Socket pins are delicate and bend easily. Use extreme care when placing the
processor in the socket to avoid bending pins.

3. Align the notches in the processor base with the tabs on the socket. Seat the processor into the
socket. Ensure that the underside of the processor is level with the top of the processor socket.
Close the processor cover plate. Lightly press down on the processor cover plate while closing the
socket lever.

Figure 4-49  Seating the processor
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System board

Removing the system board
1. Disconnect power from the system ( Pre-disassembly procedures on page 55), and remove the

access panel (Access panel on page 60). Place the workstation on its side with the system board
facing up. Remove all expansion boards, graphics cards (Removing PCI or PCI Express cards
on page 74), and the CPU heatsink (Processor heatsink on page 88). If an airflow duct is installed,
remove the system/memory fan assembly (Power supply on page 65).

2. Disconnect all cables from the system board.

CAUTION Be sure you can differentiate which power cable was disconnected from the
PCI Express x16 graphics card and which power cable was disconnected from the system
board. These two cables look similar. The PCI Express power cable has a black connector
and the power cable has a white connector. When power is present, NEVER connect the
PCI Express power cable to the system board. If you do so, the system board can be
damaged and your warranty voided. To see a picture of the PCI Express cable and where
it must be connected, see PCI or PCI Express installation on page 75.

NOTE Make note of the cable connections before disconnecting them from the system
board. See Power connections to drives on page 78for more information.

3. Slide the system board forward (1) to disengage the metal mounting standoffs from the chassis.

CAUTION Do not attempt to remove the eight system board mounting screws. These
screws are permanently secured and are not removable.

4. Lift the system board out (2) of the chassis, being careful not to damage the cables and rear panel
connectors. You can lift the board by the rear audio connector and the 2 x 4 power connector.

Figure 4-50  Removing the system board
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Replacing the System Board:
1. Insert the system board straight down, and be sure that all system board standoffs engage with

the keyholes in the chassis.

NOTE Be sure the system board connectors engage correctly with the rear I/O panel.

2. Push back on the board while maintaining downward pressure on the board, so all standoffs remain
engaged.

3. Install the heatsink (Replacing the CPU heatsink on page 90).
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5 System diagnostics and
troubleshooting

This chapter discusses the tools available for diagnosing and troubleshooting system issues.

● E-Support on page 98

● Troubleshooting checklist on page 99

● LED color definitions on page 100

● HP Insight Diagnostics Offline Edition on page 101

● Diagnostic error codes on page 106

● Troubleshooting scenarios and solutions on page 109

● POST error messages on page 126
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E-Support
Help and support center and E-Support

Help and Support Center (HSC) provides online access to technical support information, software
updates and downloads, diagnostic tools, and HP support contact information.

To open HSC from your desktop, click Start>Help and Support.

HSC contains four sections:

● HP Product Information (requires Internet access)—Links to the HP Technical Support website for
your product. You can access all related documentation, downloads and updates, tools, and more.

● HP Software and Driver Downloads (requires Internet access)—Links to HP specific software
downloads and updates.

● HP Support Tools (requires Internet access)—Links to self-help tools and diagnostics offered by
HP Instant Support Professional Edition.

● Contact HP for Support—Provides two different options:

● Chat with an expert online (requires Internet access)—Provides a tool to communicate with
a support specialist online through Active Chat.

● Call a support agent—Provides hardware details about the workstation and HP support
contact phone number worldwide.
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Troubleshooting checklist
Before running any of the diagnostic utilities, use the following checklist to find possible solutions for
workstation or software problems.

● Are the workstation and monitor connected to a working electrical outlet?

● Is the workstation powered on?

● Is the green power light illuminated?

● Is the monitor powered on?

● Is the green monitor light illuminated?

● Adjust the monitor brightness and contrast controls if the monitor is dim.

● Press and hold any key. If the system beeps, then the keyboard is operating correctly.

● Examine all cables for loose or incorrect connections.

● Reconfigure the workstation after installing a non-PNP (positive-negative-positive) expansion
board or other option, such as a diskette drive.

● Are all of the necessary device drivers installed?

● Have all printer drivers been installed for each application?

● Remove all diskettes and CDs from the drives before you power on the system.

● Are you running the latest BIOS version, drivers, and/or software updates?
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LED color definitions 
The front panel LED indicates system status as described in Table 1.

Table 5-1  Front panel LED color definitions

LED State LED Color System Status

Solid Green System is on.

Blinking Green System is in Standby mode.

Solid or blinking Red System has an error. See  Diagnostic light codes
on page 106.

None No light System is in Hibernate mode, or it is off.

100 Chapter 5   System diagnostics and troubleshooting ENWW



HP Insight Diagnostics Offline Edition
The HP Insight Diagnostics utility enables you to perform testing and to view critical computer hardware
and software configuration information from various sources. This utility enables you to:

● Run diagnostics.

● View the hardware configuration of the system.

Key features and benefits
HP Insight Diagnostics simplifies the process of effectively identifying, diagnosing, and isolating the
hardware issues.

In addition to robust management tools, service tools can be invaluable in quickly resolving system
problems. To streamline the service process and resolve problems quickly, you must have the right
information available at the time you place a service call. The primary information requirement, which
is also the one that provides the greatest insight into potential system issues, is the configuration of the
system. Insight Diagnostics helps provide higher system availability. Typical uses of the Insight
Diagnostics are:

● Testing and diagnosing apparent hardware failures

● Documenting system configurations for upgrade planning, standardization, inventory tracking,
disaster recovery, and maintenance

● Sending configuration information to another location for more in-depth analysis

Theory of operation
HP Insight Diagnostics Offline Edition operates in offline mode only. Here, the operating system is not
running, and software information from the system is not available to the diagnostics.

Offline Survey is available to display the current system configuration.

The Insight Diagnostics Test feature enables you to test functionality of all the major hardware
components in the system. The Test feature is designed to be flexible to enable you to customize test
selections by providing different modes and types of testing. It includes Quick, Complete, and Custom
testing levels to give you control over testing depth and required user interaction.

Starting the diagnostic utility from CD
HP Insight Diagnostics is available on the Documentation & Diagnostic  CD that was shipped with your
workstation.

To start the diagnostic utility on the Documentation & Diagnostic  CD:

1. Power on your workstation, and press the F10 key during the initial boot process to enter the
Computer Setup (F10) Utility (Using Computer Setup (F10) Utility on page 25).

2. Select your language from the list, and press the Enter key. In the Computer Setup Utilities menu,
four headings are displayed: File, Storage, Security, and Advanced. Other headings might be
displayed, depending on the workstation.

3. Use the right arrow key to select Storage.

4. Use the down arrow key to select Boot Order, and press Enter.
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5. Select CD-ROM Drive , and enable it as a bootable device by pressing the F5 key (if not already
enabled, pressing the F5 key again disables the device). The default setting is enabled.

6. Set the CD-ROM Drive to the top of the boot order. Select CD-ROM, press the Enter key, and use
the up arrow to move it to the top of the boot order.

7. To apply and save changes, press the F10 key, and select File>Save Changes and Exit.

8. Insert the Documentation & Diagnostic CD into the workstation.

9. Restart your system, HP Insight Diagnostics launches automatically.

Download the ISO image

1. Browse to http://www.hp.com.

2. Click Software & Driver Downloads.

3. Enter your product number (for example, xw8400) in the text box, and press the Enter key.

4. Select your operating system.

5. Click the Diagnostic link.

6. Locate HP Insight Diagnostics Offline on the display, and click Download.

User interface

Navigation
The Insight Diagnostics home page contains the following tabs: Survey, Test, Status, Log, and
Help. These tabs separate the major functions of Insight Diagnostics.

Survey tab
When you click the Survey tab, the Survey menu displays and enables you to view important system
configuration information. The Summary view limits the amount of data displayed, while the
Advanced view shows all the data in the selected category. Regardless of whether you choose
Advanced or Summary, the following categories of information are available on the Survey menu:

Overview—Lists general information about the computer.

All—Lists all information about the computer.

Architecture—Shows the type of bus the computer uses, and BIOS information. In addition, if the bus
is PCI, information about the PCI configuration is displayed.

Asset Control—Shows the serial number of the computer, and provides processor information.

Communication—Shows information about the computer parallel (LPT) and serial (COM) port settings,
USB, and network controller information.

Graphics—Shows information about the graphics subsystem of the computer.

Input Devices—Shows information about the type of keyboard and mouse.

Memory—Shows information about all memory in the computer, including memory on the board and
any memory modules installed.

102 Chapter 5   System diagnostics and troubleshooting ENWW

http://www.hp.com


Miscellaneous—Shows information obtained from the computers configuration memory (CMOS), BIOS
data area, Interrupt Vector table, and diagnostics component information.

Storage—Shows information about storage media connected to the computer, including all fixed disks,
floppy drives, and CD-ROM drives.

System—Shows product type, processor type and speed, and coprocessor information, and information
about all ROMs in the computer.

Test tab
The Insight Diagnostics utility enables you to test all the major pieces of hardware in the system. You
can select from several types of tests:

Quick Test—Provides a predetermined script in which a sample of most hardware components is
exercised and requires no user intervention.

Complete Test—Provides a predetermined script in which most hardware components are fully tested.
You can select Interactive or Unattended tests, which will change the devices tested during the Complete
Test. More tests are available in Interactive mode, but these require user intervention.

Custom Test—Provides the most flexibility in controlling the testing of a system. The Custom Test mode
enables you to select which devices, tests, and test parameters are run. You can select tests that do
not require any user interaction through the Interactive or Unattended test modes. More tests are
available in Interactive mode, but these require user intervention.

To begin testing:

1. Click the Test tab.

2. Select Type of Test to perform, and select Interactive or Unattended as the test mode.

3. Determine how you want the test to be executed.

● Select Number of Loops and enter the number of loops to perform.

● Select Total Test Times and enter the amount of time in minutes that you want the diagnostic
test to run.

4. When choosing to run the test over a specified number of loops, enter the number of loops to
perform. If you desire to have the diagnostic test for a specified time period, enter the amount of
time in minutes.

5. Click  Begin Testing in the lower right corner of the display to start the test.

While tests are being performed, you can monitor the progress by clicking the Status tab. Any errors
that are detected are summarized in the Error Log. Click Save to save the report to a floppy disk or a
USB key drive if attached.

If the diagnostics utility detects an error during a test, you can mouse-over the failed text in the Status
tab to display additional information for the type of error and the error code.

To view all test failure information, select Error Log. To view the status of all testing that has been
performed, click the Log tab.
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Status tab
The Status tab displays the status of the selected tests. The type of test executed (for example,
Quick, Complete, Custom) is displayed. The main progress bar displays the percent complete of the
current set of tests. While testing is in progress, a Cancel Testing button is activated. Clicking Cancel
Testing cancels the test job.

After testing has completed the Cancel Testing button is replaced with two buttons, Select New
Tests and Retest. Clicking the Select New Tests button enables you to go back to the previous test
selection page to select a new set of tests. Clicking the Retest button runs the last set of tests executed
without having to go back to the test selection page.

The Status page also shows the:

● Devices being tested

● Tests that are running

● Overall test time

● Individual test times

● Condition status of each test

Log tab
The Log tab consists of two views:

Test Log—Displays all tests that have been executed, the number of times the test executed, the
number of times the test failed, and the time it took to complete the test. Clicking the Clear Test Log
button clears the contents of the Test Log.

Error Log—Displays the tests that have failed during the diagnostic testing. Besides displaying the
device and test, this section might also include error details. The description section describes the error
that the diagnostic test found. Clicking the Recommended Repair button gives a recommended action
that should be performed to resolve the failed hardware. Te error count is the number of times the test
has failed. Clicking the Clear Error Log button clears the contents of the Error Log.

Help tab
The Help tab has three views:

● HP Insight Diagnostics—Provides introductory and detailed information about Insight Field
Diagnostics.

● Error Codes—Provides error code listings. It includes device tested, message, and recommended
repair information.

● Test Components—Reloads and refreshes all components and display component details after
the refresh.
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The Help tab provides information option selections:

● Reload—Located in the upper-right corner of the display, this selection reloads all hardware
components.

● About—Provides revision details of Insight Diagnostics.

● Exit—Located in the lower-left corner of the display, this selection provides the option to exit
diagnostics.
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Diagnostic error codes
This sections provides an overview of the diagnostic lights and error codes that are related to your
workstation.

Diagnostic light codes

NOTE The beeps are heard through the onboard piezo speaker and not the chassis speaker.
The blinking LEDs and beeps repeat for five cycles. After that, only the blinking LEDs repeat.

Table 5-2  Diagnostic LED codes

Chassis Indicator LEDs 

Power LED and Sound
Activity

Diagnosis and Service Action

None System does not power on. Press power button. If HDD LED = GREEN, then:

1. Remove expansion cards one at a time.

2. Replace the system board.

OR

Press power button. If HDD LED does not illuminate, then:

1. Verify that the unit is plugged into a working AC outlet.

2. Open access panel, and verify that the power button harness is properly connected to the
inline front panel I/O device assembly connector.

3. Verify that the power supply cables are properly connected to the system board.

4. Verify the power supply functionality.

a. Disconnect AC power.

b. Remove all internal power supply cables from the system board.

c. Plug in AC power.

● If the power supply fan spins and the BIST* LED lights, then the power supply is
good. Replace the system board.

● If the power supply fan does not spin or the BIST* LED does not light, replace the
power supply.

Blinks red 2 times, once per
second, then 2 second pause, 2
beeps

Thermal shutdown.

1. Ensure that the workstation air vents are not blocked and the cooling fan is running.

2. Open the access panel, press power button, and see if the processor fan spins. If the
processor fan is not spinning, make sure the fan's cable is plugged onto the system board
header. Ensure the fan is fully/properly seated or installed.

3. If fan is plugged in and seated properly, but is not spinning, the problem may be in the
processor fan. Contact HP for assistance

4. Verify that the fan assembly is properly attached. If problems persist, there may be a
problem with the processor heatsink. Contact HP for assistance.
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Chassis Indicator LEDs 

Power LED and Sound
Activity

Diagnosis and Service Action

Blinks red 3 times, once per
second, then 2-second pause, 3
beeps

CPU not installed.

1. Check to see that the processor is present.

2. Reseat the processor.

Blinks red 4 times, once per
second, then 2 second pause, 4
beeps

Power supply failure.

1. Open the access panel and ensure the following connections are secure on the system
board:

● 24–pin main power (all systems)

● 4–pin CPU (xw4000 series)

● 8–pin CPU (xw6000/xw8000/xw9000 series)

● 4–pin memory (xw8000/xw9000 series)

2. Locate faulty device by removing all devices and then reinstalling one at a time until
workstation fails. Replace the device causing the failure. Continue adding devices to
ensure all are functioning properly.

3. Verify power supply functionality.

a. Disconnect AC power.

b. Remove all internal power supply cables from the system board.

c. Plug in AC power.

● If the power supply fan spins and the BIST* LED lights, then the power supply
is good. Replace the system board.

● If the power supply fan does not spin or the BIST* LED does not light, replace
the power supply.

Blinks red 5 times, once per
second, then 2 second pause,
5 beeps

Pre-video memory error.

1. Reseat DIMMs

2. Replace DIMMs one at a time to isolate faulty module

3. Replace third-party memory with HP memory.

4. Replace system board.

Blinks red 6 times, once per
second, then 2 second pause,
6 beeps

Pre-video graphics card error.

For systems with integrated graphics, replace the system board.

For systems with graphics cards, perform the following steps.

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

Table 5-2  Diagnostic LED codes (continued)
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Chassis Indicator LEDs 

Power LED and Sound
Activity

Diagnosis and Service Action

Blinks red 7 times, once per
second, then 2 second pause,
7 beeps.

System board failure (ROM detected failure before video).

1. Clear CMOS.

2. Replace system board.

Blinks red 8 times, once per
second, then 2 second pause,
8 beeps

Invalid ROM based on bad checksum.

1. Clear CMOS.

2. Upgrade the ROM using a ROMPaq diskette, CD, diskette, or USB removable device
(e.g., HP Drive Key). See the ROM Flash section of the Service and Technical Reference
Guide at http://www.hp.com/support/workstation_manuals.

3. Replace system board.

Blinks red 9 times, once per
second, then 2 second pause, 9
beeps

System powers on but is unable to boot.

1. Replace the system board.

2. Replace the processor.

* Refer to the Service and Technical Reference Guide for your workstation for BIST information.

Table 5-2  Diagnostic LED codes (continued)
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Troubleshooting scenarios and solutions
This section presents an extensive overview of various troubleshooting scenarios and includes possible
solutions for each.

Solving minor problems 
Table 5-3  Minor problems

Problem Cause Possible Solution

Workstation appears locked
up and will not turn off when
the power button is pressed.

Software control of the power
switch is not functional.

1. Press and hold the power button for at least four
seconds until the workstation turns off.

2. Disconnect electrical plug from outlet.

Workstation seems to be
locked up.

Program in use has stopped
responding to commands.

1. Attempt the normal Windows shut down procedure.

2. Restart the workstation using the power button.

Workstation date and time
display is incorrect.

Real-time clock (RTC) battery
might need to be replaced.

1. Reset the date and time under Control Panel.

2. Replace the RTC battery.

Workstation appears to pause
periodically.

Network driver is loaded and no
network connection is
established.

Establish a network connection, or use Computer Setup or
Microsoft Windows Device Manager to disable the network
controller.

Cursor will not move using the
arrow keys on the keypad.

The Num Lock key might be on. Press Num Lock. The Num Lock key can be disabled (or
enabled) in Computer Setup.

Poor performance is
experienced.

Processor is hot. 1. Be sure airflow to the workstation is not blocked.

2. Be sure the fans are connected and working properly
(some fans only operate when needed).

3. Be sure the CPU heatsink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on
the hard drive.

Workstation powered off
automatically and the Power
LED flashes Red two times,
once every second, followed
by a two-second pause, and
two simultaneous beeps are
heard.

Processor thermal protection
activated:

A fan might be blocked or not
turning.

OR

The CPU heatsink is not properly
attached to the processor.

1. Be sure workstation air vents are not blocked and the
cooling fan is running.

2. Open the hood, press the power button, and determine
if the processor fan spins. If not spinning, be sure the
fan’s cable is plugged into the system board header. Be
sure the fan is fully/properly seated or installed.

3. Replace the processor fan.

4. Reseat CPU heatsink and verify that the fan assembly
is properly attached.

System does not power on and
the LEDs on the front of the
workstation are not flashing.

System unable to power on. Press and hold the power button for less than four seconds.
If the hard drive LED turns green, then:

1. Remove the expansion cards.

2. Replace the system board.

OR

Press and hold the power button for less than four seconds.
If the HDD LED does not illuminate, then:
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Problem Cause Possible Solution

1. Verify that the unit is plugged into a working AC outlet.

2. Open the access panel, and verify that the power
button harness is properly connected to the inline front
panel I/O device assembly connector.

3. Verify that the power supply cables are properly
connected to the system board.

4. Verify power supply functionality:

a. Disconnect AC power.

b. Remove all internal power supply cables from the
system board.

c. Plug in AC power.

● If the power supply fan spins and the BIST*
LED lights, then the power supply is good.
Replace the system board.

● If the power supply fan does not spin or the
BIST* LED does not light, replace the power
supply.

Solving power supply problems

Testing power supply
Before replacing the power supply, use the BIST feature to determine if the power supply still works.

To test the power supply:

1. Disconnect all internal power supply cables.

2. Plug in AC power.

a. If the green BIST LED on the rear of the workstation is lit and the fan is spinning, the power
supply is functional.

b. If the green BIST LED is not lit or the fan is not spinning, replace the power supply.

Table 5-3  Minor problems (continued)
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Figure 5-1  Power supply

Table 5-4  Power supply problems

Problem Cause Solution

Power supply shuts down
intermittently.

Power supply fault. Replace the power supply.
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Problem Cause Solution

Workstation powered off
automatically and the Power LED
flashes red two times, once every
second, followed by a two-second
pause.

Processor thermal protection
activated.

A fan might be blocked or not
turning.

OR

The CPU heatsink fan
assembly is not properly
attached to the processor.

1. Be sure that the workstation air vents are not blocked
and the cooling fan is running.

2. Open the access panel, press the power button, and
determine if the processor fan spins. If the processor
fan is not spinning, be sure the fan’s cable is plugged
into the system board header. Be sure the fan is
properly seated or installed.

3. Replace the processor fan.

4. Reseat the CPU heatsink, and verify that the fan
assembly is properly attached.

Power LED flashes red, once every
two seconds.

Power failure (power supply is
overloaded).

1. Determine whether a device is causing the problem
by removing all attached devices). Power on the
system. If the system enters the POST, then power
off and replace one device at a time and repeat this
procedure until failure occurs. Replace the device
causing the failure. Continue adding devices one at a
time to ensure all devices are functioning properly.

2. Verify power supply functionality.

a. Disconnect AC power.

b. Remove all internal power supply cables from
the system board.

c. Plug in AC power.

● If the power supply fan spins and the BIST
LED lights, then the power supply is good.
Replace the system board.

● If the power supply fan does not spin or the
BIST LED does not light, replace the power
supply.

Solving diskette problems  
Table 5-5  Diskette problems

Problem Cause Solution

Diskette drive light stays on. Diskette is damaged. Right-click Start, click Explore, and select a drive.
Select File>Properties>Tools. Under Error-checking,
click Check Now.

Diskette is incorrectly inserted. Remove diskette and reinsert.

Files on diskette are damaged. Check the program diskettes.

Drive cable is not properly
connected.

Reconnect power cable. Be sure that all four pins are
connected.

Drive not found. Cable is loose. Reseat diskette drive data and power cables.

Removable drive is not seated
properly.

Reseat the drive.

Table 5-4  Power supply problems (continued)
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Problem Cause Solution

Diskette drive cannot write to a
diskette.

Diskette is not formatted. Format the diskette.

Diskette is write-protected. Use another diskette or remove the write protection.

Writing to the wrong drive. Check the drive letter in the path statement.

Not enough space is left on the
diskette.

Use another diskette.

Diskette write control is
enabled.

Use Computer Setup to check the storage security
feature disabled settings.

Diskette is damaged. Replace the damaged disk.

Cannot format diskette. Invalid media reported. When formatting a disk in MS-DOS, you might need to
specify diskette capacity. For example, to format a 1.44-
MB diskette, enter the following command at the MS-
DOS prompt:

FORMAT A: /F:1440

A problem has occurred with a disk
transaction.

The directory structure is bad,
or there is a problem with a file.

Right-click Start, click Explore, and select a drive.
Select File>Properties>Tools. Under Error-checking,
click Check Now.

Diskette drive cannot read
a diskette.

Diskette is not formatted. Format the diskette.

You are using the wrong
diskette type for the drive type.

Be sure you use the correct diskette type for the type of
drive you are using.

You are reading the wrong
drive.

Check the drive letter in the path statement.

Diskette is damaged. Replace the diskette with a new one.

“Invalid system disk” message is
displayed.

A diskette that does not contain
the system files needed to start
the workstation has been
inserted in the drive.

When drive activity stops, remove the diskette and press
the spacebar. The workstation should start up.

Diskette error has occurred. Restart the workstation by pressing the power button.

Cannot Boot to Diskette. Diskette is not bootable. Replace with a bootable diskette.

Diskette boot has been
disabled in Computer Setup.

Run Computer Setup and enable diskette boot in
Storage>Boot Order.

Removable media boot has
been disabled in Computer
Setup.

Run Computer Setup and enable Removable Media
Boot in Storage>Storage Options.

Diskette Master Boot Record
(MBR) validation is enabled.

Run Computer Setup, and disable diskette MBR
validation in Storage>Storage Options.

   

Table 5-5  Diskette problems (continued)
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Solving hard drive problems
Table 5-6  Hard drive problems  

Problem Cause Solution

Hard drive error occurs. Hard disk has bad sectors or
has failed.

Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem. Either the directory structure is
bad or there is a problem with
a file.

Right-click Start, selectExplore, and select a drive.
Select File>Properties>Tools. Under Error-checking,
click Check Now.

Drive not found (identified). Loose cable. Check cable connections.

The system might not have
automatically recognized a
newly installed device.

1. Run Computer Setup.

2. If the system still does not recognize the new device,
determine if the device is listed within Computer
Setup. If it is listed, the probable cause is a driver
problem. If it is not listed, the probable cause is a
hardware problem.

3. If this is a newly installed drive, enter Setup and try
adding a POST delay under Advanced>Power-On.

Drive responds slowly
immediately after power on.

Run Computer Setup, and increase the POST Delay in
Advanced>Power-On Options.

Non-system disk/NTLDR missing
message.

System is trying to start from a
non-bootable diskette.

Remove the diskette from the diskette drive.

Non-system disk/NTLDR missing
message.

System is trying to start from a
damaged hard drive.

1. Insert a bootable diskette into the diskette drive and
restart the workstation.

2. If the hard drive is still inaccessible and MBR
Security is enabled, try restoring the previously
saved MBR image by entering Setup and selecting
Security>Restore Master Boot Record.

System files missing or not
properly installed.

1. Insert a bootable system diskette and restart.

2. Verify that the hard drive is partitioned and formatted.

3. Install system files for the appropriate operating
system if necessary.

Hard drive boot disabled in
Computer Setup.

Run Computer Setup, and enable the hard drive entry in
the Storage—>Boot Order list.

Both slow and fast UATA
devices are on the same data
cable.

Connect slower UATA devices to a separate data cable
connected to the secondary IDE (ATA) controller.

Workstation will not start. Hard drive is damaged. Observe the beeps and LED lights on the front of the
workstation. See  POST error messages on page 126.
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Solving display problems 
Table 5-7  Display problems

Problem Cause Solution

Blank screen (no video). The cable connections are not
correct.

Check the cable connections from the monitor to the
workstation and to a working electrical outlet.

The monitor is off. Switch the monitor to on (LED is on). You might need to
refer to the monitor manual for an explanation of the LED
signals.

Screen blanking utility installed
or energy saver features
enabled.

Press any key or click the mouse button and, if set, enter
your password.

System ROM is bad; system is
running in FailSafe Boot Block
mode (indicated by eight
beeps).

Reflash the ROM using a ROMPaq diskette.

Fixed-sync monitor will not
sync at the resolution chosen.

Be sure that the monitor can accept the same horizontal
scan rate as the resolution chosen.

Computer is in mode. Press the power button to resume from mode.

Monitor settings in the
workstation are not compatible
with the monitor.

1. Restart the workstation and press F8 during startup
when you see Press F8 in the bottom-right corner of
the screen.

2. Using the keyboard arrow keys, select Enable VGA
Mode and press Enter.

3. In Windows Control Panel, double-click the Display
icon and click the Settings tab.

4. Use the sliding control to reset the resolution.

The display works properly during
the POST but goes blank when the
OS starts.

The display settings in the
operating system are
incompatible with your
graphics card and monitor.

1. Restart your workstation in VGA mode.

2. After the operating system starts, change the display
settings to match those supported by your graphics
card and monitor.

3. Refer to your operating system and graphics card
documentation for information on changing display
settings.

Power LED flashes Red six times,
once every second, followed by a
two second pause, and the
workstation beeps six times.

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

Monitor does not function properly
when used with energy saver
features.

Monitor without energy saver
capabilities is being used with
energy saver features
enabled.

Disable monitor energy saver feature.

Dim character s. The brightness and contrast
controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly
connected.

Verify that the graphics cable is securely connected to the
graphics card and the monitor.
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Problem Cause Solution

Blurry video or requested
resolution cannot be set.

If the graphics controller was
upgraded, the correct video
drivers might not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of
displaying requested
resolution.

Change requested resolution.

The picture is broken up, rolls,
jitters, or flashes.

The monitor connections might
be incomplete or the monitor
might be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
workstation.

2. In a two-monitor system or if another monitor is in
close proximity, be sure the monitors are not
interfering with each other’s electromagnetic field by
moving them apart.

3. Be sure that fluorescent lights or fans are not too close
to the monitor.

Monitor needs to be
degaussed.

Degauss the monitor.

Vibrating or rattling noise coming
from inside a CRT monitor when
powered on.

Monitor degaussing coil has
been activated.

None. It is normal for the degaussing coil to be activated
when the monitor is powered on.

Clicking noise coming from inside a
CRT monitor.

Electronic relays have been
activated inside the monitor.

None. It is normal for some monitors to make a clicking
noise when turned on and off, when going in and out of
Standby mode, and when changing resolutions.

High pitched noise coming from
inside a flat panel monitor.

Brightness and contrast
settings are too high.

Lower brightness and contrast settings.

Fuzzy focus; streaking, ghosting,
or shadowing effects; horizontal
scrolling lines; faint vertical bars; or
unable to center the picture on the
screen. (Flat panel monitors using
an analog VGA input connection
only.)

Flat panel monitor’s internal
digital conversion circuits
might be unable to correctly
interpret the output
synchronization of the
graphics card.

1. Select the monitor’s Auto-Adjustment option in the
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions. Download SoftPaq
SP20930 or SP22333, depending on the monitor, to
assist with the synchronization.

Certain typed symbols do not
appear correct.

The font you are using does
not support that particular
symbol.

Use the Character Map to locate the and select the
appropriate symbol. Click Start>All Programs>
Accessories>System Tools>Character Map. You can
copy the symbol from the Character Map into a document.

Solving audio problems 
Table 5-8  Audio problems

Problem Cause Solution

Sound does not come out of the
speaker or headphones.

Software volume control is
turned down.

Double-click the Speaker icon on the taskbar and use the
volume slider to adjust the volume.

The external speakers are not
turned on.

Turn on the external speakers.

External speakers are plugged
into the wrong audio jack.

See the sound card documentation for proper speaker
connection.

Table 5-7  Display problems (continued)
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Problem Cause Solution

Audio cable not connected. Connect audio cable between CD or DVD-ROM drive and
the system board.

Digital CD audio is
not enabled.

Enable digital CD audio:

1. From the Control Panel, select System.

2. On the Hardware tab, click Device Manager.

3. Right-click the CD/DVD device and select
Properties.

4. On the Properties tab, be sure Enable digital CD
audio for this CD-ROM device is selected.

Headphones or devices
connected to the line-out
connector mute the internal
speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external
speakers.

Volume is muted. 1. From the Control Panel program, click Sound,
Speech and Audio Devices, and then click Sounds
and Audio Devices.

2. Clear the Mute check box.

Computer is in mode. Press the power button to resume from mode.

Noise or no sound comes out of the
speakers or headphones.

1. If using digital speakers that have a stereo jack and
want the system to auto-switch to digital, use a stereo-
to-mono adapter to properly engage the auto-sense
feature or use the multimedia device properties
to manually switch the audio signal from analog to
digital.

2. If the headphones have a mono jack, use the
multimedia device properties to switch the system to
analog out.

NOTE If you set digital as the Output Mode, the internal speaker and external analog speakers will no longer output
audio until you switch back to an auto-sense or analog mode.

If you set analog as the Output Mode, external digital speakers will not function until you change the output mode back
to an auto-sense or digital mode.

Sound cuts in and out. Processor resources are being
used by other open
applications.

Shut down all open processor-intensive applications.

Workstation appears to be locked
up while recording audio.

The hard disk might be full. 1. Before recording, be sure there is enough free space
on the hard disk.

2. Try recording the audio file in a compressed format.

Table 5-8  Audio problems (continued)
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Solving printer problems
Table 5-9  Printer problems

Problem Cause Solution

Printer does not print. Printer is not turned on and
online.

Turn the printer on and be sure it is online.

The correct printer driver for
the application are not
installed.

1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\> [printer port]

where [printer port] is the address of the printer
being used. If the printer works, reload the printer
driver.

If you are on a network, you
might not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer might have failed. Run printer self-test.

Printer does not turn on. The cables might not be
connected properly.

Reconnect all cables.

Printer prints garbled information. The correct printer driver is not
installed.

Install the correct printer driver for the application.

The cables might not be
connected properly.

Reconnect all cables.

Printer memory might be
overloaded.

Reset the printer by turning it off for one minute, then turn
it back on.

Printer is offline. The printer might be out of
paper.

1. Check the paper tray and refill it if it is empty.

2. Select online.

Solving keyboard and mouse problems
Table 5-10  Keyboard and mouse problems  

Problem Cause Solution

Keyboard commands and typing
are not recognized by the
workstation.

Keyboard connector is not
properly connected.

1. Power off the workstation.

2. Reconnect the keyboard to the back of the
workstation and restart the workstation.

Program in use has stopped
responding to commands.

Shut down the workstation using the mouse and then
restart the workstation.

Keyboard needs repairs. Replace the keyboard.

Keyboard key is stuck down. Remove any debris from the keyboard.

Workstation is in mode. Press the power button to resume from mode.

Cursor will not move using the
arrow keys on the keypad.

The Num Lock key might be
on.

Press the Num Lock key. The Num Lock light should not
be on if you want to use the arrow keys. The Num Lock key
can be disabled (or enabled) in Computer Setup.
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Problem Cause Solution

Mouse does not respond to
movement or is too slow.

Mouse connector is
not properly plugged into the
back of the workstation.

1. Shut down the workstation using the keyboard.

2. Plug the mouse connector into the PS/2 mouse
connector slot in the workstation and restart the
workstation.

Program in use has stopped
responding to commands.

Shut down the workstation using the keyboard and then
restart the workstation.

Mouse needs repairs. Replace the mouse.

Workstation is Stand By mode. Press the power button to resume from Stand By mode.

Mouse will only move vertically or
horizontally, or movement is jerky.

Mouse roller ball is dirty. Remove roller ball cover from the bottom of the mouse and
clean it.

Solving front panel component problems
If you are experiencing problems with one of the front panel ports, you might be able to try your device
in the corresponding port on the back side of the computer. If this does not fix the problem, or you must
use the front panel ports, continue troubleshooting.

Some problems in this section are also discussed in other troubleshooting suggestions in this chapter.

Table 5-11  Front panel component problems  

Problem Cause Solution

If a USB device, headphone, or
microphone is not recognized by
the workstation.

It is not properly connected. 1. Power off the workstation.

2. Reconnect the device to the front of the workstation
and restart the workstation.

The device does not have
power.

If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not
installed.

1. Install the correct driver for the device.

2. You might need to reboot the workstation.

The cable from the device to
the computer does not work.

1. If possible, replace the cable.

2. Restart the workstation.

The device is not working. 1. Replace the device.

2. Restart the workstation.

If a USB, audio, and IEEE-1394
devices are not working.

The internal cables might not
be connected to the system
board or the PCI card.

1. Power off the workstation.

2. Connect the cables correctly.

A device in the IEEE-1394a port is
not responsive.

Cables of new external device
are loose or power cables are
unplugged.

Be sure that all cables are properly and securely
connected.
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Problem Cause Solution

The power switch on the
device is not turned on.

Power off the workstation, and power on the external
device, then turn on the workstation to integrate the device
with the workstation system.

The IEEE-1394 port is not active. The port is not there because it
was not purchased with the
system.

You can buy an IEEE 1394 PCI adapter card. Contact an
HP seller.

Solving hardware  installation problems
You might need to reconfigure the workstation when you add or remove hardware, such as an additional
diskette drive. If you install a PNP (positive-negative-positive) device, Windows XP automatically
recognize the device and configure the workstation. If you install a non-PNP device, you must
reconfigure the workstation after completing installation of the new hardware.

Table 5-12  Hardware installation problems

Problem Cause Solution

A new device is not recognized as
part of the system.

Device is not seated or
connected properly.

Be sure that the device is properly and securely connected
and that pins in the connector are not bent.

Cables of new external device
are loose or power cables are
unplugged.

Be sure that all cables are properly and securely connected
and that pins in the cable or connector are not bent.

Power switch of new external
device is not turned on.

Power off the workstation, power on the external device,
and power on the workstation to integrate the device
with the workstation system.

When the system advised you
of changes to the
configuration, you did not
accept them.

Reboot the workstation, and follow the instructions for
accepting the changes.

A PNP board might not
automatically configure when
added if the default
configuration conflicts with
other devices.

Use the Device Manager to clear the automatic settings for
the board and select a basic configuration that does not
cause a resource conflict. You can also use Computer
Setup to reconfigure or disable devices to resolve the
resource conflict.

Device hardware is not
properly jumpered or
otherwise configured.

Read the device-specific configuration information and
check for incorrect settings or conflicts with other devices
already installed in the system.

Workstation will not start. Wrong memory modules were
used in the upgrade or memory
modules were installed in the
wrong location.

1. Review the documentation that came with the system
to determine if you are using the correct memory
modules and to verify the proper installation.

2. Observe the beeps and LED lights on the front of the
workstation. Refer to  POST error messages
on page 126 to determine possible causes.

PCI Express power cable
might be plugged into the
wrong connector on the
system board.

Connect the auxiliary PCI Express power cable to the PCI
Express card.
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Problem Cause Solution

Power LED flashes Red five times,
once every second, followed by a
two second pause, and the
workstation beeps five times.

Memory is installed incorrectly
or is bad.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Power LED flashes Red six times,
once every second, followed by a
two second pause, and the
workstation beeps six times.

Video card is not seated
properly or is bad, or system
board is bad.

For systems with a graphics card:

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

Solving network problems 
These guidelines do not discuss the process of debugging the network cabling.

Table 5-13  Network problems

Problem Cause Solution

Wake-on-LAN feature  is not
functioning.

Wake-on-LAN is not enabled. Use the Network control application to enable Wake-on-
LAN.

Network driver does not detect
network controller.

Network controller is disabled. Run Computer Setup and enable network controller.

Incorrect network driver. Check the network controller documentation for the
correct driver, or obtain the latest driver from the
manufacturer’s website.

Network status link light does not
turn on or it never flashes.

The network status light should
flash when there is network
activity.

No active network is detected. Check cabling and network equipment for proper
connection.

Network controller is not set up
properly.

Use the network control application to verify that the
device is working properly.

Network driver is not properly
loaded.

Reinstall network drivers.

System cannot auto-sense the
network.

Disable auto-sensing capabilities and force the system
into the correct operating mode.

Diagnostics reports a failure. The cable is not securely
connected.

Be sure that both ends of the data cable are securely
connected.

The cable is attached to the
incorrect connector.

Be sure that the cable is attached to the correct connector.

There is a problem with the cable
or a device at the other end of the
cable.

Be sure that the cable and device at the other end are
operating correctly.

Network controller interrupt is
shared with an expansion board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.
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Problem Cause Solution

The network controller
is defective.

Replace the NIC.

Diagnostics passes, but the
workstation does not
communicate with the network.

Network drivers are not loaded, or
driver parameters do not match
current configuration.

1. Be sure the network drivers are loaded and that the
driver parameters match the configuration of the
network controller.

2. Be sure the correct network client and protocol is
installed.

The network controller is not
configured for this workstation.

Select the Network icon in the Control Panel and
configure the network controller.

Network controller stopped
working when an expansion
board was added to the
workstation.

Network controller interrupt is
shared with an expansion board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires
drivers.

Verify that the drivers were not accidentally deleted when
the drivers for a new expansion board were installed.

The expansion board installed is a
Network Interface Card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

Network controller stops working
without apparent cause.

The files containing the network
drivers are corrupted.

Reinstall the network drivers, using the Restore Plus! CD.

The cable is not securely
connected.

Be sure that both ends of the cable are securely attached
to the correct devices.

The network controller is
defective.

Replace the NIC.

New network card will not boot. New network card might be
defective or might not meet
industry-standard specifications.

Install a working, industry-standard NIC, or change the
boot sequence to boot from another source.

Cannot connect to network
server when attempting Remote
System Installation.

The network controller is not
configured properly.

Verify Network Connectivity, that a DHCP Server is
present, and that the Remote System Installation Server
contains the NIC drivers for your NIC.

System setup utility reports
unprogrammed EEPROM.

Unprogrammed EEPROM. Flash the ROM.

Solving memory problems  

CAUTION For those systems that support ECC memory, HP does not support mixing ECC and
non-ECC memory. Otherwise, the system will not boot the operating system.

Table 5-14  Memory problems

Problem Cause Solution

System will not boot or does not
function properly after installing
additional memory modules.

Memory module is not the
correct type or speed, or the
new memory module is not
seated properly.

Replace module with the correct industry-standard device
for the workstation.

On some models, ECC and non-ECC memory modules
cannot be mixed.

Table 5-13  Network problems (continued)
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Problem Cause Solution

Out of memory error. Memory configuration might
not be set up correctly.

Use the Device Manager to check memory configuration.

You have run out of memory to
run the application.

Check the application documentation to determine the
memory requirements.

Memory count during POST is
wrong.

The memory modules might
not be installed correctly.

Check that the memory modules have been installed
correctly and that proper modules are used.

Insufficient memory error during
operation.

Too many Terminate and Stay
Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory
for the application.

Check the memory requirements for the application or add
more memory to the workstation.

Power LED flashes red 5 times,
once every second, followed by a
2-second pause, and the
workstation beeps 5 times.

Memory is installed incorrectly
or is bad.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving processor problems 
Table 5-15  Processor problems

Problem Cause Solution

Poor performance is experienced. Processor is hot. 1. Be sure the airflow to the workstation is not blocked.

2. Be sure the fans are connected and working properly
(some fans only operate when needed).

3. Be sure the CPU heatsink is installed properly.

Power LED is Red and stays on. Processor is not seated
properly or not installed.

1. Check to see that the processor is present.

2. Reseat the processor.

Solving CD-ROM and DVD problems 
Table 5-16  CD-ROM and DVD  problems

Problem Cause Solution

System will not boot from CD-ROM
or DVD drive.

The CD-ROM or DVD boot is
not enabled through the
Computer Setup utility.

Run the Computer Setup utility and enable booting to
removable media and verify boot order settings.

Non-bootable CD in drive. Try a bootable CD in the drive.

CD-ROM or DVD devices are not
detected or driver is not loaded.

Drive is not connected properly
or not properly configured.

1. Reconnect power and data cables to the drive.

2. Install correct device driver.
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Problem Cause Solution

Movie will not play in the DVD drive. Movie might be regionalized
for a different country.

See the documentation that came with the DVD drive.

Decoder software is not
installed.

Install decoder software.

Cannot eject compact disc (tray-
load unit).

Disc not properly seated in the
drive.

1. Power off the workstation, and insert a thin metal rod
into the emergency eject hole and push firmly.

2. Slowly pull the tray out from the drive until the tray is
fully extended, and remove the disc.

CD-ROM, CD-RW, DVD-ROM, or
DVD-R/RW drive cannot read a
disc or takes too long to start.

CD has been inserted upside
down.

Reinsert the CD with the label facing up.

The DVD-ROM drive takes
longer to start because it has to
determine the type of media
played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive
determine the type of media being played. If the disc still
does not start, read the other solutions listed for this topic.

 CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit.

Windows does not detect the
CD-ROM or DVD-ROM drive.

1. Use Device Manager to remove or uninstall the
device in question.

2. Restart the workstation and allow Windows to detect
the device.

Recording audio CDs is difficult or
impossible.

Wrong or poor quality media
type.

1. Try using a slower recording speed.

2. Verify that you are using the correct media for the
drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.

Solving Internet access problems 
Table 5-17  Internet access problems

Problem Cause Solution

Unable to connect to the Internet. Internet Service Provider (ISP)
account is not set up properly.

Verify Internet settings or contact the ISP for assistance.

Modem is not set up properly. Reconnect the modem. Verify the connections are correct
using the quick setup documentation.

Web browser is not set up
properly.

Verify that the web browser is installed and set up to work
with your ISP.

Cable/ DSL modem is not
plugged in.

Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not
available or has been
interrupted due to bad
weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

The CAT5 10/100/1000 cable
is disconnected.

Connect the CAT5 10/100 cable between the cable modem
and the workstations’s RJ-45 connector. (If the connection
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Problem Cause Solution

is good, the “PC” LED light on the front of the cable/DSL
modem will be on.)

IP address is not configured
properly.

Contact the ISP for the correct IP address.

Cookies are corrupted. 1. Select Start>Control Panel.

2. Double-click Internet Options.

3. On the General tab, click Delete Cookies.

Cannot automatically launch
Internet programs.

You must log on to the ISP
before some programs will
start.

Log on to the ISP and launch the desired program.

Internet takes too long to download
websites.

Modem is not set up properly. Verify that the correct modem speed and COM port are
selected.

1. Select Start>Control Panel.

2. Double-click System. Click the Hardware tab.

3. In the Device Manager area, click Device Manager.

4. Double-click Ports (COM & LPT).

5. Right-click the COM port your modem uses, then
click Properties.

6. Under Device status, verify that the modem is working
properly.

7. Under Device usage, verify the modem is enabled.

8. If there are further problems, click Troubleshoot and
follow the on-screen instructions.
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POST error messages
POST is a program run at startup that initializes and runs some tests on installed hardware. An audible
and/or visual message occurs if the POST encounters a problem. POST checks the following items to
ensure that the workstation system is functioning properly:

● Keyboard

● Memory modules

● Diskette drives

● All SATA, IDE, and SAS mass storage devices

● Processors

● Controllers

NOTE If the Power-On Password is set, a key icon appears on the screen while POST is
running. You must enter the password before continuing.

Table 5-18  POST error messages  

Screen Message Probable Cause Recommended Action

101–Option ROM Error. System ROM checksum. Verify the correct ROM:

1. Flash the ROM if needed.

2. If an expansion card was recently added, remove
it and see if the problem remains.

3. Clear CMOS. If the message disappears, there
might be a problem with the expansion card.

4. Replace the system board.

102–System Board Failure. DMA, timers. 1. Clear CMOS.

2. Remove expansion boards.

3. Replace the system board.

103–System Board Failure. DMA, timers. 1. Clear CMOS.

2. Remove expansion boards.

3. Replace the system board.

110–Out of Memory for Option
ROMs.

Option ROM for a device was unable
to run due to memory constraints.

Move the suspected card to a different slot to see if the
error resolves. Contact HP for assistance if necessary.

162–System Options Not Set. Your system configuration has
changed since your last boot, in which
case press F1. Or, a loss of power to
the Real Time clock has occurred.

1. Run Computer Setup (F10 Setup).

2. Set the date and time under Control Panel or in
F10 Setup, depending on the operating system.

3. If the problem persists, replace the RTC battery.

163–Time and Date Not Set. Invalid time or date in configuration
memory.

RTC (real-time clock) battery might
need to be replaced.

1. Set the date and time under Control Panel or in
F10 Setup, depending on the operating system.

2. If the problem persists, replace the RTC battery.
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Screen Message Probable Cause Recommended Action

CMOS jumper might not be properly
installed.

164–Memory Size Error. The system memory size is different or
memory configuration has changed
from the last startup.

1. Pressing F1 will record the configuration.

2. If the problem persists, be sure memory modules
(if any) are installed correctly.

3. If third-party memory has been added, test using
HP memory only.

4. Verify proper memory module type.

201–Memory Error. The memory test performed during
startup failed.

1. Run Computer Setup (F10 Setup) or Windows
utilities.

2. Ensure that memory modules are installed
correctly.

3. Verify proper memory module type.

4. Remove and replace memory modules one at a
time to isolate faulty module.

5. Replace the faulty memory modules.

6. If error persists after replacing memory modules,
replace the system board.

202–Mixed 533 and 667 MHz
memory detected.

Memory modules do not match each
other.

Replace memory modules with matched sets.

207–Incompatible memory
modules detected.

Incompatible memory module(s)
detected.

1. Verify proper memory module type.

2. Try another memory socket.

3. Replace memory module if problem persists.

209–Incompatible FBD
memory modules detected.

Incompatible memory modules
detected.

1. Verify proper memory module type.

2. Try another memory socket.

3. Replace memory module if problem persists.

210–Incompatible memory
modules (AMBs) detected.

Incompatible memory module(s)
detected. Mismatched Advanced
Memory Buffer (AMB) IC.

1. Verify proper memory module type.

2. Try another memory socket.

3. Replace memory module if problem persists.

211–Memory warning
condition detected.

An unknown issue with one of the
DIMMs has been detected.

1. Verify proper memory module type.

2. Try another memory socket.

3. Replace memory module if problem persists.

212–Failed Processor. Processor has failed to initialize. 1. Reseat the processor in its socket.

2. If the processor does not respond, replace it.

213–Incompatible ECC
Memory Module in memory
Socket(s).

The memory modules in the system
are either not all ECC, or not all non-
ECC. This could also be caused
because the DIMM is missing critical
SPD information.

1. Verify that all memory modules are ECC or non-
ECC.

2. Replace memory module if problem persists.
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214–DIMM Configuration
Warning.

DIMMs not installed correctly (not
paired correctly).

Refer to Memory on page 67“Memory” for the correct
memory configurations and reseat the DIMMs
accordingly.

301–Keyboard Error. Keyboard failure. 1. Reconnect keyboard with workstation
powered off.

2. Check the connector for bent or missing pins.

3. Be sure that none of the keys are pressed.

4. Replace keyboard.

303–Keyboard Controller
Error.

I/O board keyboard controller. 1. Reconnect keyboard with workstation
powered  off.

2. Replace the system board.

304–Keyboard or System Unit
Error.

Keyboard failure. 1. Reconnect the keyboard with workstation
powered off.

2. Be sure that none of the keys are pressed.

3. Replace keyboard.

4. Replace system board.

401–Parallel Port 1 Address
Assignment Conflict.

IRQ address conflicts with another
device.

Reset the IRQ in the BIOS Setup menu.

404–Parallel Port Address
Conflict Detected.

Both external and internal ports are
assigned to parallel port X.

1. Remove any parallel expansion cards.

2. Clear CMOS.

3. Reconfigure card resources and run Computer
Setup (F10 Setup).

410–Audio Interrupt Conflict. IRQ address conflicts with another
device.

Reset the IRQ in the BIOS Setup menu.

411–Network Interface Card
Interrupt Conflict.

IRQ address conflicts with another
device.

Reset the IRQ in the BIOS Setup menu.

501–Display Adapter Failure. Graphics display controller. 1. Reseat the graphics card (if applicable).

2. Clear CMOS.

3. Verify that the monitor is attached and turned on.

510–Splash Screen image
corrupted.

Splash Screen image has errors. Install latest version of ROMPaq to restore image.

511–CPU Fan not detected. Fan is not connected or it might have
malfunctioned.

1. Reseat fan cable.

2. Reseat the fan.

3. Replace the fan.

512–Chassis fan not detected. Fan is not connected or it might have
malfunctioned.

1. Reseat chassis or rear chassis fan cable.

2. Reseat chassis, rear chassis, or front chassis fan.

3. Replace chassis, rear chassis, or front
chassis fan.
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513–Memory fan not detected. Memory fan is not connected or it
might have malfunctioned.

1. Reseat memory fan connector.

2. Replace memory fan.

601–Diskette Controller Error. Diskette controller circuitry or diskette
drive circuitry incorrect.

1. Run Computer Setup (F10 Setup).

2. Check and replace cables.

3. Clear CMOS.

4. Replace diskette drive.

5. Replace the system board.

605–Diskette Drive Type Error. Mismatch in drive type. 1. Run Computer Setup (F10 Setup).

2. Disconnect any other diskette controller devices
(tape drives).

3. Clear CMOS.

610–External Storage Device
Failure.

External tape drive not connected. Reinstall tape drive, or press F1 and allow system to
reconfigure without the drive.

611–Primary Diskette Port
Address Assignment Conflict.

Configuration error. 1. Run Computer Setup (F10 Setup).

2. Remove expansion cards.

3. Clear CMOS.

912–Computer Cover Has
Been Removed Since Last
System Start Up.

No action required.

914–Hood Lock Coil is not
Connected.

Hood lock mechanism is missing or
not connected.

1. Reconnect or replace the hood locking
mechanism.

2. Reseat or replace the hood locking mechanism
cable.

915–Fan Power from Power
Supply Not Connected.

The fan power cable is not connected,
or the power supply is bad.

1. Verify that all power supply cables are connected.

2. Replace the power supply.

916–Power Button Not
Connected.

The power button is not connected. Connect the power button.

917–Front Audio Not
Connected.

The front audio cable is not connected. Connect the front audio cable.

918–Front USB Not
Connected.

Front USB is not connected. Connect the front USB cable.

921–Device in PCI Express
Slot Failed to Initialize.

A PCI Express card was detected in
one of the slots, but failed to initialize
properly.

Reseat all PCI Express cards. If this failure occurred
after inserting a new card, there could be a problem with
that card.

922–Fatal error on slot # Fatal error occurred in the designated
slot.

Try moving card to a different slot. If the problem
persists, try replacing the card.

923–Non fatal error on slot #. A PCI or PCIe non-fatal error condition
occurred for the device in the
designated slot.

Try moving card to a different slot. If the problem
persists, try replacing the card.
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931–Northbound CRC error on
non-redundant retry

CRC error occurred. This could be due
to a faulty system board, memory, or
BIOS issue.

Try replacing or reseating DIMMs first, then system
board.

932–Alert on non-redundant
retry

Alert present on retry. Try replacing or reseating DIMMs first, then system
board.

945-FBD northbound CRC
error

Try replacing or reseating DIMMs first, then system
board.

946-Correctable patrol data
ECC error

Bad DIMM or improperly installed
DIMM

Try reseating the DIMMs and make sure that they are
inserted correctly. If the problem persists, remove or
replace the DIMMs one by one until the problem DIMM
is isolated.

949-Correctable non-mirrored
demand data ECC error

Bad DIMM or improperly installed
DIMM

Try reseating the DIMMs and make sure that they are
inserted correctly. If the problem persists, remove or
replace the DIMMs one by one until the problem DIMM
is isolated.

950-Redundant retry FBD
northbound CRC error

Try replacing or reseating DIMMs first, then system
board.

953-Non-aliased uncorrectable
patrol data ECC error

Double bit ECC error due to bad DIMM
or improperly installed DIMM

Try reseating the DIMMs and make sure that they are
inserted correctly. If the problem persists, remove or
replace the DIMMs one by one until the problem DIMM
is isolated.

956-Non-aliased uncorrectable
non-mirrored demand data
ECC error

Bad DIMM or improperly installed
DIMM

Try reseating the DIMMs and make sure that they are
inserted correctly. If the problem persists, remove or
replace the DIMMs one by one until the issue is
resolved.

960–CPU Overtemp occurred. The ambient temperature could
exceed operating limits (maximum =
95° F), or there are obstructions to
airflow, including dust build up.

1. Be sure you are not operating the system in an
environment that exceeds 95° F.

2. Disconnect power and open the access panel.

3. Check that cables are not blocking CPU heatsink
fans or front fan, if installed.

4. Check that there is not excessive dust on major
components.

5. If airflow is acceptable and there is not excessive
dust, the thermal sensing circuitry has failed on the
processors or on the system board. You must
replace the processors, the system board, or both.

961-Uncorrectable data ECC
on replay error

Bad DIMM or improperly installed
DIMM

Try reseating the DIMMs and make sure that they are
inserted correctly. If the problem persists, remove or
replace the DIMMs one by one until the problem DIMM
is isolated.

1151–Serial Port 1 Address
Conflict Detected.

Both external and internal serial ports
are assigned to COM1.

1. Remove any COM port expansion cards.

2. Clear CMOS.

3. Reconfigure card resources and run Computer
Setup (F10 Setup).

4. Run Computer Setup or Windows utilities.
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1155–Serial Port Address
Conflict Detected.

Both external and internal serial ports
are assigned to same IRQ.

1. Remove any COM port expansion cards.

2. Clear CMOS.

3. Reconfigure card resources and run Computer
Setup (F10 Setup).

4. Run Computer Setup or Windows utilities.

1201–System Audio Address
Conflict Detected.

Device IRQ address conflicts with
another device. (Usually due to an
add-in audio card.)

Reset the IRQ.

1202–MIDI Port Address
Conflict Detected.

Device IRQ address conflicts with
another device. (Usually due to an
add-in audio card.)

Reset the IRQ.

1203–Game Port Address
Conflict Detected.

Device IRQ address conflicts with
another device. (Usually due to an
add-in audio card.)

Reset the IRQ.

1720 SMART Hard Drive
Detect Imminent Failure.

Hard drive is about to fail. (Some hard
drives have a firmware patch that will
fix an erroneous error message.)

1. Determine if hard drive is giving correct error
message.

2. Run the Drive Protection System test if applicable.

3. Apply firmware patch if applicable
(see  http://www.hp.com/support).

4. Back up contents and replace hard drive.

1783–Disk 0 Failure. The drive is not installed correctly or
has failed.

1. Be sure that power and drive cables are connected
to the drive and to the system board.

2. Verify that the cables are the correct cables for
your computer model.

3. If this message persists, you might need service
for your workstation.

1784–Disk 1 Failure. The drive is not installed correctly or
has failed.

1. Be sure that power and drive cables are connected
to the drive and to the system board.

2. Verify that the cables are the correct cables for
your computer model.

If this message persists, you might need service for
your workstation.

1794–Inaccessible devices
attached to SATA 1 and/or
SATA 3.

Devices attached to the SATA 1 (blue)
and SATA 3 (black) connectors are
inaccessible while SATA Emulation is
set to Combined IDE Controller in
Setup.

1. Run Computer Setup (F10 Setup).

2. Select Storage>Storage Options, and set the
SATA controller to Separate IDE Controller.

1800–Temperature Alert. Internal temperature exceeds
specification.

1. Check that workstation air vents are not blocked
and that the cooling fan is running.

2. Verify processor speed selection.

3. Replace the processor.

4. Replace the system board.
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1801–Microcode Update Error. Missing or Invalid Processor
Microcode Update. Contact HP for a
new Microcode Update to support the
new Processor Stepping.

Upgrade BIOS to proper version.

1802–Processor Not
Supported.

The system board does not support
the processor.

Replace the processor with a compatible one.

Invalid Electronic Serial
Number.

Electronic serial number has become
corrupted.

1. Run Computer Setup. If Setup already has data in
the field or will not allow the serial number to be
entered, download SP5572.EXE (SNZERO.EXE)
from http://www.hp.com and run it on your
workstation.

2. Run Computer Setup. Try to enter the serial
number under Security>System ID, and save the
changes.

ECC Multiple Bit Error Detected
in Memory Module.

Chipset has detected more than one
bad bit in a 64-bit quadword of the
memory array.

Replace the memory module.

Parity Check 2. Parity RAM failure. Run Computer Setup and Diagnostic utilities.

Table 5-18  POST error messages  (continued)
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Supported SAS RAID configurations
The following RAID configurations are supported on the HP xw8400 Workstation.

NOTE  This section does not apply to configuring RAID in the Linux environment. For RAID in
the Linux environment, configure SW RAID configurations as provided by Red Hat Enterprise
Linux.

● Up to 4 internal or external SAS hard disk drives

● External connections require optional internal-to-external cable

● SAS drives require SAS to SATA data and power converter

● LSI MyStorage Utility for Windows

● RAID 0 – Striped disk array

● Two drives minimum

● Improved I/O performance

● No fault tolerance

● RAID 1 — Mirrored disk array

● Improved read performance

● 100% redundancy

● Can recover from single drive failure

● Two drives

● RAID 1E

● Three drives minimum

● Can be an odd number of drives

● Can always recover from a single drive failure, and in some cases, recover from two drive
failures
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SAS RAID 0 configuration
Follow the steps below to configure an Integrated Striped (IS) volume with the BIOS-based configuration
utility. The configuration procedure assumes that the system already has the required disk and disk
controllers.

1. On the Main menu screen of the BIOS-based configuration utility, use the arrow keys to select an
adapter.

2. Press Enter to go to the Adapter Properties screen.

3. On the Adapter Properties screen, use the arrow keys to select RAID Properties on the screen.

4. Press Enter to go to the RAID Properties screen.

5. In the RAID Properties screen, use the arrow keys to select the first disk for the IS volume. Then
use the arrow keys to move to the Array Disk column for this disk, and press the SPACE, +, or -
key to select Yes as the value for this column. If partitions are defined on the selected disk, a
message appears warning you that data on the disk will be lost when the striped volume is created.
Press the M key to migrate, or the D key to delete the data on the drive.

6. Repeat the previous step to select up to three more disks for the striped volume.

7. Press the C key to create the array once all drives have been chosen, then press Esc and
SAVE.
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SAS RAID 1 configuration
Follow the steps below to configure an Integrated Mirroring (IM) volume with the BIOS-based
configuration utility. The configuration procedure assumes that the system already has the required disk
and disk controllers.

1. On the Main menu screen of the BIOS-based configuration utility, use the arrow keys to select an
adapter.

2. Press Enter to go to the Adapter Properties screen.

3. On the Adapter Properties screen use the arrow keys to select RAID Properties on the screen.

4. Press Enter to go to the RAID Properties screen. Continue with Step 5 to configure a two-disk
mirrored volume. Go to Step 6 to configure a mirrored volume with three to six disks.

5. To configure a two-disk mirrored volume with an optional hot spare disk:

● In the RAID Properties screen, use the arrow keys to select the primary disk for the IM volume
(the disk with the data you want to mirror.)

● Use the arrow keys to move to the Array Disk column for this disk and use the SPACE key to
select Yes as the value. If partitions are defined on the selected disk, a message appears
warning you that data on the disk will be lost when the striped volume is created. Press the
M key to migrate, or the D key to delete the data on the drive.

● When the Keep Data/Erase Disk message appears, press F3 to keep the data that is currently
on this disk. The value in the Array Disk column changes to Primary.

● Use the arrow keys to select the secondary (mirrored) disk for the IM volume. Select Yes as
the value for the Array Disk column.

If partitions are defined on this disk, a message warns you that data on the disk will be lost
when the mirrored volume is created. Press Delete to confirm erasing data from the disk, or
press any other key to deselect the disk. Continue with Step 7.

6. To configure a mirrored volume with three to six disks, or three to five disks with an optional hot
spare disk:

● In the RAID Properties screen, use the arrow keys to select the first disk for the IM volume.

● Use the arrow keys to move to the Array Disk column for this disk, and use the + and - keys
to select Yes as the value.

● When the Keep Data/Erase Disk message appears, press Delete to erase the disk.

● Use the arrow keys to select the next disk for the IM volume. Select Yes as the value for the
Array Disk column.

If partitions are defined on this disk, a message warns you that data on the disk will be lost
when the mirrored volume is created. Press Delete to confirm erasing data from the disk, or
press any other key to deselect the disk.

● Repeat the previous steps to select up to four more disks for the IM volume. If you want to
configure a hot spare disk for the volume, you can only select up to three more disks.
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7. (Optional) Use the arrow keys to select a hot spare disk for the IM volume. Select Yes as the value
for the Hot Spare column.

8. When you have selected all disks for the IM volume, press Esc and select Save changes, then
exit this menu. (If you do not want to create the IM volume, select Discard changes, then exit
this menu.

The IM volume exists as soon as you save the changes. The RAID Properties screen now displays
the IM volume properties and status.
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SAS RAID 1E configuration
Follow the steps below to configure an Integrated Mirroring Extended (IME) volume with the BIOS-based
configuration utility. The configuration procedure assumes that the system already has the required disk
and disk controllers.

1. On the Main menu screen of the BIOS-based configuration utility, use the arrow keys to select an
adapter.

2. Press Enter to go to the Adapter Properties screen.

3. On the Adapter Properties screen use the arrow keys to select RAID Properties on the screen.

4. Press Enter to go to the RAID Properties screen. Continue with Step 5 to configure a two-disk
mirrored volume. Go to Step 6 to configure a mirrored volume with three to six disks.

5. To configure a two-disk mirrored volume with an optional hot spare disk:

● In the RAID Properties screen, use the arrow keys to select the primary disk for the IME volume
(the disk with the data you want to mirror.)

● Use the arrow keys to move to the Array Disk column for this disk and use the SPACE, +,
or - key to select Yes as the value. If partitions are defined on the selected disk, a message
appears warning you that data on the disk will be lost when the striped volume is created.
Press the M key to migrate, or the D key to delete the data on the drive.

● When the Keep Data/Erase Disk message appears, press F3 to keep the data that is currently
on this disk. The value in the Array Disk column changes to Primary.

● Use the arrow keys to select the secondary (mirrored) disk for the IME volume. Select Yes as
the value for the Array Disk column.

If partitions are defined on this disk, a message warns you that data on the disk will be lost
when the mirrored volume is created. Press Delete to confirm erasing data from the disk, or
press any other key to deselect the disk. Continue with Step 7.

6. To configure a mirrored volume with three to six disks, or three to five disks with an optional hot
spare disk:

● In the RAID Properties screen, use the arrow keys to select the first disk for the IME volume.

● Use the arrow keys to move to the Array Disk column for this disk, and use the + and - keys
to select Yes as the value.

● When the Keep Data/Erase Disk message appears, press Delete to erase the disk.

● Use the arrow keys to select the next disk for the IME volume. Select Yes as the value for the
Array Disk column.

If partitions are defined on this disk, a message warns you that data on the disk will be lost
when the mirrored volume is created. Press Delete to confirm erasing data from the disk, or
press any other key to deselect the disk.

● Repeat the previous steps to select up to four more disks for the IME volume. If you want to
configure a hot spare disk for the volume, you can only select up to three more disks.

138 Appendix A   Appendix A — SAS devices ENWW



7. (Optional) Use the arrow keys to select a hot spare disk for the IME volume. Select Yes as the
value for the Hot Spare column.

8. When you have selected all disks for the IME volume, press Esc and select Save changes, then
exit this menu. (If you do not want to create the IME volume, select Discard changes, then exit
this menu.

The IME volume exists as soon as you save the changes. The RAID Properties screen now displays
the IME volume properties and status.
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B Appendix B—SATA devices

This appendix describes how to use the Intel® Matrix Storage Manager option ROM Configuration Utility
to set up and manage SATA RAID volumes.

NOTE If only a single HDD is attached, the Intel Matrix Storage Manager option ROM will not
execute, and all associated messages will not be displayed.

Intel’s Serial ATA AHCI BIOS always executes when RAID/AHCI is selected for the SATA
emulation mode. This BIOS is only used to support serial attached optical drives. When an HDD
is attached, the AHCI BIOS properly identifies the HDD that is connected to the appropriate SATA
port and displays (Device not supported in this configuration). This message is expected and
is not an indication of a problem.
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Attaching SATA HDDs
Attach the required number of SATA HDDs for the desired RAID level.

● RAID 0: two to six HDDs

● RAID 1: two HDDs

● RAID 5: three to six HDDs

● RAID 10: four to six HDDs
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Configuring system BIOS
Configure the system BIOS to enable embedded SATA RAID functionality.

1. Press F10 to enter the system BIOS setup.

2. Use the arrow keys to highlight the desired language, then press Enter.

3. Press left arrow, right arrow, left arrow, and right arrow  to highlight Storage>Storage Options,
then press Enter.

4. Press the up or down arrow key to highlight SATA Emulation.

5. Press the left or right arrow key to select RAID/AHCI.

6. Press F10 to accept the new setting.

7. Press left arrow, right arrow, left arrow, and right arrow to highlight Advanced > Power-On
Options, then press Enter.

8. Press the up or down arrow key to highlight POST Messages.

9. Press the left or right arrow key to select Enable.

10. Press F10 to accept the new setting.

11. Use the arrow keys to highlight Advanced>Device Options, and press Enter.

12. Press the up or down arrow key to highlight SATA RAID Option ROM Download, and press
Enter.

13. Press the left or right arrow key to select Enable.

14. Press F10 to accept the new setting.

15. Press left arrow, right arrow, left arrow, and right arrow to highlight File>Save Changes and
Exit, and press Enter.

16. Press F10 when prompted.
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Creating RAID volumes
Use the Intel Matrix Storage Manager option ROM Configuration Utility to create RAID volumes

.

1. Press Ctrl+I when prompted to enter the Intel Matrix Storage Manager option ROM Configuration
Utility.

2. If required, refer to Deleting RAID volumes on page 145 to make enough physical drives available
to create the desired RAID volume.

3. Press the up or down arrow key to highlight 1. Create RAID Volume, and press Enter.

4. Type the desired RAID volume name in the Name: field, and press Tab.

5. Press the up or down arrow key to select the desired RAID level in the RAID Level: field, then
press Tab.

6. Press Enter to display the Select Disks dialog.

7. Press the up and down arrow keys and <Space> to mark individual physical disks which will be
members of the volume.

8. Press Enter to exit the Select Disks dialog and return to the Create Volume Menu dialog.

9. If appropriate, press the up or down arrow key to select the Strip Size in the Strip Size: field, and
press Tab.

10. Type the desired volume size in the Capacity: field, and press Tab.

11. Press Enter to initiate volume creation.

12. When prompted, press Y to acknowledge the warning message and create the volume.

13. Return to step 3. to create additional RAID volumes, or use ↑ or ↓ to highlight 4. Exit, and press
Enter.

14. Press Y when prompted to confirm the exit.
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Deleting RAID volumes
Use the Intel Matrix Storage Manager option ROM Configuration Utility to delete RAID volumes.

1. Press the up or down arrow key to highlight 2. Delete RAID Volume, and press Enter.

2. Press the up or down arrow key to highlight the RAID volume to be deleted, and press Del.

3. When prompted, press Y to confirm the deletion of the selected RAID volume.

4. Choose one of the following steps:

● Return to step 1. to delete additional RAID volumes.

● Refer to Creating RAID volumes on page 144 to create RAID volumes.

● Use the up or down arrow key to highlight 4. Exit, and press Enter.

● Use the up or down arrow key to highlight 3. Reset Disks to Non-RAID, and press Enter.

5. Press the up and down arrow keys and <Space> to mark individual physical disks to be reset.

6. Press Enter to complete the selection.

7. When prompted, press Y to confirm the reset action.

8. Choose one of the following steps:

● Return to step 1. to delete additional RAID volumes.

● Refer to Creating RAID volumes on page 144 to create RAID volumes.

● Use the up or down arrow key to highlight 4. Exit, and press Enter.
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C Appendix C — Ultra ATA devices
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Ultra ATA jumpers
NOTE This system supports a mixed configuration of UATA/IDE optical drives, and SAS and
SATA hard drives. While HP supports the presence of SCSI and IDE hard drives, it does not ship
any configurations using those drives.

Ultra ATA drives are configured with jumper settings. Factory-installed drives ship with the jumpers
preset to the cable-select mode; therefore, no jumper setting changes are required on factory
preinstalled, replacement, or option drives. With cable-select, the drive is configured as either Master
(Drive/Device 0) or Slave (Drive/Device 1) by its physical attachment to the cable. 

If you purchase a third-party hard drive, refer to the documentation included with the drive kit to ensure
proper cable installation and configuration.

NOTE All drives on a controller channel must have their jumpers either in the cable-select mode
or have the individual drive jumper installed on the appropriate Master (Drive/Device 0) or Slave
(Drive/Device 1) position.

148 Appendix C   Appendix C — Ultra ATA devices ENWW



Ultra ATA cables 
When installing a second device on either the primary or secondary controller, you must use an industry
standard 80-conductor Ultra ATA cable for optimal performance. These cables have a maximum length
of 18 inches and a maximum distance of six inches between the two devices for a two-drive cable.

Drives operating at speeds faster than those of the Ultra ATA-33 devices require industry-standard 40-
pin, 80-conductor cables to maintain the highest data transfer rates possible with the improved
technology.

When using Ultra ATA-133, -100, -66, and -33 drives in the same system, each drive will operate at its
appropriate data transfer rate.
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Drive installation guidelines
Most workstation system boards have two ATA (IDE) controller channels with a dedicated connector for
each controller. One controller is designated as the primary and the other as the secondary controller.

Each of the two controllers can have up to two devices attached to it. Each workstation system might
therefore have a maximum of four ATA/ATAPI drives. All drives are connected to these controllers using
an industry-standard, 80-conductor cable.

NOTE The industry standard, 1.44-MB diskette drive has its own separate channel and is not
included as a part of the maximum four drives.

Any drive attached to a controller must have a drive designation. If only a single drive is connected to
a controller and its jumper is in the cable-select position, it is designated as the Master Drive (Drive/
Device 0) by its attachment to the Drive/Device 0 cable position. If two cable-selected drives are
connected to a single controller, one will be designated by its attachment to the cable as the Master
(Drive/Device 0) and the other as Slave (Drive/Device 1).

For optimal performance of a workstation system, all drives must be attached to the ATA controllers in
a specified sequence. This sequence is determined by the device class of the drives and by specific
attach sequence rules.

Device classes
To determine the best drive attach sequence, ATA/ATAPI drives are segregated into four different
classes based on the bandwidth demands they place on an ATA controller. The most demanding devices
are in Class 1 and the least demanding are in Class 4.

Table C-1  Device classes

Class 1 Hard
drives

Class 2 High Speed
optical drives

Class 3 Optical storage
drives

Class 4 Magnetic
storage drives

ATA-100

ATA-66

ATA-33

DVD

DVD-CD R/W

R/W CD-ROM

CD-ROM

LS-120

Tape

Zip

General attach guidelines

● The lower the device class number, the faster the device and the more bandwidth required.

● Drives installed in the Device 0 positions on both the primary and secondary controllers receive
the greatest possible bandwidth.

● The bootable ATA hard drive should always be installed on the primary controller in the Device 0
position.

Attach sequence rules by class priority
Drives should be attached in the sequence shown for optimum performance starting at position 1.
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1

2

4

3

Primary 
Controller*

4 1

Installing drive order

*If there are three or more devices, two or more of which are hard drives, two hard drives should be
attached to the primary controller first before following the general attach sequence rule.

The attach sequence rule can also be stated in table format:

Table C-2  General attach sequence rule

Sequence Description

1 The lowest class drive—Bootable hard drive recommended.

2 If only two drives, the last drive goes here; otherwise, the lowest class of the remaining drives goes
here.

3 If only three drives, attach the final drive here. If a fourth drive exists, attach the lowest class drive
here.

4 If there is a fourth drive, attach the final drive here—the drive with the highest class number of all
devices.

If there are three or more devices, two or more of which are hard drives, two hard drives should be attached to the
primary controller first before following the general attach sequence rule.

The rules allow for:

● Keep the hard drive on a separate controller channel to maximize drive performance until a fourth
device is added.

● Keep the hard drives and removable media drives on separate controller channels to maximize
compatibility.

● Keep the hard drive and the writable optical drive on separate controller channels to maximize
optical drive reliability.

Attach sequence worksheet
Use the worksheet below to obtain optimum system performance when setting up a workstation with
multiple drives. Use the general attach sequence rule to determine the best drive installation sequence.

Table C-3  Attach sequence worksheet

Device name Device class Position
number

Controller name Device
number

ENWW Drive installation guidelines 151



Device name Device class Position
number

Controller name Device
number

Two examples of how to use the worksheet are:

● Three device installation

● Four device installation

Example 1: Three device installation sample
A system has three devices: Ultra ATA-100 hard drive, CD-ROM drive, and a DVD drive. Using the
Device Class Table, the devices can be identified as:

● Ultra ATA-100 hard drive = Class 1

● DVD drive = Class 2

● CD-ROM drive = Class 3

Table C-4  Attach sequence worksheet—Three device installation (sample)

Devicen ame Device class Position
number

Controller name Device
number

Ultra ATA-100 hard drive 1 1 Primary 0

DVD drive 2 2 Secondary 0

CD-ROM drive 3 3 Secondary 1

1

2

4

3

Primary 
Controller*

4 1

Installing drive order (2)

Table C-3  Attach sequence worksheet (continued)
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Example 2: Four device installation sample

A system has four devices: Ultra ATA-100 hard drive, Ultra ATA-100 hard drive, DVD-CDR/W drive,
and a ZIP-250 drive.

● Ultra ATA-100 hard drive = Class 1

● Ultra ATA-100 hard drive = Class 1

● DVD-CDR/W drive = Class 2

● ZIP-250 drive = Class 4

Table C-5  Attach sequence worksheet—Four device installation (sample)

Device name Device
class

Position
number

Controller name Device
number

Ultra ATA-100 hard drive 1 1 Primary 0

DVD-CDR/W drive 2 2 Secondary 0

ZIP-250 drive 4 3 Secondary 1

Ultra ATA-100 hard drive* 1 4 Primary 1

*If there are three or more devices, two or more of which are hard drives, two hard drives should be attached to the
primary controller first before following the general attach sequence rule.

1

2

4

3

Primary 
Controller*

4 1

Installing drive order (3)

Additional drive application notes
● When replacing a hard drive, the replacement should be of the same type (Ultra ATA-33, -66, or

-100) as that being removed to retain the same level of performance.
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SMART  
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for HP workstations have
built-in drive failure prediction that warns the user or network administrator of an impending failure or
crash of the hard drive. The SMART drive tracks fault prediction and failure indication parameters, such
as reallocated sector count, spin retry count, and calibration retry count. If the drive determines that a
failure is imminent, it generates a fault alert.
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Jumpers 
The following specification is the standard drive configuration.

CD-ROM or DVD-ROM drive
 

CD-ROM or DVD-ROM drive jumpers
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Connector pin descriptions
Ethernet connector Pin Signal

1

2

3

4

(+) Transmit Data

(-) Transmit Data

(+) Receive Data

Unused

5

6

7

8

Unused

(-) Receive Data

Unused

Unused

Parallel connector

Pin Signal Pin Signal Pin Signal

1

2

3

Strobe

Data Bit 0

Data Bit 1

7

8

9

Data Bit 5

Data Bit 6

Data Bit 7

13

14

15

Select

Auto Linefeed

Error

4

5

6

Data Bit 2

Data Bit 3

Data Bit 4

10

11

12

Acknowledge

Busy

Paper End

16

17

18-25

Initialize Printer

Select IN Signal

Ground

Serial connector Pin Signal

1

2

3

Carrier Detect

Receive Data

Transmit Data

4

5

6

Data Terminal Ready Signal

Ground

Data Set Ready

7

8

9

Request to Send

Clear to Send

Ring Indicator
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USB connector Pin Signal

1

2

3

4

+5 VDC

- Data

+ Data

GND

IEEE 1394 connector Pin Signal

1 power

2 gnd

3 tpb-

4 tpb+

5 tpa-

6 tpa+

Microphone connector (1/8 inch) Pin  Signal  

1 (Tip)

2 (Ring)

3 (Shield)

Audio

Power

Ground

Headphone connector (1/8 inch) Pin  Signal  

1 (Tip)

2 (Ring)

3 (Shield)

Audio_Left

Audio_Right

Ground

Line-in audio connector (1/8 inch) Pin  Signal  

1 (Tip)

2 (Ring)

3 (Shield)

Audio_In_Left

Audio_In_Right

Ground

Line-out audio connector (1/8 inch) Pin  Signal  

1 (Tip)

2 (Ring)

Audio_Out_Left

Audio_Out_Right
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Line-out audio connector (1/8 inch) Pin  Signal  

3 (Shield) Ground

SATA connector

Pin Signal  Pin Signal  Pin Signal  

Data Cable  Power Cable  Power Cable  

S-1 Ground P-1 3.3-V power P-8 5-V power

S-2* A+ P-2 3.3-V power P-9 5-V power

S-3* A- P-3 3.3-V power P-10 Ground

S-4 Ground P-4 Ground P-11 Reserved

S-5** B- P-5 Ground P-12 Ground

S-6** B+ P-6 Ground P-13 12-V power

S-7 Ground P-7 5-V power P-14 12-V power

* S2 and S3 differential signal pair

**S5 and S6 differential signal pair

P-15 12-V power

SAS connector

Segment Pin Backplane receptacle Plug and cable
receptacles

Primary signal segment S1 SIGNAL GROUND

S2 TP+ RP+

S3 TP- RP-

S4 SIGNAL GROUND

S5 RP- TP-

S6 RP+ TP+

S7 SIGNAL GROUND
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SAS connector

Segment Pin Backplane receptacle Plug and cable
receptacles

Secondary signal segment S8 SIGNAL GROUND

S9 TS+ RS+

S10 TS- RS-

S11 SIGNAL GROUND

S12 RS- TS-

S13 RS+ TS+

S14 SIGNAL GROUND

Power segment P1 V33
c

P2 V33
c

P3 V33
c precharge c

P4 GROUND

P5 GROUND

P6 GROUND

P7 V5
c precharge c

P8 V5
c

P9 V5
c

P10 GROUND

P11 READY LED d

P12 GROUND

P13 V12 precharge c

P14 V12
c

P15 V12
c
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VGA cconnector  

 

Pin  Signal Pin  Signal Pin  Signal  

1

2

3

Red Analog

Green Analog

Blue Analog

6

7

8

GND

GND

GND

11

12

13

Monitor ID

DDC Serial Data

Horizontal Sync

4

5

Monitor ID

GND

9

10

+5V DC

GND

14

15

Vertical Sync

DDC Serial Clock

DVI connector

Pin Signal Pin Signal

1 T.M.D.S DATA 2- 16 HOT PLUG DETECT

2 T.M.D.S DATA 2+ 17 T.M.D.S DATA 0-

3 T.M.D.S DATA 2/4 SHIELD 18 T.M.D.S DATA 0+

4 T.M.D.S DATA 4- 19 T.M.D.S DATA 0/5 SHIELD

5 T.M.D.S DATA 4+ 2 0 T.M.D.S DATA 5-

6 DDC CLOCK 21 T.M.D.S DATA 5+

7 DDC DATA 22 T.M.D.S CLOCK SHIELD

8 ANALOG VERT. SYNC 23 T.M.D.S CLOCK+

9 T.M.D.S DATA 1- 24 T.M.D.S CLOCK-

10 T.M.D.S DATA 1+

11 T.M.D.S DATA 1/3 SHIELD C1 ANALOG RED

12 T.M.D.S DATA 3- C2 ANALOG GREEN

13 T.M.D.S DATA 3+ C3 ANALOG BLUE

14 +5V POWER C4 ANALOG HORZ SYNC

15 GND C5 ANALOG GROUND
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ATA/ATAPI (IDE) standard drive cable connector

Pin  Signal  Pin  Signal  Pin  Signal

1

2

3

4

5

 Reset

GND

DD7

DD8

DD6

15

16

17

18

19

DD1

DD14

DD0

DD15

GND

 29

30

31

32

33

DMAK

GND

INTRQ

IOCS16

DA1

6

7

8

9

10

 DD9

DD5

DD10

DD4

DD11

20

21

22

23

24

(Key)

DMARQ

GND

DIOW

GND

34

35

36

37

38

PDIAG (cable detect)

DA0

DA2

CS1FX

CS3FX

11

12

13

14

 DD3

D12

D2

D13

25

26

27

28

DIOR

GND

IORDY

CSEL

39

40

DASP

GND

24-Pin Main power connector

1 12

13 24

1

2

3

4

5

6

7

+3.3 V

+3.3 V

GND

+5 V

GND

+5 V

GND

 8

9

10

11

12

13

POK

+5 Vaux

+12 V-A

+12 V-A

+3.3 V

+3.3 V/+3.3 V-Rsense

14

15

16

17

18

19

20

-12 V

GND

PS_ON_L

GND

GND

GND

21

22

23

24

+5 V

+5 V/+5 V-Rsense

+5 V

GND
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CAUTION Be sure you can differentiate between which power cable connects to the PCI
Express x16 graphics card and which power cable connects to the system board. These two
cables look very similar. The PCI Express power cable has a black connector, and the system
board power cable has a white connector. When power is present, you must never connect the
PCI Express power cable to the system board. If you do so, the system board may be damaged
and your warranty voided. To see a picture of the PCI Express cable and where it must be
connected, refer to PCI or PCI Express installation on page 75.

6-Pin power (auxiliary system board) connector Pin Color Signal

4 6

31

1 BLD w/ORG stripe +3.3V

2 BLK w/ORG stripe +3.3V

3 BLD w/YEL stripe +12V-A

4 BLK GND

5 BLK GND

6 BLD w/YEL stripe -12V

8-Pin power (for CPUs and memory) Pin  Color Signal

5 8

41

1 BLK GND

2 BLK GND

3 BLK GND

4 BLK GND

5 Gray

BLK w/WHT stripe

+12 V CPU0 Rsense

+12 V CPU0

6 BLK w/WHT stripe +12VCPU0

7 BLK w/light blue
stripe

+12VCPU1

8 BLK w/light blue
stripe

+12VCPU1

CAUTION Be sure you can differentiate between which power cable connects to the PCI
Express x16 graphics card and which power cable connects to the system board. These two
cables look very similar. The PCI Express power cable has a black connector, and the system
board power cable has a white connector. When power is present, you must never connect the
PCI Express power cable to the system board. If you do so, the system board may be damaged
and your warranty voided. To see a picture of the PCI Express cable and where it must be
connected, refer to PCI or PCI Express installation on page 75.

NOTE The 6-pin power (auxiliary PCI Express) is only required with high-powered graphics
cards.
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6-Pin power (auxiliary PCI Express) Pin Color Signal

4 6

31

1 BLK w/YEL stripe +12V-C

2 BLK w/YEL stripe +12V-C

3 BLK w/YEL stripe +12V-C

4 BLK GND

5 BLK GND

6 BLK GND

Keyboard connector  Pin Signal

1

2

3

Data
Unused
Ground

4

5

6

+5 VDC
Clock

Unused

Mouse connector  Pin Signal

1

2

3

Data
Unused
Ground

4

5

6

+5 VDC
Clock

Unused
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E Appendix E — System board
designators

This appendix lists the system board designators for this system.

Designator Silkscreen Component

MH02-03, MH06-09, MH14-15 N/A Mounting holes

N/A N/A LED: 5V_AUX power indicator

N/A N/A Power LED

E14 BBLK_WP Boot block header/jumper

E49 PSWD Clear password header/jumper

J20 SLOT1 PCI PCI slot

J21 SLOT5 PCI-X 133 PCI slot

J22 SLOT6 PCI-X 100 PCI slot

J23 SLOT7 PCI-X 100 PCI slot

J31 SLOT 3 PCI-E x8 (4) PCI Express slot

J32 SLOT 4 PCI-E x16 (4) PCI Express slot

J41 SLOT2 PCI-E x16 GRAPHICS PCI Express x16 slot for graphics

P80-83 SAS0, SAS1, SAS2, SAS3 SAS Connectors

P60-63, P66-67 SATA0, SATA1, SATA2, SATA3, SATA4, SATA5 SATA Connectors

J53, P53 PAR/SER Parallel port and serial port stack connector

J68 KBD MS PS2 Stacked keyboard/mouse connector

J9 RJ45/USB Stacked RJ 45/dual USB

J10 USB Quad stacked USB

J11 1394 IEEE 1394a connector

J83 AUD Triple stacked audio jack

N/A N/A Reset header

SW50 CMOS Clear CMOS switch/push button

P1 PWR Power supply connector (24-pin)

P2 PWR2 Second power supply connector
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Designator Silkscreen Component

P3 PWRCPU Processor 12-V header

P10 FDD Diskette driver connector

N/A N/A Security boot connector

N/A N/A CD analog audio connector

P11 AUX Auxiliary audio connector

P20 PRIMARY IDE Primary IDE connector

N/A N/A Secondary IDE connector

J12 FRNT 1394 Front panel 1394a header

J34 FRNT AUD Front panel audio header

P24 FRNT USB Front panel USB header

P25 INT USB Internal USB header

N/A N/A Multi-Bay Header

P29 HDD LED HDD LED connector

J33 CONTROL PANEL Main power/HDD LED/internal speaker
connector

P70 CPUFAN1 Primary CPU fan header

P71 CPU2FAN Secondary CPU fan header

P8 CHFAN Primary chassis fan header

P92 MEMFAN Memory fan header

P9 PCIFAN1 PCI fan header

P93 FRNTFAN Front chassis fan header

BAT1 BAT Battery retainer

XMM1 DIMM1 Memory slot

XMM2 DIMM2 Memory slot

XMM3 DIMM3 Memory slot

XMM4 DIMM4 Memory slot

XMM5 DIMM5 Memory slot

XMM6 DIMM6 Memory slot

XMM7 DIMM7 Memory slot

XMM8 DIMM8 Memory slot

U1 XU1 Primary processor socket

U2 XU2 Secondary processor socket

U23 ROM ROM socket

E15 RECOVER Crisis recovery header/jumper
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F Appendix F — Power cord set
requirements

The power cord set (flexible cord or wall plug) received with this product meets the requirements for use
in the country where you purchased the equipment.

If you must obtain a power cord for a different country, purchase a power cord that is approved for use
in that country.

The power cord must be rated for the product and for the voltage and current marked on the product’s
electrical ratings label. The voltage and current rating of the cord should be greater than the voltage and
current rating marked on the product. The length of the cord must be between 1.8 m (6 feet) and 3.6 m
(12 feet). If you have questions about the type of power cord to use, contact an HP authorized service
provider.

Route the power cord so that it is not likely to be walked on or pinched by items placed on it or against
it. Pay particular attention to the plug, electrical outlet, and the point where the cord exits from the
product.

NOTE Use a 15 A-capable (minimum) power cord with a 110V power source. Use a 10 A-
capable (minimum) power cord with a 220V power source.
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G Appendix G — Routine care
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General cleaning safety precautions 
● Never use solvents or flammable solutions to clean the workstation.

● Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth
and then use the cloth on the component.

● Always unplug the workstation before cleaning the keyboard, mouse, or air vents.

● Disconnect the keyboard before cleaning it.

● Wear safety glasses equipped with side shields when cleaning the keyboard.
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Maximizing the airflow
● Keep your workstation in an area where the airflow to the front and rear of the system is not

obstructed.

● If possible, keep the unit off of surfaces where dust can gather.

● Keep the back of the unit at least 0.15 m (6 in.) away from a wall or other obstruction.

● Keep the front of the unit clear of any obstruction that keeps air from entering the front of the system.

● Remove any dust on the front panel (vent area) and the rear fans with a small vacuum, compressed
air, or dust rag.
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Cleaning the workstation case
● Follow the safety precautions presented in Service considerations on page 50 before cleaning the

workstation.

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dish-washing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed because the alcohol will
evaporate quickly and not leave a residue.

● After cleaning, always wipe the unit with a clean, lint-free cloth.

● Occasionally clean the air vents on the workstation. Lint and other foreign matter can block the
vents and limit the airflow.
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Cleaning the keyboard  
CAUTION Use safety glasses equipped with side shields before attempting to clean debris from
under the keys. 

● Follow the safety precautions presented in Service considerations on page 50 before cleaning the
keyboard.

● Visible debris underneath or between the keys can be removed by vacuuming or shaking.

● Canned, pressurized air can be used to clean debris from under the keys. Use caution because
too much air pressure can dislodge lubricants applied under the wide keys.

● If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool
is available through many electronic supply outlets. 

CAUTION Never remove a wide leveled key (like the space bar) from the keyboard. If
these keys are improperly removed or installed, the keyboard might not function properly.

● Clean under a key with a swab moistened with isopropyl alcohol and squeezed out. Be careful not
to wipe away lubricants necessary for proper key functions. Allow the parts to air dry before
reassembly.

● Use tweezers to remove any fibers or dirt in confined areas.
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Cleaning the monitor  
● Follow the safety precautions presented in Service considerations on page 50 before cleaning the

keyboard.

● To clean the monitor, wipe the monitor screen with a towelette designed for cleaning monitors or
a clean cloth moistened with water.

CAUTION Do not use sprays or aerosols directly on the screen—the liquid might seep into
the housing and damage a component.

Never use solvents or flammable liquids on the monitor because display or housing damage
may result.
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Cleaning the mouse
1. Follow the safety precautions presented in Service considerations on page 50 before cleaning the

mouse.

2. Remove the mouse ball from the housing by removing the retaining plate.

3. Clean the mouse ball.

4. Pull out any debris from the ball socket, and wipe the ball with a clean, dry cloth.

5. Reassemble the mouse.
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H Appendix H — Additional password
security and resetting CMOS

This workstation supports the following security password features, which can be established through
the Computer Setup Utilities menu:

● Setup password

● Power-on password

When you establish a setup password, only the power-on password is required to access Computer
Setup and any other information on the workstation. When you establish both passwords, only the setup
password will give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on password
as an override to log in to the workstation, which is a useful feature for a network administrator.

If you forget the password for the computer, two methods are available for clearing that password so
you can gain access to the information on the workstation:

● Reset the password jumper

● Use the Clear CMOS button

CAUTION Pushing the CMOS button resets CMOS values to factory defaults and erases any
customized information, including passwords, asset numbers, and special settings. It is important
to back up the workstation CMOS settings before resetting them in case they are needed later.
To back up the CMOS settings, use Computer Setup and run the Save to Diskette option from
the File menu.
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Resetting the password  jumper
To disable the power-on or setup password features and clear the power-on and setup passwords:

1. Shut down the operating system, and power off the workstation and any external devices.
Disconnect the power cord of the workstation and any external devices from the power outlets.

2. Disconnect the keyboard, monitor, and any other external devices that are connected to the
workstation.

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces,
be sure to disconnect the power cord from the wall outlet and allow the internal system
components to cool before touching. Remove the access panel.

CAUTION When the workstation is plugged in, the power supply always has voltage
applied to the system board even when the unit is turned off. Failure to disconnect the power
cord can result in damage to the system.

CAUTION Static electricity can damage the electronic components of the workstation or
optional equipment. Before beginning these procedures, be sure that you are discharged of
static electricity by briefly touching a grounded metal object.

3. Remove the access panel.

4. Locate the password header and jumper. The password header is E49.

NOTE The password jumper is green so that it can be easily identified. For assistance
locating the password jumper and other system board components, see System board
components on page 56.

5. Remove the jumper from either pin 1 or 2. Place the jumper on pins 1 and 2 (connecting both pins
together).

6. Replace the access panel.

7. Reconnect the external equipment.

8. Plug in and power on the workstation. Allow the operating system to start. This process clears the
current passwords and disables the password features.

9. To establish new passwords, repeat steps 1 through 4, replace the password jumper on either pin
1 or pin 2 (but not both), and repeat steps 6 through 8. Establish the new passwords in Computer
Setup.
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Clearing and Resetting the CMOS
The CMOS of the workstation stores password information and information about the workstation
configuration. This section describes the steps to successfully clear and reset the CMOS.

Using the CMOS Button
1. Shut down the operating system, and power off the workstation and any external devices.

Disconnect the power cord of the workstation and any external devices from the power outlets.

2. Disconnect the keyboard, monitor, and any other external devices that are connected to the
workstation.

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces,
be sure to disconnect the power cord from the wall outlet and allow the internal system
components to cool before touching.

CAUTION When the workstation is plugged in, the power supply always has voltage
applied to the system board even when the unit is powered off. Failure to disconnect the
power cord can result in damage to the system

Static electricity can damage the electronic components of the workstation or optional
equipment. Before beginning these procedures, be sure that you are discharged of static
electricity by briefly touching a grounded metal object.

3. Remove the access panel.

CAUTION Pushing the CMOS button resets CMOS values to factory defaults and erases
any customized information, including passwords, asset numbers, and special settings. It
is important to back up the workstation CMOS settings before resetting them in case they
are needed later. To back up the CMOS settings, use Computer Setup and run the Save to
Diskette option from the File menu.

4. Locate, press, and hold the CMOS button in for five seconds.

NOTE Be sure that the AC power cord is disconnected from the power outlet. The CMOS
button does not clear CMOS if the power cord is connected.

For assistance locating the CMOS button and other system board components, see System
board components on page 56.

5. Replace the access panel.

6. Reconnect any external devices.

7. Plug in and power on the workstation.

NOTE The workstation passwords and any special configurations along with the system
date and time will have to be reset.
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Using Computer Setup to Reset CMOS
1. To reset CMOS using Computer Setup, access the Computer Setup (F10) Utilities menu. When

the Computer Setup message appears in the lower-right corner of the screen, press the F10 key.
Press Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key while the message is displayed, the workstation
must be powered off, then on again, to access the utility.

2. From the Computer Setup menu, select File>Set Defaults and Exit. This restores the soft settings
that include boot sequence order and other factory settings. It does not, however, force hardware
rediscovery.

NOTE The workstation passwords and any special configurations, along with the system
date and time, will have to be reset.
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I Appendix I — Quick troubleshooting
flowcharts

This appendix presents some quick troubleshooting flowcharts for the following issues:

● Initial troubleshooting

● No power

● No video

● Error messages

● No OS loading

● No OS loading from hard drive

● No OS loading from diskette drive

● No OS loading from CD-ROM drive

● No OS loading from network

● Non-functioning device

NOTE The flowcharts presented are for general troubleshooting purposes only and they might
not apply to your specific workstation.
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Initial troubleshooting
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No power
No power, part 1
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No power, part 2
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No power, part 3
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No video
No video, part 1
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No video, part 2
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No video, part 3
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Error messages
Error messages, part 1
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Error messages, part 2
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Error messages, part 3
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No operating system loading
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No operating system loading from hard drive
No operating loading from hard drive, part 1
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No operating system loading from hard drive, part 2
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No operating system loading from hard drive, part 3
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No operating system loading from diskette drive
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No operating system loading from CD-ROM drive
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No operating system loading from network
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Non-functioning device

ENWW Non-functioning device 201



202 Appendix I   Appendix I — Quick troubleshooting flowcharts ENWW



J Appendix J—PCI bus layout
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PCI bus layout and device list
The following illustration shows the HP xw8400 Workstation PCI bus layout. It is followed by a PCI device
list description.

Figure J-1  PCI bus layout

Table J-1  PCI device list

Device Bus# Dev# Fn#

Intel® 5000X Chipset Memory Controller Hub (BUS0) 0 0 0

Intel PCI Express x4 MCH Port 2 (MCH to ICH Bridge) 0 2 0

Intel PCI Express x4 MCH Port 3 (Bridge for PCI-E x16 — Slot 4) 0 3 0

Intel PCI Express x16 MCH Port 4 (Bridge for PCI-E x16 — Slot 2) 0 4 0

Port 5, Slave Port of Port 4 00 5 00

Port 6, Slave Port of Port 4 00 6 00

Port 7, Slave Port of Port 4 00 7 00

Intel 5000 Series Chipset Error Reporting Registers 00 16 00

Intel 5000 Series Chipset Error Reporting Registers 00 16 01

Intel 5000 Series Chipset Error Reporting Registers 00 16 02

Intel 5000 Series Chipset Reserved Registers 00 17 00
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Device Bus# Dev# Fn#

Intel 5000 Series Chipset Reserved Registers 00 19 00

Intel 5000 Series Chipset FBD Registers 00 21 00

Intel 5000 Series Chipset FBD Registers 00 22 00

High Definition Audio Controller 00 27 00

Intel 631xESB/6321ESB PCI Express Root Port 1) 00 28 00

Intel 631xESB/6321ESB USB Universal Host Controller 00 29 00

Intel 631xESB/6321ESB USB Universal Host Controller 00 29 01

Intel 631xESB/6321ESB USB Universal Host Controller 00 29 02

Intel 631xESB/6321ESB USB Universal Host Controller 00 29 03

Intel 631xESB/6321ESB USB2 Enhanced Host Controller 00 29 07

Intel 82801 PCI Bridge (Bridge above Slot 1 and 1394) 00 30 00

Intel 631xESB/6321ESB LPC Interface Controller 00 31 00

Intel 631xESB/6321ESB Ultra ATA Storage Controller 00 31 01

Intel 631xESB/6321ESB Serial ATA Storage Controller 00 31 02

Intel ESB2 SATA AHCI Controller 00 31 02

Intel ESB2 SATA RAID Controller 00 31 02

TI IEEE 1394 Controller 01 05 00

Intel 6702PXH PCI Express-to-PCI Bridge A (Bridge for 133 MHz
PCI–X Slot 5)

08 00 00

Intel 6311ESB/6321ESB PCI Express Upstream Port (Bridge for 100
Mhz PCI–X Slots 6 and 7)

16 00 00

Intel 6311ESB/6321ESB PCI Express to PCI-X Bridge 16 00 03

LSI 1064 SAS Controller - PCI-X 17 06 00

Intel 6311ESB/6321ESB PCI Express Downstream Port E1 (Bridge
for PCI-E x8 — Slot 3)

30 00 00

Intel 6311ESB/6321ESB PCI Express Downstream Port E2 (Bridge
for onboard NIC)

30 01 00

Table J-1  PCI device list (continued)
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